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TheHOTToolbox is designed to provide theOSMCommunitywith a repository of trainingmaterials, com-
plete with step-by-step guides developed by the HOT training team. Thematerial covers everything from
setting up mobile devices to exporting OSM data for quality control and analysis. In addition to consoli-
dating HOT’s extensive training materials, this toolbox curates a large amount of other OSM resources
that support mapping projects; from software guides to guidelines on running mapathons. HOT’s train-
ing materials are uploaded under a CC by 4.0 license which means they are free to use and adapt - we
simply ask that you credit HOT and maintain a Creative Commons License. Learn more about Creative
Commons and free use here.
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1.0 Introduction to Designing aMapping Project
In this section, Project Managers will find guides, tools and resources to design amapping project includ-
ing:

• Considerations and question guides for determining project factors such as scope, scale, and logis-
tics;

• Resources for selecting hardware;
• Guides andmaterials for planning workshops/trainings.

There is nooneway tocollect data in thefieldand itwill varybycontext. However, therearesomeessential
topics and questions all project managers andOSM communities should consider whenDesigning and
Coordinating aMapping Project.

• 1.1 Defining Needs and Requirements poses questions to answer when defining the scope of the
project, such as purpose, geographic scale, and what features to map, as well as ensuring that the
project takes into account the various contexts and stakeholders involved in the project.

• 1.2 Safety, Security, and Logistics for Field Operations contains guiding questions to help plan for
project logistics and security concerns. As all field operations involve some level of risk and can
involvemanymoving parts, it is vital to conduct a safety, security, and logistics review before begin-
ning field work on any project, regardless of experience.

These first two sections provide guiding questions and considerations, however, it is important to under-
stand that each project will have different variables that might not be covered. When designing a project,
be sure to use past experience, consult with other organizations, and meet with stakeholders to ensure
that you are covering all variables.

• 1.3SelectingHardware provides a guide on the various hardware, such as phones and laptops, that
couldbeneeded for aproject. Additionally, HOThasprovided lists of specificmodels that havebeen
used in HOT field projects that have proven suitability.

• 1.4 Trainings and Workshops covers the requirements for running trainings as well as providing re-
sources such as example agendas andmaterials to provide.

Further resources and reading
In addition to this Toolbox, there are several guides that were developed to help teams in the project plan-
ning process, some of which were borrowed from to develop this Toolbox.

• Open Mapping for the SDGs - Humanitarian OpenStreetMap Team (HOT) published a guide for
launching and growing open mapping initiatives at the national and local levels to achieve the Sus-
tainable Development Goals (SDGs). This guide can be found at: https://hotosm.github.io/gpsdd-
documentation/

• Open Cities Project Guide - the World Bank Global Facility for Disaster Reduction and Recov-
ery (GFDRR) and Humanitarian OpenStreetMap Team (HOT) published a guide that can be down-
loaded at http://www.opencitiesproject.org/guide/.

• Participatory Mapping Toolkit - Humanitarian OpenStreetMap Team (HOT) published a guide
for open mapping projects in the context of refugees. The full toolkit can be downloaded at
https://www.hotosm.org/downloads/Toolkit-for-Participatory-Mapping.pdf
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1.1 DefiningNeeds andRequirements
This section includes guiding questions and considerations that Project Managers and OSM communi-
ties should take into account when beginning a project including:

• Factors to consider when deciding what to map;
• Contexts that could impact planning and preparation;

• Considerations to make for involving stakeholders, communities, and how to select your team.

Overview
When starting a mapping project, it is important to define the scope of the project and understand the
larger context in which the data is needed, this includes understanding how to work with local stakehold-
ers and how the data will impact them.

Decidingwhat tomap
1. Purpose and audience: All data collected needs to fulfill a specific purpose with an intended use
case and/or audience. This not only defines the scope of the project and data collected but helps
ensure that the data collection process is ethical and limits the burden on individuals and commu-
nities being surveyed, even if indirectly. A helpful way to think about this to ask, what problem is
this project seeking to address or what question(s), or SDG indicator(s), are we hoping this data
will answer once it has been collected?

2. Geographic extent: Does this mapping project involve gathering information about a city, a neigh-
borhood, a whole country? Do the questions that the project needs answering logically connect to
a particular administrative scale? Or another sort of boundary?

3. Features:What,within thegeographic extent, needs tobemapped? Roads? Buildings? Particular
kinds of buildings such as schools or health facilities? Is there other information such as land-use
or natural features like rivers and forests that will also require mapping?

4. Attributes:What information about each featurewill the teamcollect? For example, is knowing the
width or surface of roads important to the questions the project seeks to answer? The number of
stories of each building? The number of beds in each hospital?

The answers to these questions will help determine if there are any existing datasets that could be used
and the amount of time and resources necessary to complete the project. In some cases, it can be help-
ful to run a small pilot project in order to determine the best approach to data collection and develop an
estimate of the level of effort required.
To collect good data you need to employ a well-defined data model. A data model reflects the informa-
tion you want to capture. Example SDG data models for OpenStreetMap can be found in Part 4. After
establishing a solid data model, it is important to create logical Field Data Collection Forms that capture
the data you are looking for in the best way.

Planning and Preparation
Before laying the groundwork for a fieldmapping project, there are several factors that you and your team
should consider. Below are a selection of factors and questions that should be asked in preparation for
dealing with them.
Political Climate:

• Government support - If a non-governmental organization, does local, regional, and national gov-
ernment support humanitarian activities in the area? Governments may either support or oppose
humanitarian organizations within their country.

• Hostile activity - Is the area experiencing violence or hostile events? Is this activity involve groups
similar to your own? Is this a secure environment to conduct yourwork? Ahostile climate canmake
it extremely difficult to carry out operations.

Communication
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• Infrastructure – Is there a foundation of technology that supports an organization? This can be
related to actual hardware, software, networks, data centers, or the presence of electricity.

• ImageryAvailable – Is there goodquality, high-resolution imagery available, fromsatellites or other
sources? Using aerial imagery as a background layer is considered to be the easiest way to map,
particularly whenmany buildings need to be digitized.

• Internet Access – Is there an Internet connection? What is the amount of bandwidth or level of
connectivity? Many tools rely on Internet access. If you don’t have an Internet connection, a POSM
may be a potential solution.

• Smartphones – Does the community have smartphones? Though not essential by any means,
mobile data collection is a recommendedmethod of field mapping and is done using smartphones.

Literacy
• MapLiteracy – Are communities aware of the basic conventions ofmaps, can they read them, and
do they use them?

• General Literacy – Does the community have the ability to read and write? Higher educational
levels can assist the mapping process.

Accessibility
• Terrain Accessibility – Are areas you want to map physically accessible?
• Transportation – How will you reach the site? Is there public transportation or do you need to hire
vehicles?

Coordinatewith the local administration of the area youwill bemapping
In many cases, mapping teams will need to carry an authorization letter or another form of permission
from local officials to show credibility and to reduce potential conflict that could arise during the field data
collection. We recommend that organizations and communities should request this letter from the appro-
priate authorities well ahead of plannedmapping activities to reduce the risk of delay.
Identifying and contacting partner organisations working locally in the area that you are planning to map
is critical to ensuring local buy-in, project success, and sustainability. While contacting these canbedone
via email or a letter detailing your intent, in-personmeetings havemoreweight and provide opportunity to
develop a stronger relationship.

Building aMapping Team
In most cases, non-governmental organizations and governmental agencies will draw mappers from
within their own teams. However, organizations should consider the benefits of bringing inmappers from
partner organizations and local communities. Whenworking within refugee environments, it is especially
important to consider incorporating refugees (and host community members) into the mapping process.
By incorporating local communities, beneficiaries, and partners in the mapping team, participatory
mapping activities:

• Increase local buy-in and representation
• Allow communities to directly represent their needs and values
• Incorporate local knowledge and perspectives that might not otherwise be accessed
• Empower local community members with skill development

When deciding what individuals to work with, the following factors should be considered:
1. Community – Active participation by the affected population is essential to providing assistance
that bestmeets their needs. The first criteria for participant selection is being from the local commu-
nity. Non-governmental organizations should also consider integrating local and/or national gov-
ernment staff to increase buy-in and data use. Government organizations conductingmapping and
survey activities should consider incorporating staff typically outside of geospatial activities as well
as staff from non-governmental partner organizations. Regardless, participation from the affected
population should be of the highest priority.

2. Motivation – Participants should have strong reasons for working. Motivations vary, but one of the
strongest factors is being emotionally invested in a project. Feeling like you aremaking progress in
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meaningful work is a powerful motivator.
3. Non-Discrimination – no one should be discriminated against on any grounds of status, including
age, gender, race, color, ethnicity, sexual orientation, language, religion, disability, health status,
political or other opinion, national or social origin. None of these should be criteria in determining
participants. Take into consideration pre-existing social, cultural andpolitical dynamics or practices
that maymarginalize or exploit certain groups

4. Payment – As a general rule it is good practice to cover costs of active participants. For example,
if volunteers join your team as field mappers they should be paid per diems to cover transportation
and food. Projects rely on the data these volunteers collect, so it is an integral part of the work and
shouldnot be treated lightly. Of courseunpaid volunteers canandshouldalsobeactiveparticipants,
but organizations must judge when the line is crossed into work to avoid exploitation. Lastly, be
mindful that even seemingly small payments can affect power dynamics in refugee communities
and households.

5. Gender – Organizations should be sensitive to gender but avoid using it as criteria to determine
participants, aligned with the non-discrimination principle. Within families, paying onemember but
not another can have unintended consequences - either positive or negative.

6. Training Your Team - Questions to consider when training your team:
• What is the technical literacy of teammembers? Certain groups will require longer lengths
of time to learn an application or tool than others.

• What tools will you be using? The tools you use will determine the length of time and skill
level demandedof your team. Additionally, thenumberof tools youplan to train teammembers
in impacts the length of training and time necessary to master a skill or tool.

• Will you be able to have hands-on and field training? Training teams in tools using hands-
on approaches, including conducting trial fieldwork greatly increases the success rate of mas-
tery and improves data quality. All trainings should incorporate a practical session if possible.

• Will you have consistent access to internet and electricity? Some tools require internet
and computer use for training.

Community Entry
Community entry is the process of initiating, nurturing and sustaining a relationship in order to secure a
community’s participation and interest in a program. Whether preparing to engage with refugee and host
communities in a settlement setting or local communities in a capital city, there are a few recommenda-
tions and practical questions that can guide your team inmindfully establishing a relationshipwith a given
group and setting the stage for activity implementation in a community.
Themost important thing tokeep inmind ishow individuals canbepart of theworkasmembersof projects.
They must be given ownership. Before starting a project, objectives and strategy should be shared with
community members. They should give feedback, and this should be incorporated. If certain members
of the community are not given roles in the project, both in termsof strategy and implementation, youmay
face problems down the road.
In the context of workingwith refugees, for example, who are used to seeing newprojectswith skepticism,
it is especially important that your approach to engagewith and inform thesegroupsof theupcomingwork
is prioritized over activity implementation and achieving results. Many organizations and individuals use
humanitarian crises as opportunities to exploit people –whether deliberately or through incompetence. It
is crucial to build trust and respect between the organization and community. Though protected under
international law, refugees in host countries are subject to municipal and national authorities. The pres-
ence of refugees can put pressure on host communities, which often fuels prejudice. Therefore, the final
aspect of successful community entry is taking into account the host community’s concerns.
A few practical questions can guide us in appropriately engaging with local communities for the first time:

• Who needs to be informed about your intent to enter a community?
• What documents do you need before entering a community? Permission may include permits or a
letter of permission from local authorities acknowledging your presence and activities in the com-
munity.
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• How can specific groups or individuals in the community be involved in the project?
• What is themost appropriate way of communicating about roles and responsibilities for a project to
these groups?

• Where can you seek information about the dynamics between groups in a given community? How
do you ensure you understand tensions or conflicts between groups you intend to work with?

• What measures are in place to mitigate or manage - if any - conflicts arise?
• Example: In the context of working with refugee and host communities, are you confident there will
not be any resentment between groups working on the same project?

Other practical recommendations to ease your organization’s entering into a new community:
• Set up consultation meetings with relevant leaders and community members to gather feedback
about proposed activities and timeline

• Articulate benefits of projects involvement to all who are involved
• Include a community member - who is familiar with local laws and customs - in your project team
• Establish relationships and work through partners already based in the community to ease activity
implementation and enable integration into existing initiatives

• Create aWhatsapp group to enable direct andmore efficient communication
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1.2 Safety, Security, and Logistics
In this section, Project Managers will find questions and considerations on assessing needs for safety,
security, and logistics for field operations. ***

Overview
For projects requiring field work, you will need to take extra steps to ensure that logistics and security are
effectively handled. The following are topics that project managers should consider and have plans for
before entering the field. Work with donors, local partners, and stakeholders to fill information gaps and
meet these needs.

Logistics
There are many components to managing logistics for field operations. The topics listed below are just
a few components that we recommend all organizations and communities consider prior to starting field
mapping activities.
Workspace /Meeting space

• Do your operations require a workspace or meeting place?
• Does your operations require a central base with full-day access and wi-fi?

Equipment
Different scopes of work will require different types of equipment. For example, ODK and Kobo software
can run onmost Android devices, but OMK software requires higher specifications.

• What type of mobile devices will you use to collect data? (Mobile phones, tablets, GPS devices,
etc.)

• Does everyone on the team have access to data collection devices? Will you need to procure hard-
ware?

• Does everyone on the team have access to computers/laptops? Or will the team plan to work in
shifts?

Refer to Section 1.3 Hardware for guidance on selecting mobile devices, laptops and other hardware for
your project.
Transportation

• How will mappers move around in the field?
• Is the scope of work/area of interest large enough that mappers will need transportation beyond
walking?

• What types of transportation are available?
• What types of transportation are safe for the context and circumstances?
• Will this type of transportation have associated costs? (i.e. driver fees, rental, fuel)

Safety &Security
Each context is so different that it is difficult to make specific recommendations for safety. Communities
and organizations conducting mapping activities should establish contingency plans to address the dif-
ferent types of security incidents thatmayoccur. Teammembers should coordinate all responses to such
incidents so as to safeguard the rights and well-being of local communitymembers, and ensure that staff
members and volunteers are not put at risk.
For operations, the key to effective safety and securitymanagement is the creation of a culture of security.
Each staff member and volunteer has a responsibility for their own safety and security, and that of other
teammembers.
Please note: The below topics are suggestions for mapping teams to consider when building and dis-
cussing security plans for mapping activities, and is in no way comprehensive.
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• Personal Security - What is the appropriate behavior, dress code, language, and forms of commu-
nication when interacting with local communities and other stakeholders? Does everyone on your
team understand these factors?

• Legal requirements -Doyouhavea letter of permission toconduct fieldactivities? Doesyour team
understand local laws and customs?

• Communications - Do you know which communication networks are best for your area of work?
Have you provided all team members with internal and external contact details? Have you devel-
oped and communicated contingency plans to your team? Does your team have a method for re-
porting incidents and do teammembers know how to use it?

• Travel - What types of travel will be required for this work? What attire, visibility, documentation is
necessary for travel? What types of risks (i.e. crime, accidents) are teams exposed to?

• CommonCrime - What types of crime are common in the area of work? What is the frequency and
occurrence of crime?

• MedicalEmergencies - Aremanagers and supervisors aware of teammembers’ pre-existingmed-
ical conditions? Doeseveryoneon the teamknowor haveaccess to informationon the location and
contact information for local health facilities and emergency services? Do all teams have access to
a first aid kit? Is someone on each team trained in first aid?

For operations, the key to effective safety and securitymanagement is the creation of a culture of security.
Each staff member and volunteer has a responsibility for their own safety and security, and that of other
teammembers.
Tips:

• Know the emergency services numbers for the local area
• Always have access to a first aid kit
• Teams should have someone trained in first aid
• Let people decide where they work and feel most safe in
• Avoid performing field work alone
• Always obtain relevant permits, licenses, permissions, and visas for work
• Develop a country specific security plan
• Create a minor incident and suspicious activity report
• Establish a process for regular monitoring and review of hazards
• If operating outside of your home country, sign up for travel alerts from your embassy

Additional Resources
• HOTGeneral Hazard Mitigation Advice
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1.3 Selecting Hardware
In this section, Project Managers will find information on selecting the appropriate hardware for conduct-
ing a mapping project including:

• Determining what hardware may or may not be needed.
• Specifications and recommended models for mobile devices, tablets, and computers based on
project needs.

• Guides on additional equipment that may be needed such as power banks and hard drives.

Overview
Hardware encompasses all physical assets related to technology, computers, and electronics needed for
aproject. Whendesigningamappingproject,managerswill need toassesswhat hardware, andspecifica-
tions, are necessary to complete thework. While theanticipatedprojectworkflow influences the selection
of hardware, it is important to note that the availability of technology and resources for procurement may
place restrictions on hardware selection. In thisway, hardware availability can also influence theworkflow,
making hardware selection an important part of the planning process. Questions to ask during hardware
selection:

• Will mappers be collecting data in the field? If yes, see Mobile Data Collection: smartphones &
tablets to determine what devices are best for field data collection.

• Will mappers be collecting data for more than: 4 hours a day with OpenMapKit and/or naviga-
tion/tracking apps? 6 hours with OpenDataKit or KoboCollect? If yes, see Powerbanks and
charging.

• Will data need to be stored or backed up physically? see Storage Devices: POSM&Hard Drives
• Will there be digitization and editing of data? Will maps and visualizations need to be made from
data? See Computers to understand what specifications are needed for different activities.

• Will there need to be drone imagery capture? see Drones and UAVs to understand what machines
are best suited depending on the need.

• Will there need to be street view imagery capture? see Street view imagery: phones, cameras, and
360 devices.

Mobile data collection: smartphones& tablets
Smartphones versus tabletsWhen choosing a type of device for mobile data collection, it is important
to determine if a smartphone or tablet ismore appropriate formapping activities. Each device types have
pros and cons, so it’s important to understand what is best for a particular project, mapper, and environ-
ment.
When planning to useOpenDataKit:
Most anyAndroid smartphoneor tabletwill do, as longas it hasa relativelymodernAndroid version (4.1+).
When planning to useOpenMapKit:
To enable OpenMapKit to run fluently and be able to handle larger backgroundmaps (in ‘mbtiles’ format)
and OSM data, please make sure that phones have:

• At least 1.5, but preferably 2 GB of RAM
• Preferably 16 GB of storage
• Amodern Android version (6.0+)

Furthermore, the following are recommended:
• A 5” screen for usability
• A decently sized battery. For extended usage, it may be necessary to have battery packs
• Make sure to have enough charging options, such as car chargers and extension cords

The following phones/models have been verified to work well on various projects:
Smartphones:
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• Tecno Camon C9 (2 GBRAM)
• Tecno L9 (2 GBRAM, 16 GB storage)
• Huawei Y5 (2017) and Huawei Y6 Pro (2 GBRAM, 16 GB storage)
• Sony Experia L1 (2 GBRAM, 16 GB storage)
• Motorola Moto G5 (2 GBRAM, 16 GB storage)
• Infinix

Tablets:
• Samsung Tab A (SM-T285, 7”, 2016) (1.5 GB RAM, 8GB storage)
• Huawei Mediapad t3 10 AGS-W09

Protectingmobile devicesHOT recommends that cases are procured for all mobile data collection de-
vices, regardless of type. This will help protect the devices from weather, dropping, sun exposure, and
other hazards. Ultimately, protecting devices not only reduces costs associated with device loss or re-
placement, it also protects the loss of data stored in the devices.

Power banks and charging
When usingmobile devices for data collection, ensuring that devices can remain charged throughout the
day and be recharged is critical. HOT recommends procuring power banks when possible to ensure that
devices are ready for mapping. Each project (and applications used) will have different drain on mobile
devices, in general, HOT has found that consistently collecting surveys with OpenMapKit and running a
GPS application in the background (i.e. OSMAnd, OSMTracker) will drain a typical device battery in 3-5
hours - requiring the need for power banks to work through the entire day. When selecting power banks,
it is recommended that they are tested for compatibility with the mobile device used.
In addition to keeping devices charged during the day, projectmanagers need to consider howall devices
(including power banks) will be charged at the end of the work day. Will mappers have access to power at
night? Does your team have enough outlets or power strips to effectively charge all of your devices? Will
mappers need to find alternative options for charging devices?

StorageDevices: Hard Drives and computer back-ups
When collecting survey data in the field, accidents can happen including lost, damaged, or stolenmobile
datacollectiondevicesor laptops. For that reason, it is important tohaveadatastoragestrategy toensure
back-ups exist. It ismuch easier to recollect one day’s worth of field data than to completely redo all of the
work. Multiple laptops with duplicate back-ups and hard-drives are effective ways of keeping back ups,
even if your team is using a cloud server. Storage devices should have at minimum 1 terabyte of storage.

Street view imagery: phones, cameras, and 360 devices
Mapillary provides an up-to-date list of recommended equipment for capturing street view imagery here.
In addition to recommended devices, this list provides additional equipment recommendations including
mounts, memory cards, charging, and cases. Additionally, HOT has usedmobile devices provided in the
OpenMapKit list above for street view imagery capture.

Computers
Determining the specifications, quality, and type of computer depends on the needs of the project or ac-
tivity. At minimum, computers involved with mapping activities should have the following specifications:

• 15” screen or larger
• Processor: Core i5, relatively new
• RAM: preferably at least 8gb
• 512 GB hard disk or larger
• Operating system: Windows or Linux preferred for most applications

The following computers have been verified to work well on various projects, categorized by typical use:
a) Training, data cleaning and basic GIS/data processing
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• Lenovo Ideapad 320
• HP 250 G6
• Lenovo ThinkPad X234
• DELL Latitude E6430s
• HP Elitebook 840
b) Advanced GIS and drone imagery processing
• Acer Aspire e5-575
• Lenovo P50

Drones andUAVs
When quality imagery is not available or up-to-date imagery is necessary for a data collection process,
such as capturing the impact of a recent flood or to capture newly constructed buildings, using a drone or
unmanned aerial vehicles (UAVs)may fulfill imagery needs. Selecting aUAV/drone depends on the need
of the project and available resources. Drones/UAVs are generally classified into three types based on
mode of flight. See the table below for a comparison of the different types. Note: cost is based on HOT
experience and is not necessarily representative.

Type
Flight
time

Max
speed PayloadCoverage Cost range

Multi-rotor UAV 25-
45
min-
utes

45-
60
mph

450g-
5.5kg

2-7 km2 $3-65k

FixedWing UAV 45
min-
utes

40-
110
mph

1-3
kg

<12 km2 $25-120k

Hybrid UAV 60
min-
utes

70-
120
mph

1-6
kg

<13 km2 $30k+

In brief, multi-rotor UAVs are best suited for small-scale operations with smaller mapping areas and/or
quick response time for flight deployment (i.e. responding to natural disasters), whereas fixedwingUAVs
are better suited for aerial mapping of large areas.
For HOT projects, we have selected and used the following drones:

• Multi-rotor: DJI Phantom 4 Pro
• Fixed wing: senseFly eBee

Please note: anyone interested in drone flying should understand local drone/UAV laws and regulations,
as well as seek out proper training in piloting.

HardwareManagement Considerations
• Create and have all mapping participants sign an agreement for the responsibility and liability of
devices

• Create an equipment sign out log
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1.4 Trainings andWorkshops
In this section, Project Managers will find information on considerations and resources to use while plan-
ning trainings and workshops for mapping and OSM, including:

• Guidance on training requirements
• Examples and resources for creating training agendas
• Considerations for presentations and other providedmaterials.

Overview
Most mapping projects will involve trainings or workshops of some kind, whether training field mappers
to useOpenDataKit, training local government stakeholders how to export and useOSMdata, or training
students inQGIS for creatingmaps. During the planning stage, projectmanagers andOSMcommunities
should anticipate what trainings are necessary andwhat resourceswill be required to run each training or
workshop.

Training Requirements
Attendee requirements
Requirements for attendees will vary depending on the scope of the trainings, the intended participants,
and the available resources. No matter the scope of the training, it is important to communicate these
requirements BEFORE the training so that participants can come prepared.
Some attendee requirements may include:

• Have a laptop andmouse.
• Be computer literate with basic computer skills.
• Have enthusiasm and willingness to collaborate with others.
• Attendee’s computers should have sufficient free disk space (approx 10GB) and attendees should
have administrator rights so that they can install software on their computers.

• Attendees should have a PDF document viewer installed on their computers.
Workshop venue requirements

• Wi-Fi Capability
– If the venue can provideWi-Fi, confirmwith the venuemanagers that theWi-Fi has enough ca-
pacity for the number of attendees expected to show. For example, if you expect 10-15 people
to show up to your event, the Wi-Fi will need to be capable of hosting 15-20 internet connec-
tions - remember, you will need to connect as well!

– If there are no venues with wi-fi capability, consider the option of using a Mi-fi device or other
Hotspot options

• Space, tables, and chairs to provide for your expected attendance.
• Enough power outlets for charging laptops and other devices.

– If this is limited, you’ll need to consider power strips and extension cables.
• Generator/electricity access for duration of workshop.

Creating an Agenda
Training Agenda Examples

• Three-day field mapping workshop
• Two-day GIS workshop

Training Agenda Template
• Template
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Presentations
After developing the agenda, you will need to determine what presentations are needed for each activity.
HOT Training Presentations provided in this Toolbox are available for teams and OSM Communities to
use with credit provided to HOT. Navigate through the Toolbox to appropriate sections for presentations
needed.

Tools, Software, andMaterials to Provide
It is highly recommended that prior to the training/workshop, all necessary installation files are down-
loaded and loaded onto USB drives for offline installation. Sections throughout this Toolbox introducing
tools include links to the installation files you will need.

Additional Resources
• Beginning OpenStreetMap Trainer Toolkit
• Intermediate OpenStreetMap Trainer Toolkit
• Advanced OpenStreetMap Trainer Toolkit
• TeachOSM
• LearnOSM

– Mapping Party
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2.0 Introduction to Digitization and Editing in OSM
In this section, Project Managers will find tools and resources to lead and implement organized Open-
StreetMap editing activities including:

• Presentations and step-by-step guides for introducing teams to OpenStreetMap and editing tools
such as the HOT Tasking Manager.

• Resources for determining if your project needs to meet OSMOrganized Editing Guidelines
• Detailed guides and training activities for digitization teams to use during validation anddata upload

Digitization, or remotemapping, is theprocessof tracing featuressuchasbuildingsand roads fromaerial
or satellite imagery to create map data. OpenStreetMap relies heavily on users generating data through
digitization.
With OpenStreetmap at the core of our tools and workflows, mapping projects using HOT tools and work-
flows will likely incorporate digitization or editing of OSM data during one, in not multiple phases in the
project timeline. While numerous resources exist to teach new users how to use OpenStreetMap for the
first time, this section is largely designed to guide project managers and community members through
the digitization process from the perspective of leading trainings and managing teams conducting OSM
editing. Users looking for guidance on individuals mapping in OSM should look to LearnOSM.org as a
resource.

• 2.1 Introduction to OSM contains a brief overview of OpenStreetMap with the purpose of being
distributed as supplemental training guides.

• 2.2OrganizedEditingGuidelinescoversconsiderationsprojectmanagersandcommunities should
make when organizing focused digitization or editing campaigns.

• 2.3 Working with the HOT Tasking Manager provides an overview of HOT’s tool for crowdsourcing
OpenStreetMap edits, as well as a guide for setting up tasks in the Tasking Manager.

• 2.4 Editing with iD and JOSM Editor provides guidance on selecting the appropriate OSM editing
tool for your project or event, and training materials using both tools.

• 2.5 Validating with JOSM dives into the validation process step-by-step.
• 2.6 Resolving conflicts in JOSM provides additional assistance for teams conducting advanced
OSM editing.

The following presentation(s) can be used to lead a training or workshop:
• Introduction to OSM
• Introduction to HOT Tasking Manager
• Mapping with iD Editor
• Mapping with JOSM
• Validating with JOSM
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2.1 Introduction toOpenStreetMap
This section provides:

• An overview of OpenStreetMap, including presentation slides
• Step-by-step instructions for creating OpenStreetMap accounts
• Step-by-step instructions for using and navigating OSM
• Considerations for training large groups

The following materials are designed to assist project managers and others leading trainings and
workshops. If you are an individual interested in learning how to map with OpenStreetMap, please visit
LearnOSM.org.

Overview
OpenStreetMap is a collaborative project to create a free editable world map and is at the core of HOT’s
mapping activities. You are free to use it for any purpose as long as you credit OSM and its contributors.
The power of OpenStreetMap is that it empowers anyone, anywhere in the world to add information to a
collective map and use the data for any purpose. You can think of OSM as the “Wikipedia of maps” – it is
anonlinedatabaseandglobal community of over 5million registeredusers. This community collaborates
to build a free and open map of the world to which anyone can contribute and which anyone can use in
their own context. All that is needed to contribute to OSM is an internet connection and email address.
OpenStreetMap can, and has, been used for a wide variety of purposes - from disaster response to com-
mercial use. Thefirst organizeduseofOSM indisaster responsewas following the2010Haiti Earthquake.
Ashigh-resolution imageryof theaffectedareawasmadeavailable to thepublic, over600 individuals from
the global OSMcommunity began digitizing the imagery and tracing roads and other infrastructure. They
made what quickly became the most detailed map of Port-au-Prince in existence, which was then used
by search and rescue teams to help route supplies around the devastated capital and to coordinatemany
other aspects of the response and reconstruction effort.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following presentation(s) can be used to lead a training or workshop.

• Introduction to OSM
The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

• Step-by-Step Instructions: Opening OSMAccounts
• Step-by-Step Instructions: Using OSM

OpeningOSMAccounts

With OpenStreetMap (OSM) at the core of mapping activities, it is critical that all teammembers and par-
ticipants have activated OSM accounts. This will be necessary before using many mapping tools such
as HOT Tasking Manager, JOSM, and HOT Export Tool. This section covers how to:

• Create an OpenStreetMap Account
Skills and TechnologyNeeded

• Computer
• Activated email account
• Internet connection

Creating anOSMAccount
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How to drag the map view

Figure 1: How to drag the map view

To get started, you will need to create an account on www.openstreetmap.org. Please use the “Sign Up”
tab in the top right corner to begin.
Please fill in all the fields in the form. We recommend using an email you have easy access to e.g. your
work email, as you will receive a confirmation email to verify your account. You will not receive any
spam/marketing emails. Click the blue “Sign Up” button when finished.

Note : If a problem occurs, a problem message will appear. Make sure that the email you
entered is the same as in the first two boxes and your password. If the box for the user name
is red then someone else has already used the name and you have to look for another name.

Next, please read and accept the contributor terms and agreements by selecting where you are based
(France, Germany, or the Rest of the World), and clicking the blue “Agree” button on the bottom of your
screen.
To activate your account, please now check your email and click on the link provided.
On theOpenStreetMappage, clickLog In in theupper right corner. Enter yourOpenStreetMapusername
and password then pressEnter. You should now be logged in and you will see your username on the top
right of the OpenStreetMap site.
Considerations for signing up large numbers of individuals

• Prior to beginning the OSM registration process, all individuals signing up for OSM accounts will
need to have an existing and accessible email account. If registering a large group of individuals at
one time, we recommend asking the group if they have accessible email accounts. When planning
mapathonsand trainings inareaswhere regular email usemaybe low,wealso recommendplanning
for time in assisting individuals with setting up email accounts.

• Consider internet connectivity andcapacityprior to registering largenumbersof individuals forOSM
accounts. Having individuals taking turns to register or running registration simultaneous to other
activities can reduce the load on a slow internet connection.

• It is crucial that usernames and passwords are remembered by participants so that they can access
other tools that require OSM accounts to log-in. We recommend encouraging participants to find a
way of safely storing this information for future reference.

UsingOpenStreetMap

After creating an OpenStreetMap account it is important to understand basic skills in navigating Open-
StreetMap. This section covers how to:

• Operate and navigate the OpenStreetMap website
• See object information in OpenStreetMap
• Create share link in OpenStreetMap
• Save images fromOpenStreetMap
• Understand the basic concept of attributes in OpenStreetMap
• Understand history in OpenStreetMap

Navigate themap
In the main view of the OpenStreetMap website, you will see a large map in it. You must be able to navi-
gate the map so you can go to a location that you want. Here are the ways to navigate the map on Open-
StreetMap:

• Use the left mouse to drag the map view. Left-click on your mouse, then hold and drag the map to
the location that you want. If you don’t have a mouse, you can press and hold the right touchpad
and thenmove the cursor.

How to drag the map view
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How to zoom in and out the map view

Figure 2: How to zoom in and out the map view

Steps to find location using Search box

Figure 3: Steps to find location using Search box

• Use (+) and (-) button in the upper right corner of the map to zoom in and zoom out the map view.
You also can use your mouse scroll-wheel to zoom your map. Scroll your mouse up to zoom in,
while scroll down to zoom out.

How to zoom in and out the map view
• To search the location based on the name, type the location name on the Search box in the upper
left side on the screen. You can type it in the search column, then pressEnter or clickGo. After that
a Search Results box will appear below the search column, then you can choose and click on the
search. Themap will automatically move to the location you chose.

Steps to find location using Search box
• To display your current location, you can go to themap panel to the right of themap and clickShow
MyLocation button. Then, themapwill automatically display your current location point (blue dot).
Make sure to enable the GPS on your laptop or computer to allowOSM to get your current location.

The display of ShowMy Location feature
Change different style options for themap
OpenStreetMap contains geographic data from all over the world. Although stored in one database, the
data can be displayed in several styles. The steps to change style map in OSM are as follows:

• Click Layers button in the right panel on the map.
The Layers button to change background layer
OSM has four types of layers with different functions, namely:

• Standard: This layer shows all the objects on the OSMmap.
Standard Layer

• Cycle Map : This layer emphasizes cycling routes and pedestrian roads.
Cycle Map layer

• Transport Map: This layer emphasizes transportation routes on themap such as highways and bus
stop.

Transport Map Layer
• Humanitarian: This layer emphasizes important objects or amenities on the map such as school,
hospital, etc.

Humanitarian Layer
View object information in OpenStreetMap
In theOpenStreetMap page, besides see the current location and navigate themap, you also can see the
feature information using Query Features. The steps to use Query Features are below:

• Click on Query Features button on the panel in the right. After you clicked it, you should see the
question mark on your cursor. This indicates that the query features function is activated.

Query Features button

The display of ShowMy Location feature

Figure 4: The display of ShowMy Location feature
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The Layers button to change background layer

Figure 5: The Layers button to change background layer

Standard Layer

Figure 6: Standard Layer

• Now you can choose an object or location that you want to identify. For this example, we click on a
governmental office building (Dinas Kesehatan) in Jakarta.

• Youshouldseeaboxappears in left corner thatdisplaysNearbyFeaturesandEnclosingFeatures
options. Nearby Features shows the description of any object that is closest to the location of your
chosen point, while Enclosing features shows all the object information that have a close range
locationwithyourchosenpoint. Try toclickone feature in theNearbyFeatures, clickGovernmental
officeDinas Kesehatan for this example.

Nearby features dan Enclosing features in Query Features
• After you clicked it, the information detail about Dinas Kesehatan building will appear in the left box.
The information displayed is a tag or object attribute regarding general information objects such as
object names, addresses, building levels, and others.

Query Features result
Sharemap locations in OpenStreetMap
You can share links of your OpenStreetMap maps to others for various purposes, such as sharing the
location of your current position with your colleagues and so on. To be able to share OpenStreetMap
maps, the steps are as follows:

• Click the Share button on the right panel, then the Share column will appear.
• Check the Includemarker to add the locationmarker point. You canmove or drag themarker point
to the desired location. Just click and hold the locationmarker then you drag to the desired location
point. Another way is to shift the map so that the location marker is in the position you want.

Addmarker point
• Once themarker position has fixed, you can copy the link in the Link box and share the link accord-
ing to your needs. You can also copy a shorter version of the link in the Short Link box or copy the
HTML code in theHTML box.

Share the link of the map in OpenStreetMap
Exportmap as an image
Besides changing the layermap, you also can export themap as an image and choose the various format
file such as .png, .jpg, .svg, and .pdf. The steps to export the map are as follows:

• Click on theShare icon in the right of yourmap. Then theShare columnwill appear on the right side
of your screen.

Share button to export the map
• After that, specify the area on the map that you want to export as an image. Give a check mark on
theSet customdimensions box in the Image section, then adjust the size of the box or adjust the
scale in the Scale section.
Note : You can only export map as image if you set the Standard Layer view. If yourmap does
not use the Standard Layer, you need to change it first on the Layers menu.

Cycle Map layer

Figure 7: Cycle Map layer
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Transport Map Layer

Figure 8: Transport Map Layer

Humanitarian Layer

Figure 9: Humanitarian Layer

• You can choose the format of the export image in the Format dropdown menu. After that, click
Download button to download the image and save the image to your folder location.

Image section to export the map
View the editing history in OpenStreetMap
When you edit objects or make changes to OpenStreetMap, you can see the editing history of objects in
that area. The steps to see editing history are as follows:

• You can see the information by clicking on theHistorymenu button on the top left of the map.
• After that, the Changesets column will appear at the bottom of the Search box and orange boxes
will appear on the map that indicates which areas have just been edited. Changeset is a version of
every change uploaded byOSMusers. The information that we can see in the Changesets column
is as follows:

1. Changeset comment. It is recommended that you write the short comment when uploading
changes or changeset. Comments can contain information about any changes that you made or
specific hashtags.

2. Upload time information.
3. OSM username.
4. Changeset number. This number is a unique number as the changeset identity.

Changeset history in OpenStreetMap
• You can click one of the changeset on the changeset list or you can immediately select the orange
box on the map. After you select one of the changeset, you will get details about the changeset.

The changeset details
Basic concept of OpenStreetMap attributes
1. The attribute concept on object
When you draw an object as a point, line, or polygon inOSM, you still need to add information about
the object such as object name, address, or other supporting information. This informationwill help
other users when using OSM data for various purposes. Information provided by users on OSM
objects is called an attribute or tag.
An attribute/tag is like a label that you canplace on anobject. For example, if you drawa square, this
is only a square without any object information. But you can add attributes to describe that object,
for example you draw a square that is is a building; the name of the building is “Tebet Hospital”; 10
level building.

2. Components in OpenStreetMap attribute data
You can add asmany attributes / tags as youwant to an object. Attributes are stored as a pair of text,
namedKey andValue. Key is general information that explains the function of an object. In one key,
it can consist of many values. For example schools, mosques, and hospitals have key=amenities
(important facilities). Although the three objects have different types of functions, but all three ob-
jects have the same key. Whereas Value is information that more specifically explains the type of
an object. Because this value describes specific information about an object, so that one type of
value can only describes the type of the object itself. Not the same as a key that can explain general

Query Features button

Figure 10: Query Features button
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Nearby features dan Enclosing features in Query Features

Figure 11: Nearby features dan Enclosing features in Query Features

Query Features result

Figure 12: Query Features result

information about the object. In OpenStreetMap, an attribute is added by formatting a key-value
pair that represents physical features on the ground, for example:
The example of object attributes
In the example above, there are four kinds of key & value attributes, including object amenities for
hospital (amenity = hospital), building objects (building = yes), building level 10 (building:levels =
10) and object name Tebet Hospital’ (name = Tebet Hospital).

Additional Resources
• LearnOSM - Introduction to OSM
• OSMWiki - Abot OpenStreetMap
• TwoMinute Tutorial - What is OpenStreetMap?
• TwoMinute Tutorials - How to sign up for OpenStreetMap

Addmarker point

Figure 13: Addmarker point
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Share the link of the map in OpenStreetMap

Figure 14: Share the link of the map in OpenStreetMap

Share button to export the map

Figure 15: Share button to export the map

2.2OrganizedOSMEditing
This section provides:

• Considerations for managing and sourcing mappers for an organized editing project
• Overview of the OSMOrganized Editing Guidelines and compliance
• Step-by-step guide for complying with the OSMOrganized Editing Guidelines

Overview
Before starting any mapping project, it is important to assess, and if necessary, update the Open-
StreetMap basemap through remote mapping. This remote mapping process helps ensure that the
buildings and roads used during a field mapping phase are up to date, improving the quality and effec-
tiveness of field mapping efforts. For example, using remote mapping, your team can identify buildings
or entire villages that might have beenmissed otherwise.
While the anticipated project workflow influences the area to be remotely mapped, it is important to note
that the budget and time available may place restrictions on what is feasible to be digitized. In this way,
remote mapping can also influence the workflow, making the remote mapping plan an important part of
the planning process.
Nomatter the scope of your project you will need to determine:

• Who will be digitizing for your project?
• How will you manage your organized OSM editing efforts?
• Do Organized Editing Guidelines requirements apply to you?

Sourcing your remotemappers
Remote mapping takes time and effort. This process can take several different forms ranging from be-
ing quickly completed with a few volunteer mappers for a small area to an organized, paid team working
for several months to complete a region. The resources and time needed to map your area of interest
depends on:

• Size of your area of interest: Are youmapping one city or an entire district?
• Timeline: Does the area need to bemapped in a few weeks? Months?
• Resources needed: Does your project have budget to pay digitizers and validators?
• Quality: What are your resources for ensuring that themapped data is high quality? Does the data
need to be immediately high quality, or is there room for newmappers to makemistakes?

• Featuresandattributes: Does your project require only buildings to bemapped? Roads? Will any
features (such as roof:material) be added by remote mappers?

SourcingOptions

The following a few recommendations on how to organize and source your mappers based on our best
experiences.

Image section to export the map

Figure 16: Image section to export the map
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Changeset history in OpenStreetMap

Figure 17: Changeset history in OpenStreetMap

The changeset details

Figure 18: The changeset details

• Global HOT/OSMCommunity: The global community is a wonderful and FREE source of remote
mappers. As of September 2019, 180,000 volunteers from around the world have mapped over
2 million tasks on HOT’s Tasking Manager to support mapping efforts around the world. Here are
some considerations tomake when utilizing theGlobal HOT/OSMCommunity for remotemapping
efforts:
– Size of AOI: With a large pool of individuals to choose from, the global community can cover
any size of digitization efforts, from a neighborhood to entire countries.

– Timeline: While the global community is known for it’s rapid response in the wake of disasters
and immediate humanitarian needs, other types of projects should not rely on the community
to map areas within a controlled timeframe. Relying on the global community to map a district
in Liberia, could take a week or several months depending on interest in the project and other
urgent mapping needs.

– Quality: The disadvantage of using the global community for remote mapping efforts is that
it can be more difficult to control the quality of data being immediately mapped. While all
remote mapping should be validated, the wide range of skills and experience (as well as
understanding of the project needs) could mean that additional efforts will be required to
review and fix any mistakes made by remote mappers.

– Resources needed: As already stated, using the global community for mapping has the great
advantage of being completely free!

– Features andattributes: Tasksbest suited for the larger community are those that are simplest.
Additional instructions beyond tracing buildings is feasible, but extra checks will be necessary
for coverage as somemappers maymiss detailed instructions.

• Dedicated team of digitizers (5+ people): Some projects may find that the best way to meet the
needs of their project is to hire a small team of dedicated digitizers to systematically map an area.
Typically this dedicated team works together in-person, which allows for consistent training and
quality assurance. However, it is possible to use a paid team of mappers working remotely if map-
pers are experienced and do not require extensive training. We do recommend that when looking
to hire a team of mappers that you reach out to the local OSM community with these opportunities.
Here are some considerations tomakewhen utilizing a dedicated teamof digitizers for remotemap-
ping efforts:
– Size of AOI: Like the global community, digitization teams can cover any amount of area with
enough time. As team members are dedicated to the mapping task, digitization teams can
handle larger areas over a shorter period than the global community.

– Timeline: For meeting tight deadlines, a dedicated team of digitizers can be the best option
as it ensures that the mapping task can be effectively planned and executed. Meeting that
timeline does depend on the number of digitizers hired and their experience. HOT has found
that newly trained teams of digitizers can map 500-1000 buildings a day depending on the
imagery quality and density of mapping.

– Quality: Having a dedicated and paid teammeans that it’s easier to train andmanage the data
quality of the mapping efforts.

– Resources needed: Budget for paying digitizers is required. Also recommended is providing
a dedicated workspace and consistent internet connection, as well as laptops where needed
if working with mappers on location.

– Features and attributes: By working directly with individuals, you can ensure that all special

The example of object attributes

Figure 19: The example of object attributes
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features and attributes your remote mapping campaign requires are consistently added. Hav-
ing local context (such as recognizing roofmaterial) is also extremely helpful for adding unique
features and attributes.

• Mixed approach: paid digitizers and global community: When there are timelines in place but
the scope of the work is too large for your team, one option is to have a mix of paid digitizers and
the global community. Here are some considerations to make when taking a mixed approach for
sourcing remote mapping efforts:
– Size of AOI: If you have a small team, combining efforts with the global community can help
you achieve a much larger area.

– Timeline: By including some paid digitizers, this method can help keep the project in develop-
ment while relying on the global community.

– Quality: Additionally, by including paid digitizers, your team can choose to focus on validating
the efforts of the global community and increase the consistency of quality mapping edits.

– Resources needed: Smaller budget than a full team, but will still likely need to provide a dedi-
cated workspace and consistent internet connection.

– Features and attributes: If there are unique features and attributes that rely on local context,
you can rely on the global community to develop the basemap and then your paid team can
add those features later. Or, you can use your small team to validate the special features and
attributes added by the global community.

• Hosting Mapathons: Another option that blends utilizing volunteers with some of the benefits
of a dedicated team is hosting a series of Mapathons. These mapathons typically bring together
groups of volunteers (ranging fromuniversity students to corporate volunteer events) tomap a task
together in person. Here are some considerations to make when hosting mapathons for remote
mapping efforts:
– Size of AOI: The amount of area that can be covered depends on the number of people
attending the mapathons, the number of mapathons hosted, and the skill level of volunteers.
In general, this option is only recommended for smaller areas.

– Timeline: This option can be faster than relying solely on the global community, but slower
than having a dedicated team of volunteers. Again, the speed of mapping depends on the
skill level of the mappers, frequency and number of events, if the same mappers attend each
event, and howmuch training will be required.

– Quality: Since mapathons generally bring new or inexperienced mappers together, map-
athons have the possibility of requiringmore effort on the validation side ofmapping. However,
if the same attendees regularly participate, this data quality will increase.

– Resources needed: Smaller budget than a dedicated in-person team, but event space, inter-
net, and refreshments will need to be covered.

– Features and attributes: If your mapping project requires unique features and attributes, map-
athons allow for better training and management of volunteers adding that information. How-
ever, similar to data quality, thiswill still require a heavier lift in validation than using a dedicated
team.

Whenever possible, we recommend sourcing local mappers to be part of the digitization efforts. And
remember, it is critical that nomatterwhat plan youchoose, that it includesa validationandquality control
plan!

Managing your digitization efforts
Once you decide how you will source your team of mappers (paid or unpaid, local or remote), you will
need to set up a plan and gather resources. Here’s a checklist of some questions to consider:

• What will be your team structure? We recommend having one dedicated validator for every five
digitizers.

• Have you trained validators? Our training materials for validators are available here.
• Howwill you track the progress of your mapping? When setting up a large number of mapping
tasks, it helps to set up a tracker to monitor the progress of all tasks.
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Organised Editing Compliance Procedures
TheOSMFoundation has set upOrganised EditingGuidelines for documenting organized editing efforts.
While it is not a requirement or policy, HOT highly encourages all groups to comply with these procedures
when applicable. For simplicity and ease of understanding these guidelines, HOT has developed the
following guide, however, HOT does not take responsibility for compliance.
The following is based on HOT’s suggested procedures for complying with the Organised Editing Guide-
lines (OEG) - as of June 2019

Purpose

What problem(s) does the OEG aim to address, and how can we best comply with, and address, these
concerns?

• Transparency - the OEG attempts to make it easier for local mappers to know what organizations
are editing in their area.

• Communication - the OEG attempts to make it easier for local mappers to communicate with or-
ganized editors and editing teams.

• ConflictResolution - theOEGattempts toprovideabasis for coordinating, aswell asamechanism
for local communities to form a complaint against an organized editing activity.

Documentation

• TheofficialOEGcanbe foundhere: https://osmfoundation.org/wiki/Organised_Editing_Guidelines
• The official OEG Activities page here: https://wiki.openstreetmap.org/wiki/Organised_Editing/Acti
vities

• The HOTOEGActivities page here: https://wiki.openstreetmap.org/wiki/Organised_Editing/Activi
ties/Humanitarian_OpenStreetMap_Team

Requirements

What exactly is required by the Organized Editing Guidelines (OEG)?
1. Project Documentation on the OSMWiki:

• Organisation and contact info
– description and link to organization
– a way to contact the project manager or team

• Project details
– the goal and purpose of the activity
– the timeframe for the activity
– any non-standard tools and data sources used, and their usage conditions
– links where the community can access any non-standard tools or data sources

• Standard changeset comment
– specific hashtag for tracking
– link to related organized editing activity

• Team information
– the accounts of participating persons that wish to be identified, with any details they wish
to include

– if participantswill receive trainingmaterial orwritten instructions, acopyof, or link to, these
materials
1. links to organized editing organization(s) and activity(ies) on user profile
2. sufficient training for project (i.e. local tagging schemas, etc.)

– if the success or performance of participants will be measured in any way, a description
of the metrics used for this

2. Project Execution and Follow-up
• Communication with the local community

– 2 week notice for non-emergency projects, open forum/mailing list
– 2 working day response for community inquiries throughout project
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• Plans for a “post-event clean up” to validate edits, especially if the activity introduces new con-
tributors to OpenStreetMap.

• After the activity has completed, or at least once a month for ongoing efforts, a description of
the results.

Does this apply tome?

CommonElements:
Common elements of projects can be jointly-documented among projects.
For HOT, most projects fall under OEG compliance, and will share the following:

• The organization and contact information
• Instructions to a certain degree, i.e. basic mapping covered with LearnOSMmaterials
• A somewhat standard validation process; of course be explicit about any ground truthing
• Somewhat standardized tool set(s) (i.e. TM for Remote, ODK/OMK for ground)
• Reports/descriptions/news at a central location (i.e. HOT website)

Step-by-Step Process:

1. Project Pre-launch
• Have at least a skeleton wiki/web-page ready to share with local community

– How to edit the wiki: https://learnosm.org/en/intermediate/editing-the-wiki/
– See https://wiki.openstreetmap.org/wiki/Template:Activation for a template/example of
Activation wiki-pages

– How to create HOTWebsite projects
• Local contact made a minimum of 2 weeks prior of launch; through their open mailing-list, or
forum, most likely to contact the key leaders in the community
– Look here for mailing lists: https://lists.openstreetmap.org/listinfo
– Search wiki by country as theymay have other communication channels listed there, and
sometimes individual points of contact

– And try https://github.com/osmlab/osm-community-index
– Only if you exhaust these options is it acceptable to assume no local community

• Set-up OSMUser Profiles:
– Consider registering team on OSMwith designated usernames
1. Can still be personalized, such as JaneDoe_Validator, JohnDoe_Mapper, etc.

– Consider also using organization email account(s)
2. Ideally, the ProjectManager or TeamLead should get, or be able to access all messag-
ing. If a mapper leaves, but then gets messages from the community, you will want to
be able to reply

10. All profiles should at least have a link to the OEG project page, organizations website, or
(for HOT) preferably a link to the individual’s profile on the website

2. Project Launch
• Ensure the project has an entry in OEG activities page
• Have the required details of your plan in awiki-page or (for HOT) a hotosm.orgwebsite project-
page

• Appoint one or two people that will handle rapid replying to all community traffic (2 business
day max)

• Periodic Reports are typically handled through blog (for HOT), but can also consider posting
results on wiki’s, etc.

3. Project Completion
• Make sure there is a plan to finish any remaining validation and that is communicated to the
local community.

• With constant communication with the local community throughout the project, it should be
fairly easy and straightforward to determine when the project will be done and the Community
is back on their own, with conduits to project org(s).

• Before closing your project out, make sure there is a final blog-post or report documenting the
closure.
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– Doc/report does not need to be full report requested by a donor, as example, but generally
the results: successful or not, lessons learned

– Last, move your row in the OEGActivities table from Active to Previous

Additional Resources
• Campaign Management Guide
• HOTOrganised Editing Compliance Procedures
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2.3Workingwith the HOTTaskingManager
This section provides:

• An overview of the HOT Tasking Manager, including presentation slides
• Step-by-step instructions for getting started with the HOT Tasking Manager

The following materials are designed to assist project managers and others leading trainings and
workshops. If you are an individual interested in learning how to map with OpenStreetMap, please visit
LearnOSM.org.

Overview
The HOT Tasking Manager is a mapping tool designed and built for the Humanitarian OpenStreetMap
Team’s collaborative mapping process in OpenStreetMap. The purpose of the tool is to divide up a map-
ping project into smaller tasks that can be completed rapidly withmany people working on the same over-
all area. It shows which areas need to bemapped and which areas need the mapping validated.
For information on Managing and Creating Projects on the HOT Tasking Manager, fill out a form here,
http://bit.ly/TaskManagers, to receive training and permissions to become a TM Project Manager.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following presentation(s) can be used to lead a training or workshop.

• Introduction to HOT Tasking Manager
The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

Getting Startedwith TaskingManager

Skills and TechnologyNeeded
• Computer
• Internet connection
• OSM account

Head to the HOT Tasking Manager website: https://tasks.hotosm.org/. To sign in, click on the ‘Log in’
button in the top right corner of the page. Once you click on the login button a popup will appear with the
OpenStreetMap login form. Please enter your OSM username and password.
If this is the first time you are logging into TaskingManager with your OSM username and password from
the device you are using, an authorisation message will appear. Click ‘Grant Access’ so that your OSM
login details will sync to the Tasking Manager. You will notice that your username now displays in the
upper right hand corner of the page.
Finding a Project
The ‘Explore Projects’ button along the top of the Tasking Manager will display a list of current mapping
projects as shown below:
Each project listed will describe:
1. The urgency of the project
2. The project number and name - this will often include the location, the type of humanitarian re-
sponse, and the focus feature being mapped

3. Any important information e.g. type of mapper needed / experience level
4. A description of the project
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5. The organization requesting the project
6. The category of the project
7. The level of experience amapper needs to contribute
8. The percentage of the project mapped so far (dark grey in the progress bar)
9. The percentage of the project validated so far (red in the progress bar)
10. The total number of contributors
If you have a specific project to contribute to, you can search for it in the sidebar to the left of your screen.
You can search by:

• Project name or number
• Level of mapping difficulty
• Organization
• Campaign
• Location
• Type of mapping (features being mapped)

You can also view the list of projects on the map. You can switch the map on and off by selecting the
toggle in the upper right hand side. Projects are clustered together on the map into circles which display
the number of projects in a particular area.
You can zoom into an area to view a breakdown of projects in a particular region.
Selecting a Project
Once you have decidedwhich project youwant tomap, you can click on a tile to open a project page. This
page provides specific details on the project objectives and requirements.
Underneath the project description you will see a series of icons. The bold icons indicate which entities
to map (which features e.g. buildings, roads).
Once you select ‘Contribute’ more detailed instructions are provided, with specific guidelines (mapping
notes). The Project Specific Mapping Notes section gives detailed instructions on the imagery to use,
how to trace specific features, and how to tag features.
Mapping features which are the focus point of the project are explained in further detail underneath the
Project Specific Mapping Needs. These feature specifications will describe common tags used for each
main feature and provide tips for mapping that feature.
The overview map on the right-hand side of the project you have selected is split into squares which are
colour coded dependent on the completion of the mapping in that square. The colours represent the
following:

• White: a tile is ready to bemapped and needs to be completed
• Blue: a tile has beenmapped and is ready to be validated
• Yellow: a tile has been invalidated. This could be because an area was not fully mapped or multiple
errors need to be corrected

• Green: a tile hasbeenvalidated. Thismeans that themapping in this areahasbeenquality checked,
edited if necessary, andapproved. Validatorswill leave comments next to a tile to show the changes
they havemade

• Grey: a tile has beenmarked as having bad imagery
• Black padlock: a tile is locked by another user
• Red padlock: a tile is locked by you

Click on awhite tile to beginmapping an area that is in need ofmapping. When you click on awhite tile the
outline of the square will turn bold and the button in the lower right hand corner will display ‘Map selected
task’.
Prior to selecting a task you may also click ‘Map a task’, this will allocate one randomly to you. You can
also specify the editor you will be using. Select ‘JOSM’ or ‘iD Editor’ from the popup list before you start
mapping.
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Additional Resources
• OSM Tasking Manager Wiki
• Learn How to Use the Tasking Manager
• TwoMinute Tutorials: How to use the OSM Tasking Manager
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2.4 Editingwith iD and JOSM
This section provides:

• A comparison of OpenStreetMap editing tools, JOSM and iD Editor
• An overview of iD Editor, including presentation slides
• An overview of JOSM, including presentation slides

The following materials are designed to assist project managers and others leading trainings and work-
shops. If you are an individual interested in learning how to map with OpenStreetMap using iD Editor or
JOSM, please visit LearnOSM.org.

Overview
There are several ways to edit inOpenStreetMap. The twomost commonly used tools andbest programs
for mapping projects are iD editor and JOSM. This section provides an overview of each tool as well as
presentations to be used in trainings. For self-pacedmaterials and guides, visit LearnOSM.
The following section is designed to provide Project Managers and OSM Communities with guidance in
making management decisions.

Comparison of Tools
iD Editor The iD editor is a user-friendly tool that allows you to directly make changes in Open-
StreetMap.
iD Editor is best for:

• Simple edits
• Fast Internet access to load the imagery and save the edits.
• Following a consistent and simple tagging scheme.
• When you are restricted from installing a program on the computer you are using.

Skills and TechnologyNeeded:
• Computer
• Mouse
• Strong Internet connection
• OSM account

JOSM JOSM (Java OpenStreetMap Editor) is an open source editor for OpenStreetMap data with of-
fline compatibility.
JOSM is best for:

• Adding many buildings (See buildings_tool plugin).
• Editing many polygons or lines that already exist.
• When you are on an unreliable Internet connection or offline.
• Using a specific tagging scheme (or custom presets).

Skills and TechnologyNeeded:
• Computer
• Mouse
• Minimal/intermittent internet connection for data download & upload
• OSM account
• Installation files (Recommended: download installation files for offline sharing and installation)

– Java (Install this file before installing JOSM)
– Java OpenStreetMap Editor Installer
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Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following presentation(s) can be used to lead a training or workshop.

• Introduction to iD Editor
• Introduction to JOSM

Additional Resources
• LearnOSM
• AwesomeOSM: A Comprehensive Guide onMapping Building Footprints
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Example of data validation

Figure 20: Example of data validation

Example of data completeness

Figure 21: Example of data completeness

2.5 Validatingwith JOSM
This section provides:

• An overview of Validation in JOSM, including presentation slides
• Step-by-step instructions for practicing validation in JOSM

The following materials are designed to assist project managers and others leading trainings and work-
shops. However, this material is also suitable for individuals interested in learning how to validate OSM
data in JOSM.

Overview
Validation is a process of checking the data quality (in this case, map data quality) for accuracy, consis-
tency, completeness and anomaly. Validation is important to maintain the quality of OSM data. When
checking for accuracy, you need to make sure that the map data is aligned with the imagery and is cor-
rect in terms of geometry. For consistency, make sure that all mapped objects are consistent in shape.
For example, when you found a residential area, make sure all the buildings are consistently traced and
orthogonalized.
For completeness, it depends on what information you want to collect whenmapping and what mapping
method is used. Information collected using remotemappingmethodwould be different with the informa-
tion collectedby conducting field survey. Information collectedusing remotemappingmethodwill be very
limited since you only have satellite imagery and gpx tracks available as reference. For anomaly, make
sure there is no abnormal looking mapped objects. See the picture below, the mapped buildings on the
left tends to be smaller than the mapped buildings on the right. After carefully checking the imagery, it
turns out that the smaller buildings are actually tombs that are mapped as buildings.
While light validation can be completed using iD Editor, HOT recommends that detailed validation be
completed using JOSM.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following presentation(s) can be used to lead a training or workshop.

• Validation in JOSM
The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

Practice Validation

The following activity covers the process of validating bad OSM data in JOSM. This activity uses an ex-
ample file that can be downloaded here [2].
Skills and TechnologyNeeded

• Computer
• Internet connection (for data download)
• OSM account
• JOSM
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JOSMMenu File

Figure 22: JOSMMenu File

Opening an osm file on JOSM

Figure 23: Opening an osm file on JOSM

• Example .osm file
Estimated time for completion: 1 hour
Objectives:

• To be able to understand validation process for OSM data
• To be able to perform validation using Validation Tools on JOSM
• To be able to fix commonly error, warning andmistake found during validation

1. OpeningOSMData
After successfully downloadedsample data, open filevalidation_sample.osm into your JOSMby follow-
ing these steps:

• Click menu File Open
JOSMMenu File

• Go toyourdirectorywhereyousavevalidation_sample.osm. Select thefilevalidation_sample.osm
and then clickOpen.

Opening an osm file on JOSM
• After opening the exercise file, your JOSMwill look like this:

Exercise file on JOSM
2. Using JOSMValidation Tools
JOSM provides a built-in validator that checks and fixes invalid map data called Validation Tools. After
checking for accuracy, consistency, completeness and anomaly, run this validation tools so that the map
data is perfectly valid. To get started with the Validation tools, you need to activate the Validation Results
Windows by following these steps:

• Click menuWindows  Validation Results
Windowsmenu on JOSM

• Validation results Windows will appear on the left side of your JOSM
Validation results Windows
After activating the Validation Results Windows, now you can start validation using JOSM Validation
Tools. Download OSM data first using either Slippy Map or Tasking Mananger, then you can click the
Validation button in the Validation Results Windows. Let’s use OSM data sample for exercise.

• To run validation on all the data in the current data layer, which is validation_sample.osm, make
sure that there is no data selected. Then, clickValidation button in the ValidationResultsWindows.
Once the validation process is finished, Validation Results Windows will be filled with listed errors
and warnings. The amount of errors and warnings found depends on the quality of the data. For
example, on this OSM data sample, you will find one error and twenty one warnings.

Validation Results fromOSMData Sample

Exercise file on JOSM

Figure 24: Exercise file on JOSM
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Windowsmenu on JOSM

Figure 25: Windowsmenu on JOSM

Validation results Windows

Figure 26: Validation results Windows

• Anew layer calledValidationerrorswill alsobeadded to theLayersWindows. This layerwill highlight
the errors and warnings found - red highlight for errors and yellow highlight for warnings.

Highlighted errors and warnings
3. Fixing Errors andWarnings
Errors are important to fix. Do not ignore errors. If you have errors on your OSM data, you won’t be able
to upload it into OSMServer until you fix the errors. Some errors can be fixed automatically using the Fix
buttononValidationResultsWindows. Warningsareproblems that are important to fix, but in somecases,
such as “UnnamedWays”, they are tolerable. Mostly, warning should be fixed manually. Now, let’s try to
fix errors and warnings found on validation_sample.osm. There are one error and twenty one warnings
found on validation_sample.osm. They are:

• Error: Duplicated ways (1)
• Warning: Building inside building (4)
• Warning: Crossing building/highway (1)
• Warning: Crossing buildings (1)
• Warning: Crossing highways (1)
• Warning: deprecated tagging - amenity=hotel is deprecated, use tourism=hotel instead (1)
• Warning: missing tag - incomplete object: only name (1)
• Warning: node connects highway and building (1)
• Warning: Overlapping highways (1)
• Warning: Unclosed way - building (1)
• Warning: Unnamed ways (6)
• Warning: Untagged ways (1)
• Warning: Way end node near other highway (2)

Now, let’s fix all the errors and warnings one by one.
3.1 Fixing Error: Duplicatedways
Duplicated ways error come up when there are ways that duplicate. This is usually caused by unstable
internet connection when uploading OSM data into OSM server. Initially, to fix errors or warning, you
should select the error or warning youwant to fix. Go to theDuplicatedways error in the ValidationResult
Windows, click the + icon so that it looks like the picture below.
Duplicated objects on Validation Results
Select the objects where it is duplicated andRight-click  Zoom to problem to zoom and see the dupli-
cated objects. Your map canvas will zoom in to the duplicated objects. Fortunately, duplicated ways can
be automatically fixed. After selecting the duplicated objects, click Fix. Voila, your error is fixed!
Zooming to Error: Duplicated ways
3.2 FixingWarning: Building inside building
Building inside building warning come up when there is a building object inside another building object.
To fix it, go to the building inside building warning in the Validation Results Windows, click the + icon so
that it looks like the picture below.
Building inside building on Validation Results

Validation Results fromOSMData Sample

Figure 27: Validation Results fromOSMData Sample
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Highlighted errors and warnings

Figure 28: Highlighted errors and warnings

Duplicated objects on Validation Results

Figure 29: Duplicated objects on Validation Results

Select the objects listed under the warning Building inside building andRight-click  Zoom to problem
to zoom and see the objects. Your map canvas will zoom in to the objects.
Zooming toWarning: Building inside building
Mostofwarningshouldbefixedmanually. Tofixbuilding insidebuilding, simplydeleteoneof thebuildings.
To decide which one to be deleted, please take a look at the imagery and carefully decide which one to be
deleted. Voila, you just fixed a building inside building.
Fixing a building inside building warning
3.3 FixingWarning: Crossing building/highway
Crossing building/highway come up when there is a building crossing with highway. To fix it, go to the
crossing building/highway warning in the Validation ResultsWindows, click the + icon so that it looks like
the picture below.
Crossing building/highway on Validation Results
Select the objects listed under the warning Crossing building/highway andRight-click  Zoom to prob-
lem to zoom and see the objects. Your map canvas will zoom in to the objects.
Zooming toWarning: Crossing building/highway
To fix crossing building/highway, simply move one of the crossed objects, either the building or the seg-
ment/node of the highway. To decide which object that should be moved, please take a look at the im-
agery.
Fixing a crossing building/highway warning
3.4 FixingWarning: Crossing buildings
Crossing buildings warning come up when there are two or more buildings overlapped with each other.
To fix it, go to the crossing buildings warning in the Validation Results Windows, click the + icon so that it
looks like the picture below.
Crossing buildings on Validation Results
Select the objects listed under the warning Crossing buildings and Right-click  Zoom to problem to
zoom and see the objects. Your map canvas will zoom in to the objects.
Zooming toWarning: Crossing buildings
To fix crossing buildings, simply move one of the overlapped buildings so that they wont be overlapping
anymore. To decide which buildings that should bemoved, please take a look at the imagery.
Fixing a crossing buildings warning
3.5 FixingWarning: Crossing highways
Crossing highways warning come up when there are highways that cross each other with no crossing
node. To fix it, go to the crossing highways warning in the Validation ResultsWindows, click the+ icon so
that it looks like the picture below.
Crossing highways on Validation Results

Zooming to Error: Duplicated ways

Figure 30: Zooming to Error: Duplicated ways
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Building inside building on Validation Results

Figure 31: Building inside building on Validation Results

Zooming toWarning: Building inside building

Figure 32: Zooming toWarning: Building inside building

Select the objects listed under the warning Crossing highways and Right-click  Zoom to problem to
zoom and see the objects. Your map canvas will zoom in to the objects.
Zooming toWarning: Crossing highways
To fix crossing highways, simply add a crossing node in the highway intersection. To add node at inter-
section, you can use JOSM additional tools, but first you have to activate plugin utilsplugins2. You can
go to menu Preferences Plugins, search for utilsplugins2 and give a check for utilsplugin2.
Activating plugin utilsplugins2
To add node at intersection, select the two crossing highways, and go tomenuMore toolsAddnodes
at intersections. And voila, your crossing highways now have a crossing node.
Adding node at intersection
3.6 FixingWarning: deprecated tagging
Deprecated tagging warning come up when there is an object or more in your OSM data that used depre-
cated tagging. To fix it, go to the deprecated tagging warning in the Validation ResultsWindows, click the
+ icon so that it looks like the picture below.
Deprecated tagging on Validation Results
Select the objects listed under the warning deprecated tagging and Right-click  Zoom to problem to
zoom and see the objects. Your map canvas will zoom in to the objects.
Zooming toWarning: deprecated tagging
Fortunately, deprecated tagging can be fixed automatically using Fix button. After selecting the object
that has deprecated tagging, press the Fix button. JOSM will automatically change the deprecated tag
into the new one.
Fixing deprecated tagging
3.7 FixingWarning: missing tag
Missing tag warning come up when there is one or more objects that have no tag or the tag is incomplete.
To fix it, go to the missing tag warning in the Validation Results Windows, click the + icon so that it looks
like the picture below.
Missing tag on Validation Results
Select the objects listed under thewarningmissing tag andRight-clickZoom toproblem to zoomand
see the objects. Your map canvas will zoom in to the objects.
Zooming toWarning: missing tag
In this case, the object “Monrovia Park” only has tag name. It does not have the tag that identify it as park.
What you have to do is simply add a tag to define that it is a park, namedMonrovia Park. To add tag, click
menu Presets  Search preset… and search for Park. Select one that suits the kind of park you map,
in this case you can select Geography/Landuse/Park, then clickSelect. Leave the name as is, then click
Apply Preset.
Adding tag

Fixing a building inside building warning

Figure 33: Fixing a building inside building warning
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Crossing buildings on Validation Results

Figure 34: Crossing buildings on Validation Results

Zooming toWarning: Crossing buildings

Figure 35: Zooming toWarning: Crossing buildings

Fixing a crossing buildings warning

Figure 36: Fixing a crossing buildings warning

Crossing highways on Validation Results

Figure 37: Crossing highways on Validation Results

Zooming toWarning: Crossing highways

Figure 38: Zooming toWarning: Crossing highways

Activating plugin utilsplugins2

Figure 39: Activating plugin utilsplugins2

Adding node at intersection

Figure 40: Adding node at intersection

Deprecated tagging on Validation Results

Figure 41: Deprecated tagging on Validation Results

Zooming toWarning: deprecated tagging

Figure 42: Zooming toWarning: deprecated tagging

Fixing deprecated tagging

Figure 43: Fixing deprecated tagging

Missing tag on Validation Results

Figure 44: Missing tag on Validation Results

Zooming toWarning: missing tag

Figure 45: Zooming toWarning: missing tag

Adding tag

Figure 46: Adding tag

Fixing missing tag warning

Figure 47: Fixing missing tag warning
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Node connects highway and building on Validation Results

Figure 48: Node connects highway and building on Validation Results

Zooming toWarning: Node connects highway and building

Figure 49: Zooming toWarning: Node connects highway and building

Fixing missing tag warning
3.8 FixingWarning: node connects highway and building
Node connects highway and building warning come up when there is a building node connects with high-
way. To fix it, go to the node connects highway and building warning in the Validation Results Windows,
click the + icon so that it looks like the picture below.
Node connects highway and building on Validation Results
Select the objects listed under thewarning node connects highway and building andRight-clickZoom
to problem to zoom and see the objects. Your map canvas will zoom in to the objects.
Zooming toWarning: Node connects highway and building
To fix this, simply separate the connected nodes by selecting the connected nodes first then click menu
ToolsUnglueWays or pressG on keyboard for shortcut. After separating the connected nodes, keep
in mind to move either the whole building or the highway’s node since both nodes are still overlapping.
Zooming toWarning: Node connects highway and building
Fixing node connects highway and building warning
3.9 FixingWarning: Overlapping highways
Overlapping highways come up when there are highways overlapping each other. To fix it, go to the over-
lappinghighwayswarning in theValidationResultsWindows, click the+ iconso that it looks like thepicture
below.
Overlapping highways on Validation Results
Select the objects listed under the warning overlapping highways and Right-click  Zoom to problem
to zoom and see the objects. Your map canvas will zoom in to the objects.
Zooming toWarning: Overlapping highways
To fix this warning, firstly you should split the overlapped segment of the highway. Select one end node
where the highways are overlapped, then clickmenuToolsSplit way or pressP on keyboard for short-
cut. Selet the other end node where the highways are overlapped, and then menu Tools  Split way or
press P on keyboard again. Now the overlapped segment have splitted. All you have to do now is to
delete the overlapped segment by selecting the segment and then press delete on your keyboard.
Fixing overlapping highways warning
3.10 FixingWarning: Unclosedway - building
Unclosedway - buildingwarningcomeupwhen there is oneormorebuildingsdrawnasunclosedpolygon.
This happens when you draw buildingmanually using node tools without building tools and the first node
and the last node are not merged. To fix it, go to the unclosed way - building warning in the Validation
Results Windows, click the + icon so that it looks like the picture below.
Unclosed way - building on Validation Results
Select the objects listed under the warning unclosed way - building andRight-click  Zoom to problem
to zoom and see the objects. Your map canvas will zoom in to the objects.

Zooming toWarning: Node connects highway and building

Figure 50: Zooming toWarning: Node connects highway and building
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Fixing node connects highway and building warning

Figure 51: Fixing node connects highway and building warning

Overlapping highways on Validation Results

Figure 52: Overlapping highways on Validation Results

Zooming toWarning: Unclosed way - building
To fix this, select the first node and the last node of the building and merge it by clicking menu Tools 
MergeNodes or pressingM on keyboard. And voila, now your building is a closed polygon.
Fixing unclosed way - building warning
3.11 FixingWarning: Unnamedways
Unnamedwayswarningcomeupwhen there isoneormorehighways (main road) thatdonothavenames.
This warning is one of the tolerable warning, so you can just ignore this. If you know the name of the road,
you can add the road’s name by adding tag name to the road. However, if you do not know the name,
please just leave it as is rather thangivinga randomname that couldbemisleading. To ignore thiswarning,
you can just leave it as is or you can also put it on your Ignore list so that this warning does not come up
when you perform validation in the future. Click the “Unnamed Ways” warning in the warning list, then
click Ignore and clickWholeGroup.
Putting a warning into Ignore List
You can always put it back to your warning list if you change your mind, so that this warning will come up
again when you perform validation by clickingManage Ignore, then right-click on the warning you want
to put back and chooseDon’t Ignore.
Managing Ignore List
3.12 FixingWarning: Untaggedways
Untaggedwayswarningcomeupwhen there isuntaggedobject. Tofix it, go to theuntaggedwayswarning
in the Validation Results Windows, click the + icon so that it looks like the picture below.
Untagged ways on Validation Results
Select the objects listed under the warning untagged ways andRight-clickZoom to problem to zoom
and see the objects. Your map canvas will zoom in to the objects.
Zooming toWarning: Untagged ways
To fix it, just simply add tag/preset to the object. Please take a look at the imagery to decide what tag to
add to the object. Select the object and then go to menu Preset and select the tag that suits the object.
For example, if this object turns out to be hospital, add tag/preset hospital.
Fixing untagged ways warning
3.13 FixingWarning: Way end node near other highway
To fix way end node near other highway, go to the way end node near other highway in the Validation
Results Windows, click the + icon so that it looks like the picture below.
Way end node near other highway on Validation Results
Select the objects listed under the warning untagged ways andRight-clickZoom to problem to zoom
and see the objects. Your map canvas will zoom in to the objects.
Zooming toWarning

Zooming toWarning: Overlapping highways

Figure 53: Zooming toWarning: Overlapping highways

41



Fixing overlapping highways warning

Figure 54: Fixing overlapping highways warning

Unclosed way - building on Validation Results

Figure 55: Unclosed way - building on Validation Results

Zooming toWarning: Unclosed way - building

Figure 56: Zooming toWarning: Unclosed way - building

Fixing unclosed way - building warning

Figure 57: Fixing unclosed way - building warning

Putting a warning into Ignore List

Figure 58: Putting a warning into Ignore List

Managing Ignore List

Figure 59: Managing Ignore List

Untagged ways on Validation Results

Figure 60: Untagged ways on Validation Results

Zooming toWarning: Untagged ways

Figure 61: Zooming toWarning: Untagged ways

Fixing untagged ways warning

Figure 62: Fixing untagged ways warning

Way end node near other highway on Validation Results

Figure 63: Way end node near other highway on Validation Results

Zooming toWarning

Figure 64: Zooming toWarning
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FixingWarning

Figure 65: FixingWarning

To fix it, select the end node and then activate Draw mode by pressing A on keyboard. Then, draw the
road so that it is connected to the road nearby.
FixingWarning
Congratulations! Now you have finished fixing errors and warnings in the validation_sample.osm. Hope-
fully after completing this exercise, you canperformvalidation forOSMdata. More validatormeansbetter
OSM data quality.
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Example of Conflict DetectionWindow in JOSM

Figure 66: Example of Conflict DetectionWindow in JOSM

2.6 Resolving conflicts in JOSM
This section provides:

• An overview of data conflict in OpenStreetMap
• Step-by-step instructions for resolving data conflict in JOSM
• Guidance on preventing andmanaging data conflict

The following materials are designed to assist project managers and others leading trainings and work-
shops. However, this material is also suitable for individuals interested in learning how to validate OSM
data in JOSM.

Overview
Other contributors may have edited the same features as you in JOSM. Alternatively, different data may
have been collected in the field for the same features. Both situations cause data conflicts during the up-
load process. Therefore, it is critical for digitizers to learn about data conflicts in OpenStreetMap, conflict
types, and how to fix them using JOSM.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

Resolving Data Conflicts in JOSM

Objectives:
• Participants can explain data conflicts on OpenStreetMap
• Participants can describe the different types of conflict in JOSM
• Participants can fix data conflicts using JOSM
• Participants learn how to avoid data conflicts in JOSM

1. Data Conflicts in OpenStreetMap
While uploading your edits in JOSM (learnmore about this in 2.4 Editingwith iD and JOSM), youmight
have received amessage like this:
Example of Conflict DetectionWindow in JOSM
This indicates a data conflict in OSM. A conflict has occurred because you have been editing the same
data/object(s) as another contributor simultaneously. Thus, the other contributor has uploaded their
changes first and they have been received by the OSM Server. You are attempting to upload the same
data/object(s) with your own changes. Therefore, your changes are automatically rejected by the server
because it causes confusion.
You will come across data conflicts in JOSM when you are editing, adding, or deleting objects which are
beingworked on by another contributor. The other contributor has uploaded their changes slightly before
you. Therefore, when you try to upload your changes, it causes confusion for the OSM Server because
it does not know which changes are correct. If this happens, the data conflict must be fixed before you
upload your changes.
Example why conflict happens in JOSM
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Example why conflict happens in JOSMExample why conflict happens in JOSM

Figure 67: Example why conflict happens in JOSMExample why conflict happens in JOSM

Conflict Property Window

Figure 68: Conflict Property Window

The image above illustrates a potential conflict stemming from the different positioning of the rectangular
object inMy version and Their version (which has already been received by the server). To resolve this
conflict, you have to choose either ‘My Version’ or ‘Their Version’ (see section 3. Fixing Data Conflicts
in JOSM).
2. Types of Data Conflict in JOSM
2.1 Conflict of Properties
A conflict of properties occurs when an object has beenmoved or deleted and one ormore of its nodes is
in a different location than the other version.
Conflict Property Window
The image above illustrates a conflict of properties in JOSM. In My version the object is square and in
Their version a corner nodes has been deleted. To fix this, you need to choose which version is correct.
2.2 Conflict of Tags
A conflict of tags occurs when different tags have been assigned to the same object by multiple contribu-
tors. The tag can be deleted or changed to the other version.
Conflict of Tag in JOSM
The image above illustrates varied tags for the same object between two versions in JOSM.My version
has Rumah Sakit tag (amenity = hospital) and a name value of ‘Rumah Sakit Tebet Raya’. While Their
version has tag (amenity = clinic) and a name value of ‘RS Tebet Timur’. You have to choose which
version has the correct information before uploading to the server.
2.3 Conflict of Nodes
A conflict of nodes occurs when there are differences in the direction of a way or if nodes in a way have
been deleted or moved.
Conflict of Nodes in JOSM
3. Fix Conflict Data in JOSM
Fixing conflict data in JOSM is quite simple, even though most OSM contributors do find it confusing.
Essentially, you have to decide which is the correct version and choose to keep your version or delete
your version and use their version. To fix conflict data in JOSM:

• When the conflict window appears, you might be inclined to select the Synchronize node
5,960,126 only option. However, this option will only fix the conflict in one node. Instead, select
Synchronize entire dataset so you can resolve all conflicting nodes in one go.

Conflict DetectionWindow in JOSM
• JOSMwill then display the number of conflicts, selectOK.

Number of detected conflict
• In the ‘Windows’ menu, selectConflict to show the conflict window. This activates a list of conflicts
in theConflict panel to the lower right corner of JOSM. You can choose which conflict you want to
fix and selectResolve.

Conflict of Tag in JOSM

Figure 69: Conflict of Tag in JOSM
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Conflict of Nodes in JOSM

Figure 70: Conflict of Nodes in JOSM

Conflict DetectionWindow in JOSM

Figure 71: Conflict DetectionWindow in JOSM

Conflict panel to fix detected conflict
• When you select theResolve button, the conflict window appears and shows details about the con-
flict. This might look complicated but it is actually fairly straightforward. You can tell which conflict
type has been detected because a red square symbol will display in the corresponding tab (either
properties, tags or nodes). You can look at a list of changed or moved coordinates as shown in the
image below.

AWindow to Resolve Conflict
• You can only resolve one conflict at a time. If you are sure that your version is the correct one (you
edit / add the object based on your field surveymapping or you already know the object personally),
then chooseMyVersion (local dataset). However, if you are not sure about your version and think
that the other version ismore convincing selectTheir version (serverdataset). Select: blue arrow
in the version you think is right. If the conflict has been fixed then the symbol in the tab will change
to: green check

Choose one of the versions to resolve data conflict
• After you have selected the right version, make sure the color of the conflict box has changed from
pink to green. This indicates you have successfully fixed the conflict.

Difference color between original conflict and resolved conflict
• SelectApply Resolution as shown in the picture above. When you have resolved all conflicts, you
can upload your OSM changes.

Resolved conflict window
• You can also resolve conflicts by right clicking one in the conflict window and selecting either Re-
solve tomyversions orResolve to their versions. You can also right click andZoom toConflict.

Window of list conflict on JOSM_
Note : You cannot upload changes until you have resolved all conflicts. Be careful when re-
solving the conflicts and check them one-by -one.

4. Avoiding Data Conflict in JOSM
To avoid conflicts:

• Upload your changes continuously
To minimize conflicts, you should frequently upload. Upload your changes every 20 buildings or
every 15minutes. The longer you wait to upload the higher the chance that another contributor has
edited and uploaded the same data.
You can update your OSM data first before uploading. This allows you to retrieve the latest OSM
data from the server before uploading. Select File → Update data or Update Modified and wait
until it has finished updating. Then you can upload your changes.
Update data options in file menu

• Edit Only in DownloadedArea

Number of detected conflict

Figure 72: Number of detected conflict
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Conflict panel to fix detected conflict

Figure 73: Conflict panel to fix detected conflict

AWindow to Resolve Conflict

Figure 74: AWindow to Resolve Conflict

Restrict editing to your downloaded area tominimize conflict risk in JOSM. The area outside of your
downloaded area is marked by diagonal lines, do not edit this region.
Downloaded Area (black) dan Outside Downloaded Area (diagonal lines)

• Using TaskingManager
If youwant to do collaborativemapping, you can use TaskingManager. It divides a project area into
agridof tasks. Oncea task is selected it is lockedandcannot bechosenbyanother contributor. This
allowsmany people to work in the same area at the same timewhile limiting the chance of conflicts.
Tasking Manager Interface (tasks.openstreetmap.id)

Summary
If you have followed all the steps in this chapter, you’ll have a good understanding of data conflicts in
JOSM - congratulations!

Choose one of the versions to resolve data conflict

Figure 75: Choose one of the versions to resolve data conflict
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Difference color between original conflict and resolved conflict

Figure 76: Difference color between original conflict and resolved conflict

Resolved conflict window

Figure 77: Resolved conflict window

3.0 Introduction to Technical Set-up for FieldMapping
In this section, Project Managers will find tools and resources to determine which data collection tools
are appropriate and how to navigate the technical steps needed to prepare for a field mapping project
including:

• Presentations and step-by-step guides for developing a data model suitable for uploading to
OpenStreetMap

• Resources for determining the correct mobile data collection, navigation applications, and server
options for your project

• Detailed guides and resources for setting up applications such as OpenMapKit

Any field project will require somedegree ofFieldMappingTechnicalSet-Up regardless of the complex-
ity of the data collection workflow. This section is designed to guide project managers and community
members through the decisionmaking process to determine what tools and steps are necessary for their
specific project. Many technical guides exist on setting up and using specific tools such as OpenDataKit
andPOSM. To support projectmanagers effectively, step-by-step guides are provided for some tools and
processeswhere external documentation is lacking orHOThaspreviously created tailoredmaterials. For
tools andprocesseswith quality guides andmaterials outside ofHOT resources, external links havebeen
provided.

• 3.1 Designing the Data Model covers the workflow and tools needed to develop a data model for
OSM data collection.

• 3.2 Data Collection Applications provides guidance on selecting the appropriate data collection ap-
plication for your project. Sub-pages also provide detailed instructions and resources on setting up
specific tools such as ODK and OMK.

• 3.3 Navigation Applications provides an overview of navigation applications and how they can be
used by project managers for their project.

• 3.4 Data Collection Servers provides guidance on determining if a server is necessary for your
project and selecting the appropriate server for based on data and resource needs.

The following presentation(s) can be used to lead a training or workshop:
• Data Models and Tagging

Window of list conflict on JOSM_

Figure 78: Window of list conflict on JOSM_
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Update data options in file menu

Figure 79: Update data options in file menu

Downloaded Area

Figure 80: Downloaded Area

3.1 Designing TheDataModel
This section provides:

• An overview of data models and OpenStreetMap tagging, including presentation slides
• Step-by-step instructions for tools to help build your data model
• Step-by-step instructions for creating your data model

Overview
When beginning a mapping project, a data model will need to be created in order to determine what fea-
turesaremappedand thedetails collected for eachof those features. Adatamodeldefineswhat features
are surveyed or mapped and what attributes are collected for each feature. If a project will upload data to
OpenStreetMap, the data model should be designed to match OSM tagging.
Example data models:

• Uganda Refugee Crisis
• Ramani Huria

OSM doesn’t work with layers or attribute tables, but tags. Tags are used in OSM to categorize features,
and to add information that is useful for understanding of themap, planning, routing, and querying. Each
tag consists of a key, and a value. Eachmap feature should have one or more tags such as:

• building=residential
• highway=primary
• amenity=school

In addition, each of these features can have an unlimited number of related attributes added into OSMas
tags. For example, a building might have the following tags:

• building=commercial
• building:material=brick
• roof:material=metal
• shop=tailor

Creating a data model should be done in collaboration with all stakeholders in order to ensure that all
necessary information is collected - it is a lot more difficult to revisit a location for mapping to collect addi-
tional information. At the same time, when designing a data model you should consider how much time
it will take for a surveyor to complete data collection - every feature type, attribute, or question will add
additional time needed.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following presentation(s) can be used to lead a training or workshop.

• Data models and tagging

Tasking Manager Interface

Figure 81: Tasking Manager Interface
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osm_wiki_map_features

Figure 82: osm_wiki_map_features

taginfo

Figure 83: taginfo

The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

• Tools for creating your data model
• Creating your data model

Tools for creating your datamodel

HOT recommends using TagInfo and theOSMWiki to search for existingOSM featureswhen developing
your data model. The following steps will provide an introduction to how to use these tools.
Skills and TechnologyNeeded

• Computer with
• Internet connection
• OpenStreetMap Account
• Recommended: computer mouse

How toUse theOSMWiki
1. Navigate to https://wiki.openstreetmap.org/wiki/Map_Features in a Google Chrome or Mozilla
Firefox internet browser.

2. This page provides documentation on common, existingOSM features categorized by type. These
tables contain keys and values, along with comments and sometimes pictures to help define the
tag. Scroll through the tables to explore the tags described.

3. Search for a particular tag by using ‘Ctrl+F’ on your keyboard. As anexample, search for the tag that
should be used for hospitals. To do so, hit ‘Ctrl+F’ on you keyboard, type ‘hospital’ in the search bar,
and hit enter. This will bring you to the appropriate tag for hospitals. Note: theremight bemore than
one appropriate tag for a search item. Scroll through the results until you find the appropriate tag.

4. Keys and values within the tables will also link out to individual wiki pages for those features. For
example, by clicking on “hospital” under amenities, you will be redirected to https://wiki.openstree
tmap.org/wiki/Tag:amenity%3Dhospital. This page provides in-depth detail about the tag as well
as related tags and tips on how to map a particular feature.

5. To practice, search for other key words relating to features you would want to map to discover keys
and values related to that feature.

How to use TagInfo
1. Navigate to https://taginfo.openstreetmap.org in a Google Chrome or Mozilla Firefox internet
browser.

2. In the upper left corner, use the search bar to find a tag. For this activity, search for “roof”.
3. The next windowwill allow you to select from existing keys, values, and relations that contain “roof”.
4. Selecting one of these optionswill bring you to an information page about that key, value, or relation.
For this activity, find and click on “roof:material”.

5. You will now see an information page about the tag “roof:material” including values that have been
usedwith thekey “roof:material”, combinationsofother tags thathavebeenusedwith thekey, amap
of the key’s global use distrubtion if there are enough use cases, and links to any existing related
OSMWiki pages.

6. To practice, search for other key words relating to features you would want to map to discover keys
and values related to that feature.
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Creating your datamodel

The following activity will guide you through the process of creating a data model. While this process
could be done by hand or in document software (such as Google Docs or Microsoft Word), spreadsheet
software is the recommendedmethod of documenting your data model.
Skills and TechnologyNeeded

• Computer with
• Internet connection (recommended for accessing TagInfo and OSMWiki)
• OpenStreetMap Account
• Recommended: computer mouse
• Spreadsheet software, such as LibreCalc, Google Sheets, or Excel (recommended for structuring
your data model)

Datamodel workflow
Designing a datamodel based onOSM tagging is typically defined by the following questions and work-
flow:
1. What is the focus of the data collection? Consider how the data will be used.
2. What features do you want to collect? Identify the focus of the data collection.
3. Where are you collecting data? Data models can differ based on their location.
4. What has been done before? Draft data model by leveraging similar models.
5. What tags exist for features?

1. Verify tag status through OSMWiki
2. Verify tag usage through TagInfo

6. Use approved tags where possible in data model
7. Do all stakeholders agree on the data model? Review data model and incorporate feedback from
project partners (adding, removing, or changing datamodel features can delay field data collection
and decrease data quality!)

Create a list of all of the features that you want to collect. For example: buildings, water points, roads.

Feature
Buildings
Water Points
Roads

Go toOpenStreetMapwiki to search for the appropriate key for each feature, and value if there is only one
value option.

Feature Key Value
Buildings building
Water Points amenity water_point
Roads highway

For features with multiple values, such as buildings, use the OSMWiki page for that key as well as Tag-
Info to find appropriate values. These values should only be what is reasonable for your data collection.
While it would be ideal to collect every building type in a city, your project might only be able to collect all
school and hospital buildings. Note: values in your datamodel shouldmake sense for the context of your
geography. For example: hut is an appropriate value for buildings in Liberia, but not likely in Germany.
Additionally, youmay need to interpret an existing value type to best match the appropriate value for your
region.

Feature Key Value
Buildings building residential, school, civic
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Feature Key Value
Water Points amenity water_point
Roads highway primary, secondary, residential

Once you have the base tags for your features, you can decide on what attributes you want or can collect
for each feature.

Feature Key Value
Buildings building residential, school, civic

building:material
building:levels
roof:material

Water Points amenity water_point
status

Roads highway primary, secondary, residential
name
condition
surface
width

Next, values can also be determined for each attribute key. These options can be determined using the
OSMWiki and TagInfo, or in some cases can be defined by the mapper - such as for numeric answers or
names.

Feature Key Value
Buildings building residential, school, civic

building:material cement_block, brick, wood, mud
building:levels numeric
roof:material thatch, metal, concrete, plastic,

tile
Water Points amenity water_point

drinking_water yes, no
Roads highway primary, secondary, residential

name user defined
condition excellent, good, poor
surface gravel, paved, dirt
width numeric

Once completed with your data model, this data model should be checked by your stakeholders for any
gaps. Additionally, your project plan should allow flexibility so that this data model can be adjusted with
field testing and consulting your mappers.
Collecting private data Private data should never be uploaded to OSM. However, some projects do re-
quire personal information to be collected. When this is the case, the data model can include unique
non-OSM tags for private data that needs to be collected. When cleaning data following data collection,
this private data can be kept in a full dataset before being removed. Once private data is removed, the
dataset can be uploaded to OSM.
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3.2 Data collection applications
This section provides:

• An overview of data collection application options
• Guidance on selecting a data collection application for your project needs
• Brief overviews of OpenDataKit, OpenMapKit, KoboCollect, and OSMTracker

Overview
Several mobile applications exist to assist with field data collection. Choosing an application to use de-
pends on mobile device capability, varying set-up requirements, and survey needs. Options include
OpenDataKit, OpenMapKit, KoboCollect, OSMTracker, and Maps.me
## Choosing a Data Collection Application
Which data collection application should I use? Use the following table to decide which application
is best for your project and resource restrictions. These are not the only options available, but instead,
applications that HOT has used and tested in the field for mapping projects.

I want to collect… ODK Kobo OMK Maps.me
OSM
Tracker Mapillary

Qualitative survey data    × × ×
Quantitative survey data    × × ×
GPS Points      ×
Photos attached to GPS Points   × ×  ×
GPX Tracks × × × ×  
Streetview imagery × × × × × 
Data attached to OSM points of interest × ×   × ×
Data attached to OSM polygons
(i.e. buildings)

× ×   × ×

OpenData Kit (ODK)

ODK is a free an open-source set of tools which help organizations author, field, andmanagemobile data
collection solutions. ODKCollect is part of ODK and is an Android app that replaces paper forms used in
survey-based data gathering. It supports a wide range of question and answer types, and is designed to
work well without network connectivity.
Skills and TechnologyNeeded

• Computer
• Internet Connection
• Mobile devices (see 1.3 Hardware for specifications.)
• ODK forms
• Spreadsheet software (such as Excel or LibreCalc)

UseOpenDataKit (ODK) if:
• You have access to mobile devices but they have limited RAM& storage
• You do not need to collect data for buildings in OSMOR you are able to manually transfer data col-
lected as points to OSM polygons after data collection.

• You want or need to have an easy set-up option for data collection.
Resources

• OpenDataKit: https://opendatakit.org
• ODKGuide: https://docs.opendatakit.org/collect-intro
• ODK Build: https://build.opendatakit.org
• Building ODK Forms: http://xlsform.org/en

Download
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• Directly download via Google Play
• Download APK to share and install offline

Set-up and use
• For set-up, see Section 3.2.1 Setting up OpenDataKit.
• For use, see Section 4.1 Using OpenDataKit.

OpenMapKit (OMK)

OMK is an extension that launches directly from within ODK Collect when the OSM question type is en-
abled in a standard survey. It is what allows you to browse OSM features, and to create and edit OSM
tags.
Skills and TechnologyNeeded

• Computer
• Internet Connection
• Mobile devices (see Hardware for specifications.)
• OMK forms
• Spreadsheet software (such as Excel or LibreCalc)
• Additional files

– .mbtiles
– OSM layer
– Constraint file

• Recommended: OMK Server
UseOpenMapKit (OMK) if:

• You have access to mobile devices with sufficient RAM & storage (see 1.3 Hardware for specifica-
tions.)

• You need to collect data for buildings in OSM
• You have the capacity for more intensive set-up prior to data collection

Download
• Directly download via Google Play
• Download APK to share and install offline

Set-up andUse
• For set-up, see Section 3.2.2 Setting up OpenMapKit.
• For use, see Section 4.2 Using OpenMapKit.

KoBoCollect

Kobo is in almost all ways similar to ODK Collect, and is built on top of the ODK platform. Kobo also has
prebuilt analysis tools and is another popular option.
Skills and TechnologyNeeded:

• Computer
• Internet Connection
• Kobo Account
• Mobile devices (see 1.3 Hardware

Download
• DirectlydownloadviaGooglePlay: https://play.google.com/store/apps/details?id=org.koboc.collect.android&hl=en_US

Set-up andUse
Visit the KoBo Collect website: https://www.kobotoolbox.org
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Maps.Me

Maps.me is a navigation application that usesOpenStreetMap data, and can be used offline. It is suitable
for collection Point of Interest (POI) information, as far as these fit within the types of data that Maps.me
shows you on the map.
Skills and TechnologyNeeded

• Internet Connection (for application download)
• Mobile devices (see Hardware for specifications.)
• Android or iOS device

Download
• Directly download via Google Play
• Download APK to share and install offline

Additional Resources
• OSMWiki: https://wiki.openstreetmap.org/wiki/MAPS.ME

OSMTracker

OSMTracker is “an offline GPS tracker designed for collecting points of interest (POI) to be added to the
map and for recording GPX tracks.” OSM Tracker is free and open-source.
Skills and TechnologyNeeded

• Internet Connection (for application download)
• Mobile devices (see Hardware for specifications.)

Download
• Directly download via Google Play

Set-up andUse See section 4.3 Using OSM Tracker
Additional Resources

• OSMWiki: https://wiki.openstreetmap.org/wiki/OSMTracker_(Android)
• LearnOSM: https://learnosm.org/en/mobile-mapping/osmtracker/

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.

• HOT Community Webinar: Mobile Data Collection Best Practices and Tools
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3.2.1 Setting upOpenDataKit
This section provides:

• An overview of steps needed to set-up ODK
• A step-by-step guide for creating ODK survey forms, including example files
• A step-by-step guide for setting up ODK on devices

Overview
OpenDataKit (ODK) is a free an open-source set of tools which help organizations author, field, and
managemobile data collection solutions. ODKCollect is part of ODK and is anAndroid app that replaces
paper forms used in survey-based data gathering. It supports a wide range of question and answer types,
and is designed to work well without network connectivity.
Not sure if OpenDataKit is right for your project? Review Data Collection Applications.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following section is designed to serve as a self-paced guides for project managers, supervisors, or
others in setting up the application.
Set-up Process To set-up OpenDataKit for devices, you will need to follow the following steps:
1. Create ODK forms
2. Download and set up the ODK application

CreatingODKForms

When using ODK and OMK survey applications, you will need to create the files that will serve as the
survey forms.
Forms can be created using spreadsheet software (such as Excel or LibreCalc) or using the ODK Form
Builder. Documentation on how to design a form can be found here.

• Example ODK form
• Blank ODK form

FormconversionAfter forms are developed, they need to be converted from .xlsx/.xls to .xml to be used
by theODKapplication. This can be done by usingXLSformonline or offline. If usingOpenMapKit Server
or KoboToolBox server, you will not need to complete form conversion. The server will complete this
process for you.

Download and set up theODK application
Download application
The ODK application can be found on Google Play here.
If installing onmultiple deviceswith low internet resources, it is recommended to download and share the
apk offline. The APK file for OpenMapKit can be downloaded here.
Setting up application on devices
1. Find the ODKCollect app icon on your mobile device and tap to open the app.
2. After downloading the ODK app, an odk folder will be automatically created in on the internal mem-
ory of the device. Connect your device to a laptop to confirm that this folder is created. If you don’t
see this folder on your device’s internal storage, Restart the device.
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3. Once the device has been restarted, connect it to your laptop, and navigate to internal storage ->
odk folder. You will find for sub-folders inside the openmapkit folder. I.e ‘forms’, ‘instances’, ‘layers’
and ‘metadata’ folders.

4. Add your xml forms to the forms folder.
5. In theODKCollectMainMenuwindow, selectFill BlankForm. Thiswill displayall formsdownloaded
from the server, which you will be using to field data collection testing.

6. Once you confirm that you have all forms on your device, click on the device back button to exit the
ODKCollect App.
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3.2.2 Setting upOpenMapKit
This section provides:

• An overview of steps needed to set-up OMK
• A step-by-step guide for creating OMK survey forms, including example files
• Guidance on selecting an MBTile creation method and step-by-step guide on creating MBTiles.
• A step-by-step guide for creating additional files necessary for running OMK.
• A step-by-step guide for setting up OMK on devices.

Overview
OpenMapKit (OMK) is an extension that launches directly fromwithinOpenDataKit (ODK)Collect when
the OpenStreetMap question type is enabled in a standard survey. It is what allows you to browse OSM
features, and to create and edit OSM tags.
Not sure if OpenMapKit is right for your project? Review Data Collection Applications.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following section is designed to serve as a self-paced guides for project managers, supervisors, or
others in setting up the application.
Set-up Process To set-up OpenMapKit for devices, you will need to follow the following steps:
1. Create OMK forms
2. Create .mbtiles
3. Create .osm layer
4. Optional: Set-up constraint file
5. Download and set up ODK and OMK applications

The following section is designed to serve as a self-paced guides for project managers, supervisors, or
others in setting up the application.

CreatingOMKForms

When using OMK survey applications, you will need to create the files that will serve as the survey forms.
Forms for OMK are slightly altered fromODK forms to incorporate the OSM tagging scheme and need to
be built using spreadsheet software (such as Excel or LibreCalc). In addition to the structure of an ODK
form, OMK forms require an additional ‘osm’ tab that alters the form structure for OMK. Documentation
on how to design a form can be found here.

• Example OMK form
• Blank OMK form

FormconversionAfter forms are developed, they need to be converted from .xlsx/.xls to .xml to be used
by theODKapplication. This can be done by using XLSform online or offline. If usingOpenMapKit server,
you will not need to complete form conversion. The server will complete this process for you.

Create .mbtiles

MBTiles (.mbtiles) is the file format used for storingmap tiles as a single file - themost common use case
as baselayers for mobile mapping applications. There are multiple tools to create mbtiles, with selection
based on baselayer type (aerial imagery), addition of vector layers, file size, zoom, etc. Many factors can
influence the type of basemap that you need for your field data collection.

• If you are mapping buildings in areas that are rural and/or there are few landmarks in OSM, use an
aerial imagery basemapmbtile.
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• If you are working with mappers or surveyors with low map literacy, aerial imagery basemap
mbtiles could reduce issues.

• If you are mapping points (such as POI) and/or working in well-mapped areas, simply using OSM
basemapmbtileswould be feasible.

• If your mapping area is being divided into assignment areas or enumeration areas to divide among
surveyors, consider adding vector layers to your mbtile for mappers work from.

I need .mbtiles with… HOT Export Tool QGIS Tile Huria
Aerial Imagery Basemap X  
OSMBasemap   
Vector Layers (i.e. enumeration areas) X  X

Resources
• OSMWiki: https://wiki.openstreetmap.org/wiki/MBTiles
• Mapbox: https://docs.mapbox.com/help/glossary/mbtiles/

a) Create anMBTile with HOT Export Tool HOT Export Tool allows users to download OSM data by
specifying tags, area of interest, and file type. Learning resources and walkthroughs can be found at the
HOT Export Tool Learn page.
Skill level: Easy
Tools and TechnologyNeeded:

• Computer
• Internet Connection
• OSMAccount

To get started, open an internet browser and go to: https://export.hotosm.org/ To use the HOT Export
Tool, you will need to log in using your OSM username and password, by clicking the red “Log In” button
in the top right-hand corner.
Select ‘Create’ in the top menu.
Select anAOI on themapby searching a place, uploading a .geojson, or drawing an area in themap to the
right. To draw an area of interest, zoom in and find a location of your choice (i.e. Zwedru, Accra). Once
you have zoomed in to your area of interest, select the box tool from the Tools Menu on the right. Click
one corner to start drawing a box, then select the opposite corner to complete the box. This is your AREA
OF INTEREST that will be downloaded.
On the left hand side of the window, fill out the “1 Describe” options:

• Name: “[YOUROSMUSERNAME] Test Export”
– For example, “jessbeutler Test Export”

• Description (optional)
• Project (optional)

– For example, “Government Inclusion Project”
Select preferred file type in the ‘Formats’ tab. Select .mbtiles.
In the ‘Data’ tab, select the ‘OpenStreetMap’ as the source. Then select the zoom range. The higher the
zoom range, the more you will be able to zoom in on the basemap. Note, higher zoom ranges increase
the size of files.
In the ‘Summary’ tab, select ‘Create Export’. While processing, a “Running” status will show. Processing
time depends on export size. Once completed, the file will be available for download & sent to your email.
This process will take several minutes to process.
When the export process is completed, the ‘Status’ bar will be updated to ‘COMPLETED’. Download the
file by clicking on the file link, as highlighted below.
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b) Create anMBTile in QGIS Skills and technology needed
• Computer
• Internet access (for web service basemaps only)
• QGIS (and Basic skills in QGIS)
• Optional:

– Vector layers
– QuickMapServices plug-in

Recommendation: When running this process for the first time, we recommend creating an MBTile for a
small area (<1 sq km) to test processing times.
To create anMBTile in QGIS using this process, you will need to have version 3.8 or higher installed. The
following instructions were developed using QGIS version 3.10.
Open a QGIS project. Add (and style) all layers required for your MBTile basemap. These layers can
include:

• Vector layers for enumeration areas, or other guidance.
• Raster layers, such as aerial imagery or an OSM basemap. Web service basemaps can be ac-
cessed via the QuickMapServices plugin.

Once all layers are selected and styled, navigate to the ‘Processes’ menu and open ‘Toolbox’.
In the ‘Toolbox’ panel on the right-hand side, open the ‘Raster Tools’ sub-menu. Select ‘Generate XYZ
tiles (MBTiles)’.
In this pop-upwindow, youwill need to set the specifications for yourMBTile. Click on the ‘…’ buttonunder
‘Extent’ to select the extent of the MBTile. You can either select the extent of the map canvas or draw a
bounding box.
Next, you will need to select the minimum and maximum zoom. This selection will depend on the needs
of your MBTile andmay require trial and error to assess the best combination. For use with OpenMapKit,
we recommend a minimum zoom of 18. Note: the larger the range and the higher the zoom levels, the
longer it will take for the MBTile to process (and will create a larger file.)
The remaining specifications can be adjusted as needed. Hover over each of these options to see default,
minimum, andmaximum options.
Once all settings are selected, click ‘Run’ to process the MBTile.
Note: this processmay take severalminutes depending on the zoom range and size of theMBTile aswell
as the processing power of your computer.

c) Create anMBTile in Tile Huria Tile Huria is a simple tool for creating mbtiles based on an area pro-
vided via Geojson format with aerial imagery.
Skill level: Easy
Tools and TechnologyNeeded:

• Computer
• Internet Connection
• .geojson file for area of interest

Create an .osm layer

To conduct data collection using OpenMapKit (OMK), you will need to create an .osm layer. This .osm
layer provides the buildings for selection in the OMK application.
Skills and TechnologyNeeded

• Computer
• Internet Connection
• JOSM Installed
• Basic JOSM skills
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In JOSM, click the top-menu File > New Layer to start. Then click the top-menu File > Download Data.
In the ‘Download’ window, click the tab ‘Download from Overpass API’. This will allow you to download
data with specific key=value tags in an area of interest. The top of this tab provides space for a query to
be entered. Click ‘QueryWizard.’
For an OMK .osm layer, we want a layer with only building polygons. In the search bar, type “building=*“.
This will return an OSM feature with a building tag. Click ‘Build query’.
In the slippy map below the Overpass query, navigate to your area of interest in OSM. Drag the map by
holding down the right-click button and dragging your mouse. To zoom, use the ‘+’/‘-’ keys on your key-
board. Once navigated to your AOI, hold down the left-button of your mouse or navigation pad and drag
your mouse to create a pink box. This pink box is your bounding box, all buildings within this area will be
downloaded. When complete, click ‘Download’.
Right click on the layer file in the ‘Layers’ window. Click ‘Save as’. The default file type is OSM Server
Files (*.osm), this is the correct file type.
Once saved, this file can be uploaded to devices for data collection with OMK.

Optional: Set-up a constraint file

Constraint files manage the logic of a form - when to skip questions, etc. OpenMapKit comes with a pre-
built constrain file. For information on how to modify a constraint file, see

Download and set up theOMKapplication

Note: Youwill needODK to runOMK.Weadvise installingODK first to allow for proper set-up and testing.
Download application
TheOMKapplicationcanbe foundonGooglePlay: https://play.google.com/store/apps/details?id=org.redcross.openmapkit&hl=en_US
If installing onmultiple deviceswith low internet resources, it is recommended to download and share the
apk offline. The APK file for OpenMapKit can be downloaded here.
Setting up application on devices
1. After downloading theOMKapp, a openmapkit folder will be automatically created in on the internal
memory of the device. Connect your device to a laptop to confirm that this folder is created. If you
don’t see this folder on your device’s internal storage, Restart the device.

2. Once the device has been restarted, connect it to your laptop, and navigate to internal storage ->
openmapkit folder. You will find for sub-folders inside the openmapkit folder. I.e ‘constraints’, ‘de-
ployments’, ‘mbtiles’ and ‘osm’ folders.

3. If you have a customized constraints file, in the constraints folder, delete the Buildings.json and
default.json files. Add your custom the default.json file to the constraints folder.

4. Add your .mbtiles file to the mbtiles folder.
5. Add your .osm file to the osm folder.
6. Now you are set to start working with OMK. Exit the file manager window.
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3.3 Navigation Applications
This section provides:

• An overview of Navigation Applications, including presentation slides
• Guidance on what applications to choose
• Brief overviews of Maps.me and OSMAnd

Overview
Several mobile applications exist to assist with field navigation usingOpenStreetMap as a baselayer and
functioning offline for low-connection environments. Options include OSMAnd andMaps.me.
While navigation tools are not required for data collection, they can be extremely useful for data collec-
tion teams in navigating to field locations, as well as for supervisors and project managers to understand
where their teams have been.
Additional benefits of navigation applications include:

• Collecting GPX tracks: GPX tracks can be used to record field movement as well as recording
highway and road routes for later digitization and upload to OSM.

• AddingKMLfiles: Adding point layers to a navigationmap can help fieldmappers navigate to spe-
cific locations or survey blocks that are not in OSM.

## Choosing a Navigation Application
Which navigation application should I use?

I want to… Maps.me OSMAnd
Use OSM data to findmy location  
Find my location offline  
Add kml files for navigation guidance  
Record GPX tracks* × 
Add data to OSMwithin app  ×

OSMAnd

OSMAnd is a global mobile map viewing and navigation app for online and offline OSMMaps. It is used
for recording tracks as well as mapping features. It provides easy way to record and submit information
in the field.
Skills and TechnologyNeeded

• Internet Connection (for application download)
• Mobile devices (see Hardware for specifications.)
• Android

Resources
• LearnOSM: https://learnosm.org/en/mobile-mapping/osmand/
• OSMWiki: https://wiki.openstreetmap.org/wiki/OsmAnd

Download
• Google Play: https://play.google.com/store/apps/details?id=net.osmand&hl=en_US

Maps.Me

Maps.me is a navigation application that usesOpenStreetMap data, and can be used offline. It is suitable
for collection Point of Interest (POI) information, as far as these fit within the types of data that Maps.me
shows you on the map.
Skills and TechnologyNeeded
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• Internet Connection (for application download)
• Mobile devices (see Hardware for specifications.)
• Android or iOS device

Resources
• Maps.me: https://maps.me
• OSMWiki: https://wiki.openstreetmap.org/wiki/MAPS.ME

Download
• GooglePlay: https://play.google.com/store/apps/details?id=com.mapswithme.maps.pro&hl=en_US

Additional Considerations

When downloading applications to be used by large numbers of individuals, managers should consider:
• Downloading the apk files prior to installation. These are offline files that can be shared between
users and allow for offline installation.

• ForMaps.Me, share basemapswith an offline file rather than requiring each user to download an en-
tire basemap (i.e. Liberia, northernBotswana) ondataorwifi. Toget anofflinemapfile, youwill need
to download the map to one device. Plug the device into a computer and navigate to the file folder.
The basemap file in this folder can be copied and pasted to the appropriate file in other devices.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following presentation(s) can be used to lead a training or workshop.

• Introduction to Navigation Applications
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3.4 Data Collection Servers
This section provides:

• An overview of server storage options
• Guidance on selecting a server for your project needs
• Brief overviews of server options

The following section provides an overview and guide to deciding if a server is necessary for your project
and options to choose from. For in-depth information on setting up and managing servers, please use
the documentation linked for each server option.

Overview
When beginning a mapping project, many organizations ask if they need to have a server. After collect-
ing data, you’ll need to get the data from the devices. Sometimes, it works to simply collect and process
data directly from the data collection devices. However, this does not scale well when you get more peo-
ple collecting data, and also means your data is not backed up - if you lose the device, you can lose the
data. Prior to data collection, it is important to have a data management strategy that is suited for your
operations.
## Choosing a Storage Option
Cloud Server vs. Physical storage Using a data collection server allows for much better management
of forms and deployments, collection and aggregation of responses, and can offer additional features for
viewing, analysing and exporting data. Use of a server may be restricted by available resources (cost of
a server) and/or internet connection (access to cloud server). Servers used in HOT workflows include:

• POSM
• OpenMapKit Server
• Kobo Toolbox

If the use of a server is not available to you, it is still possible and crucial to store backups of data. In
this case, data will need to be downloaded or otherwise shared with a central location, such as a laptop
computer, and cloned to a secondary location such as a hard-drive or second computer.
Which server should I use?
If you do decide to use a server, use the following table to decide which table is best for your project and
resource restrictions. These are not the only options available, but instead, servers that HOT has used
and tested in the field for mapping projects.

I want to use a server that…

Kobo
Tool-
box

OpenMapKit
Server POSM

Is physical or does not require internet connection for upload   
Is cloud-based (data upload via internet)   
Accepts ODK data   
Accepts KOBOCollect data   ×
Accepts OMK data × × ×
Can provide data visualizations × × ×
Provides a map visualization of GPS data collected × × 

Kobo Toolbox

Kobo Toolbox is an online application that allows users to build Kobo/ODK surveys as well as store, ag-
gregate, and perform analysis of Kobo/ODK data.
Skill level to implement andmanage
Beginner
UseKobo Toolbox Server if:
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Kobo Dashboard showing data collected in Uganda

Figure 84: Kobo Dashboard showing data collected in Uganda

• OpenMapKit is NOT being used.
• Data is collected in .xml format, such as with ODK or Kobo Collect
• Geospatial data collection does not include polygons - GPS points are accepted

Set-up andDataManagement Visit kobo.humanitarianresponse.info

OpenMapKit Server

OpenMapKit Server is a cloud based storage system for specially designed to store and compile Open-
MapKit data. Data collected through OpenDataKit can also be uploaded to an OpenMapKit Server.
Skill level to implement andmanageModerate
UseOpenMapKit Server if:

• Collecting .osm data using OpenMapKit.
• Collecting .xml data using ODK and Kobo applications.
• Project Manager need to monitor data as it is collected and uploaded from the field.

Set-up Set up and hosting is provided by HOT for local OSM communities and projects that HOT has an
active agreement with.
DataManagement
1. OpenMapKit Server allows forODKandOMK forms in .xlsx format to be uploaded and converted to
.xml forms. In other words, OpenMapKit Server can convert forms from Excel format to the digital
format readable by ODK, Kobo, and OMK applications.

2. OpenMapKit Server also allows for Deployments (containing .mbtiles and .osm building layers) to
be uploaded.

3. Both forms and deployments can be downloaded directly to mobile phones and tablets via internet
connection - allowing for remote set-up of devices for data collection.

4. Completed forms anddata can then be uploaded directly from the fieldwhen an internet connection
is available.

5. OpenMapKit Servermanagers can view the the incoming data and download in a variety of formats.

POSM

Portable OpenStreetMap, or POSM, is a physical server that contains a set of OpenStreetMap tools, in-
cludingOpenMapKit server. POSMsallowmultiple users to connect and upload data fromdata collection
devices to a central locationwithout the need for internet access. This data can then be aggregated using
the OMK Server and synced with OSM directly or downloaded for analysis and processing.
Skill level to implement andmanage Expert
Use POSM if:

• Project Managers will need to procure hardware for assembling a POSM, or parts for self-assembly.
Additionally, teams will need to have skills for setting up a server on the device. Due to these re-
quirements, POSM is only recommended for teams that have technical support available.

• Surveyors will not have access to internet for data upload
• Surveyors will be able to convene for upload to POSM (i.e. able to gather to return to a location
where the POSM is kept)

• Project managers are able to procure and purchase a POSM device
Set-up andDataManagement Visit the POSM.io website.
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4.0 Introduction to FieldMappingManagement
In this section, ProjectManagerswill find tools and resources to lead andmanage fieldmapping activities
as well as resources designed for their team including:

• Step-by-step guides for surveyors, mappers and field supervisors to manage and use data collec-
tion tools in the field

• Resources and step-by-step guides formanagers on how to organize andmonitor teams in the field

Effective FieldMappingManagement - knowing when, where, and what data is collected by each team
member - is critical to ensuring that mapping efforts are done in a timely and safe manner with high qual-
ity and completeness. Additionally, field supervisors and team members will need the skills to set-up
and manage field data collection tools. This section provides guides for setting up and using three tools:
OpenDataKit, OpenMapKit, and OSMTracker.

• 4.1Managing teams in thefieldprovidesprojectmanagersandsupervisorswith toolsand resources
to assign and coordinatemapping assignment areas (or enumeration areas) to teammembers and
mappers.

• 4.2 Using ODK Collect serves as a step-by-step guide for surveyors, mappers, and field surveyors
to set up and use ODKCollect.

• 4.3 Using OpenMapKit serves as a step-by-step guide for surveyors, mappers, and field surveyors
to set up and use OpenMapKit.

• 4.4 Using OSMTracker serves as a step-by-step guide for surveyors, mappers, and field surveyors
to set up and use OSM Tracker.
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4.1Managing Teams in the Field
This section provides:

• An overview of tools andmethods for managing teams in the field.
• Step-by-step guides for using OSMAnd and QGIS to manage team movement and completion of
assignment areas.

Overview
Central to effective and successful field data collection is awell thought out field data collection plan. This
will ensure that field teams face the least number of challenges while out in the field, thus reducing the
number of calls for field support coming to the supervisor.
When planning to deploy a team, it is important for the Supervisor to have a good picture of how many
work days they have versus the man power available to do the work. Once this is done, they will then
go ahead and create small sections of the mapping area, that can be covered in a day by a team of two
mappers or a single mapper depending on the team arrangement.
Similar to the grid in Tasking Manager, creating sections for mapping allows supervisors to divide tasks,
monitor progress, and be able to assess gaps or quality issues.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following section is designed to serve as a self-paced guides for project managers, supervisors, or
others in creating and implementing assignment areas for field maping.
Skills and TechnologyNeeded

• Computer
• QGIS Installed
• Basic QGIS skills
• QuickMapServices

CreatingMapping Sections in QGIS for PrintedMaps

The following activity covers the process of generating mapping sections in QGIS for printing. This activ-
ity uses the example of leading a team of 8 mapping volunteers to map Grootfontein Town, in Northern
Namibia, during a Malaria Elimination Project. Example files are provided for this activity but can be fol-
lowed with files provided by the user.
To begin, openQGIS on your computer and start a new project. UsingQuickMapServices as a basemap,
navigate to Grootfontein Town, Northern Namibia.
Create an empty shapefile by selecting ‘Layer’ > ‘Create Layer’ > ‘New Shapefile Layer’. After selecting
the location and name of the file, make sure to assign the file as ‘Polygon’.
Enable editing, select the ‘New feature’ too. Create sections of the town, giving them numbers. These
sections should follow natural features or prominent landmarks such as swamps or roads. This is to en-
sure that ease of location of these sections by mappers.
Once all sections are created, style for visibility.
Make maps showing these sections. These maps can be printed out for sharing with the mapping volun-
teers. Teams can now head to their allocated sections to conduct field mapping.
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Creating and ImportingMapping Sections intoOSMAnd

The following activity covers the process of importing files into OSMAnd based on the previous activity
(generating mapping sections in QGIS). This activity uses the example of leading a team of 8 mapping
volunteers to map Grootfontein Town, in Northern Namibia, during a Malaria Elimination Project.
OSMAnd provides a great alternative to printing out these sectionsmaps. WithOSMAnd, theSupervisor
can instead use the following steps to give sections to teammembers for use in the field directly on their
mobile devices.
1. Createsectioncentroids fromthegrootfontein_sections.shpgivingyougrootfontein_sections_centroids.shp.
Create centroids by selecting the ‘Vector’ menu > ‘Geometry Tools’ > ‘Centroids’. In the sub-menu,
select the grootfontein_sections.shp file as the Input layer, click ‘Run.’

2. Export the sections shapefiles (grootfontein_sections.shp) and the centroids shapefile (groot-
fontein_sections_centroids.shp) as a .gpx giving you a grootfontein_sections.gpx and groot-
fontein_sections_centroids.gpx.

3. Transfer these two .gpxfiles fromyoucomputer to the_/Phone/Android/data/net.osmand/files/tracks
_folder

4. Open OSMAnd application and load these two files via Menu button -> My Places -> Tracks ->
Browse to where the files are located

The sections gpx file will show you boundaries of the sections and the centroids gpx file will show you
section numbers once a centroid point is selected. With these two, volunteers canmove in the field using
the OSMAnd app, locating their positions each time as well as the sections in which they are standing.
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Option to fill the URL address menu in ODKCollect

Figure 85: Option to fill the URL address menu in ODKCollect

Step to fill the URL address in ODKCollect

Figure 86: Step to fill the URL address in ODKCollect

4.2 UsingODKCollect
This guide provides surveyors, mappers and field supervisorswith the skills to:

• Complete the initial setup for ODK Collect
• Use ODKCollect for data collection surveys

Overview
Open Data Kit Collect (ODK Collect) is a data collection application on Android. ODK Collect can re-
place form survey from paper to digital. Therefore, this application will help the mapping and data collec-
tion activities in the field which also allow to save the location and photo information at once.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following section is designed to serve as a self-paced guides for project managers, supervisors, or
others in setting up the application.

Initial Setup for ODKCollect

1. Set the URLServer If you are not using a server, skip to step 2. Set the Image Size
To take the form survey from the server for the first time, the user needs to set the URL server. There are
the steps:

• Open ODK Collect and press the three point button in the upper right corner, select General Set-
tings→Server

Option to fill the URL address menu in ODKCollect
• Type the URL address server inURL→OK

Step to fill the URL address in ODKCollect
2. Set the Image Size
In addition to the location point, you can also take a picture as additional information. If youwill be collect-
ing images as part of your data collection surveys, you can set the picture resolution as desired. But, the
picture resolution will also affect the amount of your phone memory or file which will be uploaded to the
server later. It is recommended that you choose the smallest resolution of the image during initial setup.
You can follow this step:

• Open ODK Collect and press the three point button in the upper right corner, select General Set-
tings→FormManagement.

Option menu to set image resolution
• Select Image Size then select the Very Small (640px) option.

Option menu to set image resolution

Figure 87: Option menu to set image resolution
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Image Size menu to set the image resolution

Figure 88: Image Size menu to set the image resolution

Get blank form options to take form on a server

Figure 89: Get blank form options to take form on a server

Image Size menu to set the image resolution

ODKCollect basic operations

1. How ToGet a Blank FormSurvey FromServer If you are not using a server and surveys were man-
ually uploaded to the device, skip to step 2. Fill the Survey Form
Before you fill-out the form survey that you made before, you need to download the blank survey form
from specified server. You can follow this step to take a blank survey from the server:

• PressGet Blank Form and wait for the form to download from the server andmake sure your inter-
net is active.

Get blank form options to take form on a server
• Select the available form, tick the check box or if you want to select all the form, you can Select All.
If your form does not appear, can pressRefresh to reload the page.

Page display on Get Blank Formmenu
• After select the form, you can pressGet Selected to download the selected form.

Page display on the Get Blank Form to get the survey form
2. Fill the Survey Form * To fill the form, back to the start page and select Fill Blank Formmenu. And
then select one form blank that you want to fill in the survey form list.
Fill Blank Form options for filling out the survey form and blank survey form list

• Swipe to right or left on the screen to move the next/previous page. Questions that have a red star
in the top left are required and you can not go to next question if the answer is empty.

Examples of mandatory question (red star)
• Youcan takephotosdirectlybychooseTakePictureoptionor select aphoto fromyourphotogallery
by selectChoose Image.

Take photo display in ODK Form
• To add object location points include OSM object tag, you can use additional application, that is
OpenMapKit (OMK). You can immediately switch to OMK application by press LaunchOpenMap-
Kit on the form. You can learn about using OMK application in section 4.3 Using the OpenMapKit.

Launch OpenMapKit button on the survey form
• At the end, you can name the form, tick checkMark formas finalized and at the end chooseSave
Form and Exit to finalize the final form survey.

Finalization of page views on the survey form
3. Edit the Completed Survey Form The saved form automatically save in ODK Collect. (Note: we do
not recommend editing forms collected via OpenMapKit due to potential data error.) If you want to edit
the completed form, you can follow this step:

• You can back to start page and choose Edit Saved Form.

Page display on Get Blank Formmenu

Figure 90: Page display on Get Blank Formmenu
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Page display on the Get Blank Form to get the survey form

Figure 91: Page display on the Get Blank Form to get the survey form

Fill Blank Form options for filling out the survey form and blank survey form list

Figure 92: Fill Blank Form options for filling out the survey form and blank survey form list

Edit Saved Form for edit the saved form
• Select the form that you want to edit by press the form and you can edit the form.

Edit save form page to select the form that you want to edit
• Then, press floppy disk icon

Edit save form page to select the form that you want to edit

Transferring Completed Forms

After completing data collection, all forms will need to be transferred from the data collection device to a
central storage location for data cleaning and processing.
1. Manual Download
If you do not have access to a server, forms can be manually downloaded from devices. To do so, plug
the device into a computer.

• Go File Manager or File Explorer on your smartphone and open your internal storage. Then open
ODK folder. This folder contains all the survey result file which stored on ODK Collect application.
Then select the ‘instances’ folder which contains the files from the survey results.

Instances folder in ODK folder and the survey result in instances folder
• Copy the ‘instances’ folder to your computer. Rename the folder by date and surveyor.

2. Upload Survey Forms to Server
After you fill and save the form, the next step is upload form survey to server. You can follow this step to
upload form to server:

• To upload the form return to the server, you can choose Send Finalized Form.
Send Finalized Form to upload a survey form to the server

• Form survey is saved on that page and ready to send. You can chooseSelectAll to select all forms
first.

• Makesureyouareconnectedon the internet. ThenpressSendSelectedandwait until theprocess_
upload_ the form is complete.

Survey forms that are ready to send in the Send Finalized Form
• All forms that have been successfully uploadedwill be stored inViewSentFormmenuand the icon
turn into green.

View Sent Form and survey form that have been successfully uploaded to the server
• After upload the form, you can delete the form inDelete Saved Formmenu.

Delete Saved Formmenu for delete the form
• You can delete the the filled form inSavedForms option and delete the blank form inBlank Forms
option. You should choose the form that you want to delete or Select All for delete all form.

Examples of mandatory question (red star)

Figure 93: Examples of mandatory question (red star)
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Take photo display in ODK Form

Figure 94: Take photo display in ODK Form

Launch OpenMapKit button on the survey form

Figure 95: Launch OpenMapKit button on the survey form

Finalization of page views on the survey form

Figure 96: Finalization of page views on the survey form

Edit Saved Form for edit the saved form

Figure 97: Edit Saved Form for edit the saved form

Edit save form page to select the form that you want to edit

Figure 98: Edit save form page to select the form that you want to edit

Edit save form page to select the form that you want to edit

Figure 99: Edit save form page to select the form that you want to edit

Instances folder in ODK folder and the survey result in instances folder

Figure 100: Instances folder in ODK folder and the survey result in instances folder

Send Finalized Form to upload a survey form to the server

Figure 101: Send Finalized Form to upload a survey form to the server

Survey forms that are ready to send in the Send Finalized Form

Figure 102: Survey forms that are ready to send in the Send Finalized Form

View Sent Form and survey form that have been successfully uploaded to the server

Figure 103: View Sent Form and survey form that have been successfully uploaded to the server

Delete Saved Formmenu for delete the form

Figure 104: Delete Saved Formmenu for delete the form

Delete Saved Form option

Figure 105: Delete Saved Form option
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Delete confirmation dialog box

Figure 106: Delete confirmation dialog box

Instances folder in ODK folder and the survey result in instances folder

Figure 107: Instances folder in ODK folder and the survey result in instances folder

Delete Saved Form option
• You need to confirm to delete the survey form by chooseDelete Forms

Delete confirmation dialog box
3. Upload Survey Form toGoogle Drive
After you upload all the survey form to server, you may want to save and upload the survey result file in
.zip format in Google Drive folder that was created by your mapping supervisor. This is the step:

• Go File Manager or File Explorer on your smartphone and open your internal storage. Then open
ODK folder. This folder contains all the survey result file which stored on ODK Collect application.
Then select the ‘instances’ folder which contains the files from the survey results.

Instances folder in ODK folder and the survey result in instances folder
• Before you move instances folder to your computer, you need to convert the folder to .zip format
by pressing the instances folder and selectCompress. You can change the .zip file name.

The step for convert to .zip format
• After youmove .zip file to your computer, you can upload the file to Google Drive that already set by
your mapping supervisor.

The .zip file that ready to move to computer
• You can upload the file to Survey Result folder (or another name that your mapping supervisor
made) by click right on your mouse then choose Upload Files and choose the file that you want
to upload.

The folder on Google Drive for upload .zip file

The step for convert to .zip format

Figure 108: The step for convert to .zip format
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The .zip file that ready to move to computer

Figure 109: The .zip file that ready to move to computer

The folder on Google Drive for upload .zip file

Figure 110: The folder on Google Drive for upload .zip file

4.3 UsingOpenMapKit
This guide provides surveyors, mappers and field supervisorswith the skills to:

• Configure OpenMapKit on devices for individual use and data collection
• OperateOpenMapKit for field data collection

Overview
OpenMapKit (OMK) is an additional application that is used to supportODK Collect in determining the
position of objects found during precise and precise field surveys. OpenMapKit can be run throughODK
Collect, after you open and select one of the available forms. In determining the location of an object,
OpenMapKit requires a map background in the form of a satellite imagery or OSM map. If you use the
OSM as the map background, the thing to note is that the data must be available on the OSM server.
Prior to learning how to use OpenMapKit, users should know how to use ODK (OpenDataKit) Collect,
an android-based application to replace paper form for surveys as OpenMapKit is an extension of ODK
Collect. This extension is used to add information on the position or location of the object surveyed.
*If you have not yet completed the initial set-up OpenMapKit, see 3.2.2 Setting up OpenMapKit before
proceeding.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following section is designed to serve as a self-paced guides for project managers, supervisors, or
others in setting up the application.

ConfiguringOpenMapKit

Before you useOpenMapKit, youmust first make sure each device is confirgured. The following are step
by step instructions of the initial OpenMapKit Configuration:

• On the home page of OpenMapKit, press the settings button located in the upper right corner.
This will allow you to download deployments (if applicable), select a basemap, and select the OSM
buildings layer.

1. Deployments If using OpenMapKit Server and deployments, follow these steps to download files
needed for field mapping. If not using deployments, skip to 2. Basemap.

• Open the OpenMapKit app, tap on the Settings button in the top right corner, and select Deploy-
ments [1].

• Select the appropriate deployment (i.e. census-versalles). Select the black download button in the
lower right corner.

2. Basemaps By default, OpenMapKit will display the Online Humanitarian OpenStreetMap that can
be accessed using an internet connection. However, if manually added to the device or downloaded
through a deployment, an offline basemap can be opened without an internet connection.
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Display basemap settings in OpenMapKit

Figure 111: Display basemap settings in OpenMapKit

Navigate to the current location in OpenMapKit

Figure 112: Navigate to the current location in OpenMapKit

Select and change the OpenMapKit basemap by pressing the settings button located in the top right
corner and pressingBasemap then select the .mbtiles. Then pressOK.
Display basemap settings in OpenMapKit

3. OSMBuildings Layer Selecting an installedOSMFileOpen the OpenMapKit app, tap on the Set-
tings button in the top right corner, and select OSM XML Layer [3]. Select the correct .osm layer for the
locality that is being worked in.
Downloading OSM file If your device does not have an OSM buildings layer (.osm file) pre-loaded or
a file was not downloaded with a deployment, users can still download an OSM buildings layer with an
internet connection. Users will need to complete the following steps:

• Navigate the map to your current location (for example, you are already on the survey location) by
pressing the round button in the lower right corner of the screen until the round button is colored
blue. A black dot will appear at your current location.

Navigate to the current location in OpenMapKit
• Press the settings button in the top right corner
• SelectOSMXMLDownloader to start downloadOSMdata according to the view on the screen of
your smartphone (the duration depends on the size of the area). Make sure you are connected to
an internet connection when downloadingOSMdata. Note the color of the building, the building on
the OSM _basemap _have brown color and the building fromOSMXMLDownloader is purple.

Building color on the OSM basemap (left) and downloaded building color (right)
• Your new downloaded OSM data will be saved in the format .osmwhich can be activated or deacti-
vated via the settings button→OSMXML Layer.

OSMXML Downloader menu and OSMXML Layers menu

4. Enter OSMUsername SelectOSMUser nameOSM and enter yourUser Name
Display settings menu OpenMapKit

UsingOpenMapKit

Once you have configured your basemap and OSM layer, you can add the building information by:
• Select the building to which the information will be added. Make sure the building is purple which
indicates that the building has been downloaded fromOSM. If the building is selected, the color will
change to orange.

• You can fill the building information in accordancewith the form you have chosen before in theODK
Collect application, with press the information tag in the first row located below.

Fill out building information using a form fromODKCollect.
• When done, at the end of the page select Save to save the form to ODK Collect. If you have com-
pleted filling in the form, the building that you fill in the information will look like this:

Building colors

Figure 113: Building colors
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OSMXMLDownloader menu and OSMXML Layers menu

Figure 114: OSMXML Downloader menu and OSMXML Layers menu

Display settings menu OpenMapKit

Figure 115: Display settings menu OpenMapKit

Building that has been filled in the information
If the building data for location of your survey is not yet available in the OSM, you can map the building
before conducting the survey. If you don’t have time to do the mapping, you can use points to mark the
object in theOpenMapKit by:

• Press theplus(+) icon in the lower right cornerof your screenuntil it turnsgreen. Itwill appeargreen
marker with thewordsAddNode on it. Slide themap until the location of themarker is accuratewith
the object in the field.

Addmarkers using the plus (+) icon
• PressAddNode if the point is accurate

Add note button when add point
• If the point you add turns out to be in a position that is not in represent with the object in the field, you
can move the point that has been added by clicking on the point to move then press the two arrow
icon in the top right corner. The color of the point will turn orange and above it will be appear Place
Node.

Swipe points that have been added
• Slide the map to the accurate point position, then press PlaceNode.

Place node button when shifting a point
• After the position is accurate as the object in the field, you can fill out the form the same as the
previous step.

• Enter information that matches the conditions in the field. Swipe the screen right or left to change
thepage questionon the form.

• At the end of the page, select Save to save the form to ODK Collect. If you finished to fill in forms,
the marker that you fill in the information will look like this:

Point of objects already loaded with informations
• Now you can see the form has been successfully saved on theODKCollect.

Note: all OpenMapKit surveys will be launched from the ODK application.

Fill out building information using a form fromODKCollect

Figure 116: Fill out building information using a form fromODKCollect
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The building that has been filled in the information

Figure 117: The building that has been filled in the information

Addmarker using plus icon

Figure 118: Addmarker using plus icon

4.4 UsingOSMTracker
This section provides surveyors,mappers and field supervisorswith the skills to:

• Complete the initial setup for OSM Tracker
• Use OSM Tracker for recording tracks, images, and notes

Overview
OSMTracker is an android application that allows us to record our survey data. Similar to GPS, OSM-
Tracker is able to record waypoint and also track. What makes OSMTracker different with common GPS
device is its capability to take pictures when you collect the survey data. With these images taken, it will
make your mapping more easier because you can track back what object you have been taken and take
a look into your pictures for more detail. Waypoint and track that you have collected can be converted
into .gpx file so you can open your survey data using JOSM or you can directly upload your data into
OpenStreetMap.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following section is designed to serve as a self-paced guides for project managers, supervisors, or
others in setting up the application.

Downloading and installing

If youwant to useOSMTracker you candownload the applicationon your smartphone. OpenyourGoogle
Playstore and search OSMTracker in search box.
You can download OSMTracker on Google Playstore
After the installation finished, open your OSMTracker application on your smartphone.
OSMTracker page display

Initial Setup for OSMTracker

Before you can use the OSMTracker, there are few setting you have to do. Go to
Setting button on the top right corner and then select Settings.
Select Settings menu on OSMTracker
On the settings page there are several things you have to look:
Several configurations on Settings menu
1. GPS logging interval

Add node button when adding a point

Figure 119: Add node button when adding a point
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Swipe points that have been added

Figure 120: Swipe points that have been added

Place node button when shifting a point

Figure 121: Place node button when shifting a point

This section will set how often your OSMTracker record the track. If you set the number smaller,
OSMTracker will record the track more often. The default value for this setting is 0, which means
that OSMTracker will always record your track. This will affect your battery life. You can change the
number according to your need, for example 2 second.

2. External storage (SD) directory
This section determinewhere youwant to save all your survey data on your smartphone. By default,
OSMTracker will create a new folder called “osmtracker” on your smartphone’s internal storage. If
you don’t want to change this setting, you can ignore this section.

3. One directory per track
If you activate this feature, each track you save will create a new folder in your internal storage.

4. Filename for named track
This sectionwill set the labelling of you survey data. By default, the labelling consists of track name,
survey date, and survey time. You can ignore this setting if you don’t want to change it.

5. Screen always on
If you activate this feature, you will let your smartphone always turn on when you use OSMTracker.
When you using this setting, it will drain your smartphone’s battery fast. You can change it as you
needed.

6. Backgroundmap
Use this setting to show the background map on your track. Activate this setting so you can see
your survey track with map as it’s background.

7. Map tile provider
You can change your backgroundmap using this feature.

After all thesetting isdone, thenyouare ready touseyourOSMTracker. Always remember toactivate your
GPS setting on your smartphone, then you can open your OSMTracker. If you are using OSMTracker for
the first time, your home page will be empty. Later, all your survey data will show up on your home page.

OSMTracker Basic Operations

1. Recording Survey Track
If you want to start your track recording, you can select the button + on your top right of your screen. You
will see the Track Logger page.
Use + button to start recording your track
Remember to always check your GPS accuracy. All feature on OSMTracker will not available if you are
not receiving a goodGPS signal. Try to getGPSaccuracy as best as you can (below 10meter) to prevent
a mistake when recording your current position. You can see your GPS signal indicator on your top right
corner of your screen (look at the picture). The signal bar color will change to green and become full when
you receive a good signal. Make sure you are in a good position to receive signal. Locate yourself on the
open field andmake sure you are not under the roof or tree.

the point of objects already loaded with informations

Figure 122: the point of objects already loaded with informations

78



You can download OSMTracker on Google Playstore

Figure 123: You can download OSMTracker on Google Playstore

OSMTracker page display

Figure 124: OSMTracker page display

Unable to activate track logger function because the GPS signal is not good enough (left); Track logger
is activated if GPS signal is good enough (right)
When the GPS accuracy is good enough, then you can start to record your track. When you press the +
button and the GPS accuracy is good enough, OSMTracker will automatically record your track.
2. RecordingObject usingWaypoints and Picture
When you open your Track Logger page, there are many buttons to access, but if you want to record
waypoints and also picture, you only have to use this 2 button:
Track logger page on OSMTracker
1. Text Note

Use Text note to mark your current position as a waypoint. Just press this button and then fill the infor-
mation. For example, you can label your waypoint with number and then the name of your object.
Text note function to record waypoint on your survey
2. Take Photo

Use Take Photo to take your object photos. You can straight use your smartphone camera or you can
select the photo from your gallery.
You can choose to take the photos straight from your camera or select from your smartphone’s gallery
3. Stop andContinue Track Recording
If you want to stop your recording, you can follow these steps:
1. On the Track Logger page, please go back to your home page, then find one file track you have
collected before. Press on that file for a while until additional menu is shows up.

Option to set stop tracking
2. Choose Stop tracking.
3. You can also press Save button on the top corner on your Track Logger page to stop the recording
and save your record.

If you want to continue your track record on your previous file, then you have to :
1. Press on your previous file until additional menu is shows up. Resume tracking
Select to resume tracking

2. Then chooseResumeTracking
Note :
If your file has an orange color clock icon, it means that your file still on track recording mode.
This icon will disappear after you stop and save your file.

4. Showing List of Objects Collected
You can see list of objects you have collected. On Track Logger page, press the Setting button on the top
right corner of your screen, then selectWaypoints.

Select Settings menu on OSMTracker

Figure 125: Select Settings menu on OSMTracker
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Several configurations on Settings menu

Figure 126: Several configurations on Settings menu

Use button to start recording

Figure 127: Use button to start recording

Track logger feature

Figure 128: Track logger feature

Track logger page on OSMTracker

Figure 129: Track logger page on OSMTracker

Text note function to record waypoint on your survey

Figure 130: Text note function to record waypoint on your survey

You can choose to take the photos straight from your camera or select from your smartphone’s gallery

Figure131: Youcanchoose to take thephotosstraight fromyourcameraorselect fromyoursmartphone’s
gallery

Option to set stop tracking

Figure 132: Option to set stop tracking

Ikon

Figure 133: Ikon

Button to show list of waypoints

Figure 134: Button to show list of waypoints
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Waypoint list to see list of objects you have collected

Figure 135: Waypoint list to see list of objects you have collected

Display track button to see your track and objects you have collected

Figure 136: Display track button to see your track and objects you have collected

Button to show list of waypoints
You will see the list of objects and the photos you have collected on theWaypoint list.
Waypoint list to see list of objects you have collected
5. Showing Tracks andWaypoints Collected
You can also see your track andwaypoints you have collected. On your Track Logger page, choosemenu
Setting on the top right corner of your screen, then chooseDisplay Track.
Display track button to see your track and objects you have collected
When you choose to display your track, OSMTracker will ask your permission to show the background
map. ChooseDisplay BackgroundMap.
Option to display your backgroundmap
You will see the map with line, star, and people icon on the top of the map. The star icon represent the
waypoints, the line represents the track you have collected, and the people icon shows where is your
current position on the map.
Track and object’s collected on field survey
6. Saving theOSMTracker Data
After you collecting the data, you can save your data and use it for yourmapping guide. In order to do that,
you need to save your survey data as a .gpx data format. After that, you can upload it to OpenStreetMap
server or you canmove the data to your laptop.
7. Saving Track andWaypoints as .gpxData
You can save your track and waypoint into .gpx data. You can open .gpx data with mapping software like
QGIS and JOSM. On your survey file, select and press the file for a while, then select Export as GPX. If
the process is successful, you can see the green dot on the right side of the file name.
Menu to save your survey data into GPX
8. Uploading Track toOpenStreetMap Server
You can upload your survey data to OpenStreetMap server. On your survey file, press and hold it for a
while, then selectUpload toOpenStreetMap.
Menu to upload your survey data into OpenStreetMap
On OpenStreetMap Upload page, you need to fill the form like name and file description. You can ignore
on Tags section. On the bottom section, you can set the track for :
1. Private

Track will not shown up to the public. Trackpoints can be accessed on the time sequence using GPSAPI
without time stamp.
2. Public

Track will be shown to the public and available for download to the other user.

Option to display your backgroundmap

Figure 137: Option to display your backgroundmap
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Track and object’s collected on field survey

Figure 138: Track and object’s collected on field survey

Menu to save your survey data into GPX

Figure 139: Menu to save your survey data into GPX

3. Trackable
Trackwill be shown to the public, but trackpoints still can be accessed by public GPSAPI. Other user can
download your data but it will not connected with you.
4. Identifiable

Track will be shown to the public. Other user can download your data and can refer your OSM username.
For this option, you can choose Trackable or Public so another user can download your data.
Survey data is ready to upload into OpenStreetMap server
9. Copying Track andWaypoint to Laptop/Computer
All the .gpx data stored in your internal storage of your smartphone. You can search the file using your file
manager. To copy the data, you can follow the instruction:
1. Connect your smartphone to your laptop using your smartphone cable and then find folder called
“osmtracker” in your smartphone.

OSMTracker folder on your smartphone’s storage
2. Inside of your OSMTracker folder, you can find a folder containing a .gpx data and photos. Copy the
entire folder into your laptop.

Example of OSMTracker data consist of .gpx file data and survey photos
3. Open your JOSM, and then open your gpx data. Select menu File→Open and then open the .gpx
data format.

Open your file with .GPX format data on JOSM
4. When you open your .gpx file, JOSM will automatically shows track and waypoint along with the
photo as well.

Field survey data when you open it on JOSM
You can use your survey result as a guidance for your mapping using JOSM. The photos taken will help
you identify what object you should create in JOSM.

Menu to upload your survey data into OpenStreetMap

Figure 140: Menu to upload your survey data into OpenStreetMap
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Survey data is ready to upload into OpenStreetMap server

Figure 141: Survey data is ready to upload into OpenStreetMap server

OSMTracker folder on your smartphone’s storage

Figure 142: OSMTracker folder on your smartphone’s storage

5.0 Introduction to Data Cleaning, Upload, andQuality Assurance
In this section, Project Managers will find tools and resources to clean and upload field collected data to
OpenStreetMap andmanage data quality including:

• Step-by-step guides cleaning data in JOSM for upload to OpenStreetMap.

• Resources for data quality tools to use followingupload toOpenStreetMap, includingpresentations.

DataCleaning,Upload, andQualityAssurance is a critical step in anymappingworkflow. This process
covers cleaning rawfield data for errors andmistakes, uploading cleandata toOpenStreetMap, andusing
various quality control tools to monitor data that has been uploaded. Regardless of how (and if) you are
collecting field data, any project that results edits inOpenStreetMap should have a quality assurance and
control plan.

• 5.1 Data Cleaning in JOSM covers the process and steps required to clean field data and the up-
loading process using JOSM.

• 5.2 Quality Assurance Tools provides a guide to tools HOT uses for monitoring and checking data
quality of data uploaded to OpenStreetMap.

The following presentation(s) can be used to lead a training or workshop:
• Quality Assurance Tools

Example of OSMTracker data consist of .gpx file data and survey photos

Figure 143: Example of OSMTracker data consist of .gpx file data and survey photos
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Open your file with .GPX format data on JOSM

Figure 144: Open your file with .GPX format data on JOSM

Field survey data when you open it on JOSM

Figure 145: Field survey data when you open it on JOSM

5.1 Data Cleaningwith JOSM
This section provides:

• An overview data cleaning tools in JOSM
• Step-by-step instructions for importing field data into JOSM
• Step-by-step instructions for cleaning data into JOSM

The following materials are designed to assist project managers and others leading trainings and work-
shops. However, this material is also suitable for individuals interested in learning how to clean and up-
load field data in JOSM.

Overview
Data collected in the field should always be cleaned for errors and rectifiedwith existingOSMdata before
upload. There are a lot of OSM data editors available, but in this module the OSM data editor used is
JOSM.JOSMhasa lot of useful tools andplugins,makingOSMmappinga lot easier butmost importantly,
it is the easiest tool and best tool for maintaining quality OSM data while importing batches of field data
into OSM.

JOSMData Cleaning Tools

Thereare toolsbuilt intoJOSM,aswell asadditional plugins that canassistwithdataquality control during
the upload process.

• Filters is a built-in tool that allows you to disable, hide, select, and highlight specific groups of ob-
jects based on flexible custom parameters. This tool will help you to spot and avoid common mis-
takes, and review data.

• TheValidation Tool is another built-in tool that will review and search for common errors as well as
provide warnings about potentially problematic data.

• TheTodoList plug-in allows users to systematically reviewdata that is to be uploaded, andmonitor
progress of data cleaning work. The “ToDo List” plug-in, needs to be downloaded before it can be
used. Visit this page to learn how to install plug-ins in JOSM, then download the “ToDo List” plug-in.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

Adding Survey Data into JOSM

Following a field data collection activity using JOSM, use the following step-by-step guide to clean and
upload data to OSM. By following these steps, you will be able to:

• Install plugin Utilsplugin2

to-do list in JOSM

Figure 146: to-do list in JOSM
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Installing plugin utilsplugin2

Figure 147: Installing plugin utilsplugin2

More tools menu on JOSM

Figure 148: More tools menu on JOSM

• Merge all survey data
• Save .osm file using JOSM
• Download OSM data
• Add satellite imagery layer on JOSM
• Add and edit OSM data using JOSM
• Upload changes into OSM

• View changes of OSM data in OSMwebsite
Skills and TechnologyNeeded

• Computer
• Internet Connection
• JOSM Installed
• Basic JOSM skills
• Survey data

1. Installing plugin Utilsplugin2
Before adding or editing OSM data using JOSM, install plugin you’ll be using first. JOSM has a plugin
called utilsplugin2 whose one of the functions is makes copying preset/tag easier. To use this plugin,
you have to install the plugin first since it is not installed by default. These are the steps to install plugin
utilsplugin2:

• Open JOSM
• Click menu Edit→Preferences
• SelectmenuPlugins to install newplugin. If youhaven’t downloadedavailableplugins, clickDown-
load List first to download it. Make sure that you are connected to the internet.

• After downloading plugins, search the utlisplugin2 by typing it in the search box. After you found it,
give a check on the checkbox next to utilsplugin2.

Installing plugin utilsplugin2
• Click OK and wait until the installation process is finished. If the plugin has successfully installed,
there will beMore toolsmenu on your JOSM.

More tools menu on JOSM
Note: Sometimes JOSM ask you to Restart JOSM after installing new plugin to apply newly
installed plugins. However, not all newly installed plugin needs JOSM restarting to be used
after installation process finished.

2. Importing Field Data
2.1 Merging OMK Survey Data *Note: if your data is in a different format, skip to b. Importing Survey
Data (non-OMK).
If you have finished conducting survey using field data collection toolkit such as ODK Collect and Open-
MapKit, you can use the survey data as the reference to add object’s informationwhenmapping it inOSM.
Survey data file format fromOpenMapKit is .osm. The number of .osm files fromOpenMapKit will be the
sameamount as thesurveyedobjects since informationof oneobjectwill besaved inone .osmfile. Merge
all .osm file to make it easier to use the survey data as mapping reference by following these steps:

• Go to File Explorer to where you save .osm file fromODKCollect andOMK.
File directory for .osm file fromODKCollect

• Search all .osm file by typing “osm” in the Search box. Select all .osm file from the search results.
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File directory for .osm file fromODKCollect

Figure 149: File directory for .osm file fromODKCollect

Search results for keyword “osm”

Figure 150: Search results for keyword “osm”

Search results for keyword “osm”
• Drag all selected .osm file to JOSM.

LayersWindows after .osm file fromODK and OMK dragged into JOSM
• Select all those .osm layer by selecting theuppermost .osm layer, thenpressingShift and then
selecting the lowermost .osm layer

• Right click on one of the .osm layer, then clickMerge. Select target layerWindowswill appear,
you do not have to change the target layer, clickMerge.

Merging all survey data layer
• Save the merged layer and change the name by right-clicking on themerged layer, select Save
As, change the layer name and then click Save.

Saving the merged survey data layer
• JOSM provides a plugin named to-do to help you mark the mapped or unmapped object from the
merged survey data layer. You can refer toUsing to-do list onJOSMmodule to learn how to install
and how to use to-doplugin in details. If you have already installed to-do plugin and activated Todo
list Windows, select all objects nodes in themerged layer usingSelect object icon, then clickAdd
on the Todo list Windows.

Adding objects into Todo list
2.2 Importing Survey Data (non-OSM)
You will need to convert your data into a .geojson, .shapefile, or .osm file before beginning data cleaning.
We recommendmerging and converting files in .QGIS, then open the merged file in JOSM.
3. DownloadingOSMData
After successfully merging all survey data, you need to download existingOSMdata. DownloadingOSM
dataaims todiscoverwhichobjectsalreadymappedandwhichobjectshavenotalreadymappedonOSM.
These are the steps to download OSM data using JOSM:

• Click menu File→DownloadData
• DownloadWindowswill appear. It will show you tab SlippyMap by default.

DownloadWindows on JOSM
• If themap is not displaying yourmappingarea, slide themapby rightclickingandhold yourmouse
and thendrag themap to yourmapping area. Drawabox at yourmapping area by left clickingand
hold your mouse and thenmove your mouse until a pink box cover the entire mapping area. Then
clickDownload.

• If it is quitehard tofindyourmappingareabysliding themap, youcanclick tabAreasaroundplaces
and type the name of your mapping area in the Enter a place name to search for box then click
Search. The search result will show you names of your mapping area. Click on one of the names
then go back to tab SlippyMap. The map on the tab SlippyMapwill be directed to your mapping
area. Draw a box covering your entire area of mapping, then clickDownload.

LayersWindows after .osm file fromODK and OMK dragged into JOSM

Figure 151: LayersWindows after .osm file fromODK and OMK dragged into JOSM
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Merging all survey data layer

Figure 152: Merging all survey data layer

Saving the merged survey data layer

Figure 153: Saving the merged survey data layer

Note: Do mind the amount of existing OSM data in your mapping area. If there is already
a lot of existing data, you should download it part by part since JOSM can not download an
enormous amount of data at once.

Tab “Areas around places” at DownloadWindows
• After finished downloading OSM data in your mapping area, there will be a new layer in the Layer
Windows that will also be your editing layer to add or edit OSM data. Make sure that you only add
or edit data in the clear area, not in the shaded area. The shaded area is not your downloaded
area. Andmake sure your entire survey area is already downloaded. After downloading OSM data,
your JOSMwill look like this:

Tab “Downloading OSM data on JOSM” at DownloadWindows
• If you already downloadedOSM data in all your area, merge your downloadedOSM data layer with
your surveydata layer. Select those two layers then rightclick, selectMerge. Saveonyour survey
data layer. Then clickMerge.

Merging downloaded OSM data with survey data layer
4. Adding Satellite Imagery

• Add satellite imagery as another reference for mapping by clicking menu Imagery→ choose one
of the available imagery you want to use, such as DigitalGlobe Premium Imagery. After suc-
cessfully adding satellite imagery, it is time to add OSM data. Your JOSMwill look like this:

Adding satellite imagery on JOSM
• You can adjust the display of the satellite imagery. Select the satellite imagery layer, then click icon
Change visibility of selected layer and adjust its display by sliding the blue button left or right.

Changing the display of satellite imagery
• If you use DigitalGlobe Premium Imagery as your reference, sometimes it has two versions of
display when you zoom it in or zoom it out. Usually there is only one version of display aligned with
the existing OSM data. Inactivate Auto Zoom feature so that the satellite imagery display won’t
change when you zoom it in or zoom it out. To inactivate Auto Zoom feature, right click on the
Satellite Imagerydisplay→clickAuto zoom so that the checkmark next to Auto zoomdisappear.

Inactivating Auto zoom for satellite imagery
5. EditingOSMData Using JOSM
Now you are ready to add or to edit OSMdata using JOSM. You can draw new objects or you can edit the
existing objects using the tools mentioned inUsing JOSMmodule. Here are the steps on how to add or
edit OSM data using survey data, downloaded OSM data and satellite imagery that you already added
before on JOSM:

• After successfully following the stepsmentioned in the previous sections, therewill be two layers on
your JOSM: satellite imagery layer (in the picture below, the layermeant is DigitalGlobe Premium
Imagery layer) andmerged survey data with downloaded OSM data layer (in the picture below,
the layer meant is hasil_survey_jakut.osm layer). It will look like this:

Satellite imagery layer andmerged survey data with downloaded data layer

Adding objects into Todo list

Figure 154: Adding objects into Todo list
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DownloadWindows on JOSM

Figure 155: DownloadWindows on JOSM

Tab “Areas around places” at DownloadWindows

Figure 156: Tab “Areas around places” at DownloadWindows

• You can use Filter feature on JOSM so that you don’t accidentally make changes on other objects
such as administrative boundaries. Administrative boundaries in OSM is a delicate objects, so if
there are already administrative boundariesmapped on yourmapping area then it is better to utilize
theFilter feature. To use thisFilter feature, activate the FilterWindows by clickingmenuWindows
→ Filter. There will be Filter Windows in the right panel. Click Add in the Filter Windows, type
boundary=administrative in the Filter string box and click Submit Filter. New filter will appear
for the administrative boundaries. To turn off the filter, simply uncheck the checkmark on the left of
the filter. You can find outmore about Filter feature on JOSM in theUsing Filter on JOSMmodule.

Filter Windows on JOSM
Adding filter string in the Filter Windows
Newly added filter in the Filter Windows

• Start mapping by zooming in to an object, select one object in the Todo list Windows and then click
Zoom. After selecting and zooming in one object, you can copy the tag from the selected object
to the downloaded OSM objects. Select the downloaded OSM object that aligns with the selected
survey object, then clickmenuMore tools→Copy tags fromprevious selection or pressShift +
R on your keyboard. Make sure you selected the aligned survey object right before copying its tags
to downloadedOSMobject. Alsomake sure that the copied tags are consistent withOSMmapping
guidelines and suitable for the object type. For example, in the picture below, a clinic located in
a shophouse complex, mapped as a point and only have tags suitable for point object. While the
building related tags added to the shophouse building where the clinic is located. When you finish
copying tags for one object, click Mark to identify that it is just already mapped on OSM. Repeat
until all of the objects mapped on OSM.

Using Zoom danMark feature on the Todo list Windows
Tags suitable for point object
Copying building related tags using Shift + R

• Example given above is for point object. When you find an object that is supposed to map as a
polygon, such as school complex which hasmore than one building inside, how tomap it onOSM?
Select the school object in the Todo list Windows and then click Zoom. Select the point object on
themap. Copy the tag to the building polygon alignedwith the point object by selecting the building
polygon and then clicking menu More tools → Copy tags from previous selection or pressing
Shift+Ronkeyboard. After copying the tags, delete tags that arenot related tobuildingand left only
building related tags. Draw a polygon covering all school area using Draw nodes, then copy tags
that are suitable for school area (tags that you deleted before in the building polygon) like amenity,
name and addr:full. After that, delete the school point from the survey data since it has just been
mapped as a school area polygon.

School point from survey data
Tags suitable for school building
Tags suitable for school area
6. Saving Changes

Downloading OSM data on JOSM

Figure 157: Downloading OSM data on JOSM
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Merging downloaded OSM data with survey data layer

Figure 158: Merging downloaded OSM data with survey data layer

Adding satellite imagery on JOSM

Figure 159: Adding satellite imagery on JOSM

Changing the display of satellite imagery

Figure 160: Changing the display of satellite imagery

Inactivating Auto zoom for satellite imagery

Figure 161: Inactivating Auto zoom for satellite imagery

Satellite imagery layer andmerged survey data with downloaded data layer

Figure 162: Satellite imagery layer andmerged survey data with downloaded data layer

Filter Windows on JOSM

Figure 163: Filter Windows on JOSM

Adding filter string in the Filter Windows

Figure 164: Adding filter string in the Filter Windows

Newly added filter in the Filter Windows

Figure 165: Newly added filter in the Filter Windows

Using Zoom danMark feature on the Todo list Windows

Figure 166: Using Zoom danMark feature on the Todo list Windows

Tags suitable for point object

Figure 167: Tags suitable for point object

Copying building related tags using Shift + R

Figure 168: Copying building related tags using Shift + R

School point from survey data

Figure 169: School point from survey data

Tags suitable for school building

Figure 170: Tags suitable for school building

Tags suitable for school area

Figure 171: Tags suitable for school area
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UploadWindows on JOSM

Figure 172: UploadWindows on JOSM

Save OSM File Windows on JOSM

Figure 173: Save OSM File Windows on JOSM

• If you have already done mapping using JOSM, save changes to OSM server because the newly
added objects are saved only in your computer. To save the changes you’vemade, click menu File
→UploadData.

• If you encounter warning/error after clicking Upload Data, it is better to fix warning/error first. You
can findoutmore about fixingwarning/error and commonwarning/errors found inSurveyDataVal-
idation Using JOSMmodule. However, if you don’t have the time to learn how to fix warning/error,
you can just go ahead and clickContinueUpload. UploadWindows will appear.

• If there is no warning/error, UploadWindows will appear. On the UploadWindows, type a brief com-
ment for the changes you’ve done in the comment box and specify the source(s) in the source box.
Type the name of the satellite imagery and survey in the source box. If you want other contributors
to review your edits, give a checkmark next to I would like someone to review my edits. Then
clickUploadChanges.

UploadWindows on JOSM
Note: You need to periodically upload your edits whenmapping so that there won’t be a hefty
amount of edits to upload. Themore edits youwant to upload, themore time it takes to upload.
If you already mapped a lot of edits and haven’t done any upload, you can upload it by chunk.
You can do it by clicking tab Advanced and select Upload data in chunks of objects in the
UploadWindows. Type theChunksizewithhowmanychangesyouwant touploadperchunk,
such as 500. This can be done to avoid incomplete upload, especially when your internet
connection is unstable that resulted in object duplication.

7. Saving .osmFile
• You can also save your editing layer by right clicking on your editing layer and click Save. Save
OSM fileWIndows shown below will appear. Type the name of your file, then click Save. Your file
will be saved in .osm format.

Save OSM File Windows on JOSM
Note: If you haven’t finished mapping your area and you want to continue mapping it later,
you can save your work as .osm file then you can continue mapping it later. You can open
your saved .osm file by clickingmenu File→Open, choose the file youwant to open and click
Open. After opening it, update the OSM data first by clicking menu File → Update Data and
you can go ahead to continue mapping.

8. Viewing Changes in theMap
• You can view your changes by checking it on OSM website and directing it to your mapping area.
Keep in mind, new changes can be viewed a while after uploading it to OSM server.

OSMmap before and after mapping process
SUMMARY
If you can apply and follow through to all of the steps mentioned in this module, then you are able to go
through OSM mapping process using JOSM successfully. You are able to do OSM mapping process,
such as downloading OSM data, adding satellite image, editing OSM data, uploading changes, saving
OSMdata as .osm file and viewing changes. You can upload your changes periodically, such as by region
or by village. If you already have finished conducting survey in one regionor in one village, you canupload

OSMmap before and after mapping process

Figure 174: OSMmap before and after mapping process
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it directly to OSM. This shall be done so that your survey data is not piled up and others can perform data
validation for your edits.
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5.2Quality Assurance andQuality Control Tools
This section provides:

• An overview of Quality Assurance tools, including presentation slides
• Guidance on when, why, and how to use each tool
• Brief overviews and step-by-step guides on using each tool

Overview
Quality Assurance andQuality Control is the process by whichmappers, andOpenStreetMap contrib-
utors in general, check data to ensure that all information uploaded to OSM meets high standards for
usage and to prevent vandalism. AsOpenStreetMap is a free and open platform that anyone can use and
edit, it is critical to the sustainability of open data andOSM that everyone participates in the quality assur-
ance and quality control process – from field data collection to data cleaning to long-termmaintenance of
existing OSM data.
While Quality Assurance and Quality Control should be performed at all stages of a mapping project, the
following tools will help ensure that data uploaded to OpenStreetMapmeets high quality standards.
## Choosing a Quality Assurance Tool
Which quality assurance tool should I use?
The following are Quality Assurance tools commonly used in the HOT workflow. A detailed overview of
these and other QA tools can be found at the Quality Assurance Tools Wiki. Different tools check for
different errors and issues. Use the following table to decide when and why each tool should be used.

I want to check for… MapCampaignerOSMCha Osmose

JOSM
Valida-
tor

Attribute completeness  × × ×
Potential vandalism ×  × ×
Contributions and upload issues by indivdual user ×  × ×
Tagging issues × ×  
Geometry issues × ×  

MapCampaigner

MapCampaigner is a tool developed byHOT tomonitor attribute completeness for predefined areas of in-
terest (AOI). Based on your datamodel, the tool checks and highlights anymap features that aremissing
pre-defined tags within your AOI, and allows team validators to download and fix those features.
Skills and TechnologyNeeded

• Computer with
• Internet connection
• Recommended: computer mouse

How to useMapCampaigner To navigate an existing campaign:
1. Navigate to https://campaigns.hotosm.org in the Google Chrome or Mozilla Firefox internet
browser.

2. Select one of the Projects in the landing page or use the search bar to look for a particular project.
Note: You may need to change the status menu from “Active” to “All” projects if you are not finding
a project.

3. Once a project is selected, scroll down to the feature details. Change the feature type by selecting
a feature from the drop-downmenu on the left.

4. For each feature type, the percent of features with 100% completeness will be shown on the left
panel.
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5. On themap, features are coloredby thepercent of attributes completed. Select each feature to view
the existing tags andmissing attributes. mc_monrovia

Tocreateanewcampaign: Follow the instructionsunder the resources tab foundhere: https://campaigns.hotosm.org/resources

OSMCha

OSMCha, or the OpenStreetMapChangeset Analyzer, is a tool designed to review uploads and changes
toOSMdata, largely to prevent vandalism and bad editsmade tomap data. This tool allows users to filter
by username, location, dates of upload, and other metadata features. OSMCha is useful for monitoring
the progress of data cleaning and upload teams.
Skills and TechnologyNeeded

• Computer with
• Internet connection
• OpenStreetMap Account
• Recommended: computer mouse

How to useOSMCha
1. Navigate to https://osmcha.mapbox.com in theGoogle Chrome orMozilla Firefox internet browser.
2. To use OSMCha, you will need to sign in with your OpenStreetMap account and grant permission.
osmcha_signin

3. Once logged in, a left-hand panel will appear with changesets. Each changeset shows:
• OSM username
• Time of upload
• Changeset comment
• Changeset ID
• Flags (if any) - such as “Possible Import”
• Number of ways added (highlighted in green), waysmodified (highighted in yellow), and ways
deleted (highlighted in red) osmcha_viewingchangesets

4. With OSMCha, you can create highly focused filters to monitor you and your team’s contribution to
OSM. Clicking on ‘Filters’ on the left-hand panel will open the Filtersmenu.

5. In this menu, unique filters can be applied such as OSM username, date range, locations. osm-
cha_filters

Practice creating a filter
1. Click ‘Filters’ on the left-hand panel.
2. Set filters for:

• Start Date: 01/01/19
• Your username
• A location
• One additional filter

3. Click apply.
4. Click on any of the changesets that appear on the left-hand panel. Do any changesets have flags
or warnings?

5. Click on ‘Filters’ again to modify and/or addmore filters.
6. To Save a Filter for later use, click on ‘Filters’ on the left-hand panel. In the upper-right, click ‘Save’
to choose a name for this Filter.

7. The exact filter can now be accessed using the URL or in the ‘My Saved Filters’ option after clicking
on your username.

Osmose

Osmose is a tool that monitors multiple quality control issues in OSM. These include issues with fea-
ture geometry (such as overlapping buildings/nodes, incomplete features, and duplications), and also
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osmose_monrovia

Figure 175: osmose_monrovia

JOSMValidation

Figure 176: JOSMValidation

common tagging issues (such as missing, unsuitable or poorly formatted tags). More information about
Osmose can be found at the Osmose OSMWiki Page.
Note: to properly use this tool and view errors, you will need to use the Google Chrome internet browser.
Firefox, Opera, Safari, and other browsers may not display the information correctly.

How to useOsmose
1. Navigate to http://osmose.openstreetmap.fr in the Google Chrome internet browser.
2. Use the zoom, pan, and search features on the map to navigate to your area of interest.
3. Use the left panel to toggle common issues on and off.
4. Identified issues will appear in the map as pins matching the icons from the issues panel. Click on
each pin to learn more about the object and associated issue(s).

To fix issues identified in Osmose
1. Open JOSM on your computer.
2. In Osmose, locate the ‘Export’ button at the top of the page. Click ‘Export’, then ‘JOSM’.
3. Fix the issues identified then re-upload to OSM.

JOSMValidation Tool

JOSM ’s built-in validation tool that checks for common errors and inconsistencies in OSM data relating
to both geometry and tagging.

How to use the JOSMValidation Tool
1. In JOSM, download data for your AOI.
2. Open the Validation Results tool. If the Validation Results tool is not activated, select ‘Windows’
from the top menu and select ‘Validation Results’.

3. In the Validation Results tool, click ‘Validation’.
4. Go through each warning/error produced. Note: some warnings can be disregarded, some can be
automatically fixed by clicking the ‘Fix’ button, and others will have to be manually fixed. For more
information on specific warnings and errors, read the Validator wiki.

5. Re-run the validation tool to confirm warnings/errors have been fixed.
6. Once all warnings/errors have been fixed, re-upload to OSM.

For further details on using the JOSMValidation Tool, review Section 3.5 Validation with JOSM

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following presentation(s) can be used to lead a training or workshop.

• Quality Assurance Tools
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6.0 Introduction to Data Export Tools
In this section, Project Managers will find resources on how to export OpenStreetMap data, including:

• An overview of data export tools, including presentation slides

• Step-by-step guides for exporting data with the HOT Export Tool and HDX

DataExport Tools allow users to downloadOSMdata for use and analysis programs such asQGIS. The
following areDataExport Tools commonly used in theHOTworkflow. Formore information onhow to use
these tools, follow the step-by-step guides in each of the following sections.

• 6.1 HOT Export Tool covers the HOT Export Tool which allows users to download OSM data by
specifying tags, area of interest, and file type.

• 6.2 Humanitarian Data Exchange (HDX) covers the Humanitarian Data Exchange (HDX) data plat-
form for storing and sharing humanitarian datamanaged byOCHA’s Centre for Humanitarian Data.

• Information onQuickOSM, aQGISPlug-in that allows users to directly downloadOSMdata for spe-
cific tags into QGIS, can be found in section 7.1 Introduction to QGIS.

The following presentation(s) can be used to lead a training or workshop:
• Data Export Tools
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6.1 HOTExport Tool
This section provides:

• An overview of the HOT Export Tool
• Step-by-step instructions on downloading data (such as shapefiles) from OpenStreetMap using
Export Tool

Overview
HOT Export Tool allows users to download OSM data by specifying tags, area of interest, and file type.
Learning resources and walkthroughs can be found at the HOT Export Tool Learn page.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following presentation(s) can be used to lead a training or workshop.

• Data Export Tools
The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

Using theHOTExport Tool

Tools and TechnologyNeeded:
• Computer
• Internet Connection
• OSMAccount

To get started, open an internet browser and go to: https://export.hotosm.org/ To use the HOT Export
Tool, you will need to log in using your OSM username and password, by clicking the red “Log In” button
in the top right-hand corner.
Select ‘Create’ in the top menu.
Select anAOI on themapby searching a place, uploading a .geojson, or drawing an area in themap to the
right. To draw an area of interest, zoom in and find a location of your choice (i.e. Zwedru, Accra). Once
you have zoomed in to your area of interest, select the box tool from the Tools Menu on the right. Click
one corner to start drawing a box, then select the opposite corner to complete the box. This is your AREA
OF INTEREST that will be downloaded.
On the left hand side of the window, fill out the “1 Describe” options:

• Name: “[YOUROSMUSERNAME] Test Export”
– For example, “jessbeutler Test Export”

• Description (optional)
• Project (optional)

– For example, “Government Inclusion Project”
Select preferred file type in the ‘Formats’ tab. If downloading data to use in a GIS program, try download-
ing a .shp file.
In the ‘Data’ tab, select the types of OSM data to export. Recommend types to try: ‘Education’, ‘Govern-
ment’, ‘Healthcare’.
In the ‘Summary’ tab, select ‘Create Export’. While processing, a “Running” status will show. Processing
time depends on export size. Once completed, the file will be available for download & sent to your email.
This process will take several minutes to process.
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When the export process is completed, the ‘Status’ bar will be updated to ‘COMPLETED’. Download the
file by clicking on the file link, as highlighted below. For shapefiles, open the downloaded .zip folder and
save it to a folder of your choice on your computer. You can now use the shapefile in a GIS software such
as QGIS.
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6.2 Humanitarian Data Exchange
This section provides:

• An overview of the Humanitarian Data Exchange (HDX)
• Step-by-step instructions on downloading data (such as shapefiles) from OpenStreetMap using
HDX

Overview
Humanitarian Data Exchange (HDX) is a data platform for storing and sharing humanitarian data. The
platform is managed by OCHA’s Centre for Humanitarian Data. Types of data available on HDX include:
Data includes:

• Geospatial datasets
• CSVs & spreadsheets
• text & image files

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following presentation(s) can be used to lead a training or workshop.

• Data Export Tools
The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.

Workingwith HDX

In this activity, you will practice using Humanitarian Data Exchange (HDX) for downloadingOSMdata for
use in QGIS. HDX is an online-based tool, so you will need to be patient with internet connectivity.
Tools and TechnologyNeeded:

• Computer
• Internet Connection

Downloading data
Visit data.humdata.org. In the FindData search bar, type your area of interest (i.e. Liberia, Tanzania), and
click search.
Browse list of available datasets. Select a dataset of interest and download the data file.
Adding data
Visit data.humdata.org. In the Add Data window, select ‘Upload File’. You will need to sign in or register
as an organization.
You will need to make sure data file meets HDX standards before uploading data file.
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7.0 Data Use andAnalysis
In this section, Project Managers will find tools and resources on how to use OSM data to create map
products for decision-making including:

• A step-by-step guide for getting started with QGIS, including presentation slides
• A step-by-step guide for creating maps and atlases in QGIS
• Detailed guides and resources for using data in web and interactive maps

Thereareahandful of freeDataUseandAnalysis tools available touseyour field generateddata, extract
and utilizeOSMdata, or combine datasets to createmaps, atlases, and other visuals for decisionmaking.

• 7.1 Introduction to QGIS provides an introduction to the open source geographic information sys-
tem (GIS) software that allows you to analyze and edit spatial information, as well as compose and
export geographic maps. Additionally, the section includes a step-by-step guide that project man-
agers can use in trainings for installing QGIS and learning basic skills.

• 7.2 Creating Maps and Atlases in QGIS covers more advance skills in QGIS, providing managers
with training materials to create maps and atlases in QGIS.

• 7.3Web& InteractiveMapsprovides a basic guide to two interactivemapping tools, uMapandOver-
pass Turbo Query.

The following presentation(s) can be used to lead a training or workshop:
• Introduction to QGIS
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7.1 Introduction toQGIS
This section covers the basic skills necessary to using QGIS. This includes step-by-step guides on:

• Installing QGIS
• Navigating QGIS
• Adding data
• Styling layers
• Installing Plugins, including QuickOSM and QuickMapServices

Overview
QGIS (or Quantum GIS) is a free and open source geographic information system (GIS) program. GIS
programsallowusers todisplay,manage, andanalyzegeospatial informationon thecomputer, andcreate
map products. Geospatial data that can be used in GIS includes aerial imagery, GPS data, and spatial
datasets. Following completion of this section, a new user should be prepared to navigate and work with
data in QGIS.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following presentation(s) can be used to lead a training or workshop.

• Introduction to QGIS
The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.
The following guide provides instructions and screenshots from QGIS 3.4. Versions before or after may
have different icons and steps.

InstallingQGIS

QGIS is available for download for the following operating systems:
• Windows
• Mac OS
• Linux

Skills and TechnologyNeeded
• Computer with

– Windows, Mac, or Linux operating system
– Sufficient free disk space (approx 10GB) and administrator rights to install software

• Recommended: computer mouse
ForWindows Prior to installation, you need to determine whether or not your computer runs on a 32-bit
or 64-bit system.
1. Open the Start Menu, right-click on “Computer”, and select “Properties”.
2. Under “System”, the correct system type will be listed.

Installing from Shared File If you are offline, you will need to install QGIS from a shared file. The QGIS
Installer can be downloaded and shared via USB. This file can be shared with colleagues and others who
wish to install the program. To install from a shared file:
1. Go to folder shared to you and downloaded to your computer.
2. Select the appropriate installer folder based on your operating system (Windows 32-bit; Windows
64-bit; or Mac).

3. Open the installer to begin the installation process.
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Installing from QGIS Website If you have an internet connection, you can download directly from the
QGIS website. Additionally, it is highly recommended to download software directly from the QGIS web-
site whenever possible. This ensures that you have the most up-to-date version of the program. The
QGIS file is larger than 300MB and may take a long time to download, depending on your internet con-
nection.
To install:
1. Visit: http://www.qgis.org/en/site/forusers/download.html
2. Select your appropriate operating system (i.e. Windows, Mac, Linux).
3. For Windows - select your approprite system (32-bit or 64-bit).
4. Click on the QGIS Standalone Installer to begin the download process.
5. Once installed, open the installer to begin the installation process.

Considerationswhen installingQGIS for large numbers of individuals
• Consider internet connectivity and capacity prior to installing QGIS for large numbers of individu-
als via internet. It is highly recommended that prior to the training/workshop, installation files are
downloaded and loaded onto USB drives for offline installation.

• When downloading offline installers for a large group, make sure to download an installer for all op-
erating systems. Note: it will be important to download the Windows installer for BOTH 32-bit and
64-bit.

• The downlaod and installation process often takes longer than anticipated, especially when factor-
ing in technical skills and hardware compatibility. Therefore, it is recommended to begin download
and installation process early in the training or during breaks to ensure a smooth process and ad-
herance to agenda.

• Prior to the training/workshop, request attendees tomakesure that theyhaveenoughspaceon their
computers (10GB+) for installation of QGIS.

NavigatingQGIS

To open QGIS, open the QGIS folder on your desktop. In this folder, find QGIS Desktop. Double-click to
open this program
Taking a long time? Don’t panic! QGIS can take a fewminutes to load.
Familiarize yourself with the various parts of the QGIS browser, hover your mouse over icons to view
names of various tools. Note: Your browser may have different tools than the image below.
1. Layers panel - This is where layers (i.e. imagery, building layers) will be listed. The order of layers in
the panel impacts the order of layers in the map - in other words, the layer at the top of the list will
appear as the top layer in the map.

2. Toolbars - Most of the tools you will regularly use in QGIS will appear as icons in the toolbars at
the top, such as save, zoom, pan. The number of toolbars depends on various features you have
activated or installed.

3. Map Canvas - When layers are added to the Layers Panel, they will appear in the map canvas.
4. Status Bar - Coordinates, scale, and projection will appear in the Status Bar.

Adding Data

Hover your mouse over the tools until you find the “Add Vector Layer” tool. Click on this icon to open the
Add Vector Data dialog.
Click the ‘…’ button under Source and navigate to the location on your computer where you have a saved
vector layer (i.e. .shp, .geojson) Select the file and ‘open’.
For more information on exporting data fromOSM, see instructions on QuickOSM and Export Tools.

Styling Layers

Data layers can be styled in three ways: opening the properties tab, copying from other layers in the
project, and importing a .qml style.
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Tomanually select a style:
Right-click on the point layer and select ‘Properties’. (Alternate: Double-click on a layer in the Layers
Panel.)
Select ‘Style’ from the left-hand menu. There are many changes and styles that can be made in this win-
dow. To complete a basic style change, select ‘Simple Fill’ near the top of the window. Now you can
change the Fill Color, Fill Style, Stroke (outline) Color, Stroke (outline) Width, Stroke (outline) Style and
more to your own choice.
Select ‘Ok’ to see your changes in the project.
You can also select from various preset styles in the main style window.
To copy styles from another data layer:
Right-click on any of the other layers. Select ‘Style’, then ‘Copy Style’, and ‘All Style Categories’.
Next, right-click on the layer youwant to apply the style to. Select ‘Style’, then ‘Paste Style’, and ‘All Style
Categories’. Styles from point layer styles can only be copied and pasted to other point layers, polygon
layers styles can only be copied and pasted to other polygon layers, etc.
Styling a layer from an imported .qml file
A .qml file contains style information, including labels, exported from a layer. This file can be saved and
shared to ensure consistent use of particular styles, for example, if an organization uses a particular color
scheme and font for all maps.
Prior to importing a .qml file into QGIS, you will need to receive or download a .qml file. Practice .qml files
and .shp files can be found here.
1. Double-click on a layer in the Layers Panel or right-click on the point layer and select ‘Properties’.
2. Select ‘Style’ from the left-handmenu.
3. In the lower left hand corner of the Style window, select the ‘Style’ button. Click ‘load’ style.
4. Navigate to and select the .qml saved on your computer.
5. Click ‘Ok’. Your layer will assume all style choices saved to the .qml file.

Installing Plug-ins
Tools and skills required

• Internet connection
• Installed QGIS
• Navigating QGIS
• For QuickOSM: OSM Tagging and Data Models

Estimated time: <5minutes, depending on internet connection
Plugins allow you to extend the functionality of QGIS. These plugins can range from allowing data to be
directly downloaded fromOSM to QGIS to tools that assist with analysis.
In this exercise we shall install and use two plugins: QuickMapServices &QuickOSM
Note: Managing and installing plugins requires an internet connection. If the PluginManager is not work-
ing, check your internet connection.
Considerations for working with large groups and/or in low-internet settings Plug-in Manager re-
quires a consistent internet connection to download plugins. It is highly recommended for training and
workshop facilitators to pre-download offline versions for sharing. For instructions on how to download
an offline version of a plug-in for sharing, see section 1.8.1 Software and Tools to Share.
To install plugins, click on the menu item Plugins Manage and Install Plugins.
QuickMapServices
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QuickMapServices allows you to add free, online basemaps to your QGIS maps, including OSM
basemaps.
Note: asQuickMapServicesprovidesonlinebasemaps, useof these layers requiresaconsistent internet
connection.
In the Plugin Manager dialog box that opens, find the QuickMapServices plugin. To do so, click on the
search bar and type ‘QuickMapServices’, the plugin will appear in the list. Then click the Install Plugin
button.
Once installed, QuickMapServices can be accessed in the top menuWeb QuickMapServices
In the QuickMapServices sub-menu, several types of basemaps can be accessed including OSM.
For aerial imagery, in the QuickMapServices sub-menu, open ‘Settings’. Click the ‘More Services’ tab.
Select ‘Get Contributed Pack’.
Return to theQuickMapServices sub-menu. There will now be a long list of options for basemaps, includ-
ing Bing.
QuickOSM
QuickOSM allows you to select and download OpenStreetMap data for use in QGIS. QuickOSM works
by extracting specific data based on OSM based on tags (key=value pairs) and an area of interest.
Once installed, QuickOSM can be accessed in the top menu Vector  QuickOSM >QuickOSM
Note: When downloading data through QuickOSM, it is best to have a basemap layer focused on your
areaof interest (seeQuickMapServices) and/or at least one shapefile/geojson layer in theareaof interest.
This guides QuickOSM in downloading data for the correct area of interest.
To download data in QuickOSM in QGIS, you will need to build queries to download the exact data that
you need. QuickOSMmakes building queries easier, but you will still need to know the tags (i.e. keys and
values) to generate data. It will become easier to remember these tags as you gain experience working
with OSM - in JOSM, QGIS, and other programs.
Below are some examples of common tags used in OSM queries.

Key Value
amenity school

place_of_worship
bar
bank

highway primary
residential
path

office government
ngo

shop clothes
tailor

In the pop-up QuickOSM window, at a minimum, you will need to fill in: key, value, and select the extent.
This
Tips:

• Key: For resources, on keys and values to use, see OSM Tagging and Data Models.
• Value: Multiple values can be strung together by separating with a comma (for example:
amenity=school,hospital). To download all possible values of a key (i.e. amenity=*), leave the
value field blank.

• Extent: Selecting the extent chooses the area QuickOSM will search for and download data from.
There are multiple options you can select from when choosing the extent:
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– In:
– Around:
– Canvas Extent:
– Layer Extent:
– Not Spatial:

Extent of the map canvas is best suited when you do not have a shapefile/geojson that covers your area
of interest (i.e. administrative boundaries) and/or a small area of interest. To base your extent on a layer,
use the drop downmenu on the right to select the appropriate layer.
Once providing your key and value, and selecting your extent, click ‘Run Query’.
If your query is not working:

• Did you use capital letters in your keys and values? Make sure keys and values are in lowercase.
For example: key=amenity value=school NOT key=Amenity and value=SCHOOL

• Did you use the correct spelling in your keys and values? Make sure keys and values are spelled
EXACTLY as they are in OSM guides. Otherwise QuickOSM will be looking for the wrong tag. For
example: key=amenity NOT key=amenities

Note: To large of an area, or too much data to download, can overload the API or will be too much for a
slow internet connection. If you are having difficulty downloading data, try reducing the area or limit the
data downloadby changing your tags. For example, downloading all buildings inAfrica, even somecities,
is too large for QuickOSM. Instead try downloading a smaller area or restricting to all building=school.

Additional Resources
• QGIS Training Manual: https://docs.qgis.org/2.18/en/docs/training_manual/
• QGIS Tutorials: https://www.qgistutorials.com/en/docs/learning_resources.html
• FurtherQGIS Install instructions: https://docs.qgis.org/testing/en/docs/user_manual/introduction/getting_started.html#installing-
qgis
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7.2 CreatingMaps andAtlases in QGIS
This section covers the skills necessary to create maps and atlases in QGIS:

• Preparing map data
• Creating a Map Layout
• Atlas navigation and creation
• Creating map and atlas templates

Overview
Creating an atlas in QGIS allows users to create a series of maps for geographic regions with a set tem-
plate. This atlas template allows for a large number of maps to be generated for areas of interest, such as
districts, wards, and other administrative areas, with the same style and layout.
HOTProject Examples:

• Open Cities in Monrovia, Liberia
• LEGIT in Liberia
• Ramani Huria in Dar es Salaam, Tanzania (Dar es Salaam, Tanzania)

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.
The following guide provides instructions and screenshots from QGIS 3.4. Versions before or after may
have different icons and steps.
Skills and technology needed:

• Installation of QGIS
• Navigating QGIS and adding data
• GIS data files (i.e. shapefiles, geojson)

– Example shapefiles zip
This activity covers the process of generating and configuring a map and atlas in print layout. Example
shapefiles are provided for this activity but can be followed with shapefiles provided by the user.

1. Preparingmap data

Before creating an atlas, you will need to add and style layers. While styling layers, you will need to con-
sider how the layers will look in print composer. As maps in the atlas may be at varying scales, it may be
necessary to return to styling after generating the atlas to make adjustments.
To follow along with the practice steps, add the following vector data to your map: * Dar_sub-
wards_EPSG_4326 * Dar_wards_EPSG_4326
Change the background color of the project. Open the ‘Project’ menu from the top toolbar, select ‘Prop-
erties’. Under general settings, change the background color to blue.
Style the ward layer (Dar_wards_EPSG_4326) by right-clicking on the name in the Layers Panel and se-
lecting ‘Properties’. In the pop-up window, select ‘Style’ from the side menu. Style as described below:
* Select ‘Simple Fill’ from the upper left window. * Change ‘Symbol layer type’ to ‘Outline: Simple Line’ *
Change the color to purple. * Change the ‘Pen style’ to ‘Dash Dot Line’ * Select ‘Apply’ and then ‘OK’.
Duplicate the ward layer (Dar_wards_EPSG_4326) by right-clicking on the name in the Layers Panel
and selecting ‘Duplicate’. Right-click on the copy layer and select rename. Rename this layer as
‘Ward_grey_background’.
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Style the ‘Ward_grey_background’ layer by right-clicking on the name in the Layers Panel and selecting
‘Properties’. In the pop-up window, select ‘Style’ from the side menu. Style as described below:

• Select ‘Simple Fill’ from the upper left window.
• Change ‘Symbol layer type’ to ‘Simple fill’
• Change the color to the html code #edeae2 (or select a light grey color).
• Change the ‘Outline style’ to ‘No pen’.
• Select ‘Apply’ and then ‘OK’.

Style the sub-ward layer (Dar_sub-wards_EPSG_4326) by right-clicking on the name in the Layers Panel
and selecting ‘Properties’. In the pop-up window, select ‘Style’ from the side menu. Style as described
below:

• Select ‘Simple Fill’ from the upper left window.
• Change ‘Symbol layer type’ to ‘Outline: Simple Line’
• Change the color to yellow.
• Change the ‘Pen style’ to ‘Dot’.
• Select ‘Apply’ and then ‘OK’.

After styling the sub-ward layer (Dar_sub-wards_EPSG_4326), select ‘Labels’ from the side menu in
‘Properties’.

• In the top drop downmenu, change the option from ‘No Labels’ to ‘Show labels for this layers’.
• For ‘Label with’, select the option ‘Ward_Name’ from the drop-downmenu.
• Change your ‘Text’ options such as font, font size, font color, etc.
• Select ‘Apply’ and then ‘OK’.

After styling all layers, ensure that your layers are in the following order in your layers panel. (To adjust
layer ordering, left-click and hold on a layer and then drag up or down in the list.)

• Dar_wards_EPSG_4326
• Dar_sub-wards_EPSG_4326
• Ward_grey_background

2. Creating aMap Layout in Print Layout

Open the ‘Project’ menu from the main toolbar, and select ‘New Print Layout’. In the pop-up window,
create a title for your map. This can be a unique name to describe your map’s purpose such as “Dar Sub-
Wards”. A new window will be created with a blank page. This shows how your map will look printed out.
At minimum, you will need to add the following common elements of a map to the map canvas:

• Map
• Title
• Legend
• Scale Bar
• North arrow

Each of these elements can be added by opening the ‘Add Item’ menu on the top toolbar or by using the
quick access buttons on the left-hand toolbar.
Add your map by selecting ‘Add Map’ from the ‘Add Item’ menu (alt: use the Add Map tool from the left-
hand toolbar). You will need to draw the box by clicking and dragging the corners.
Add a title to yourmap by selecting ‘Add Label’ from the ‘Add Item’menu (alt: use theAdd Label tool from
the left-hand toolbar). Like the map, you will need to draw the box by clicking and dragging the corners.
The default text is ‘Lorem ipsum’. This can be changed in the ‘Item Properties’ panel. Change the font
and size of your title.
Add a legend to your map by selecting ‘Add Legend’ from the ‘Add Item’ menu. The size of the Legend
will be generated based on its contents. You can change the size as well as add or remove legend items
in the ‘Item Properties’ panel.
Add a scale bar to your map by selecting ‘Add Scalebar’ from the ‘Add Item’ menu. Like themap, you will
need to draw the box by clicking and dragging the corners.
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Northarrowcanbeaddedbyselecting ‘Add Image’. Like themap, youwill need todraw theboxbyclicking
and dragging the corners. In the ‘Item Properties’ panel, open the ‘Search Directories’ option to select
from a choice of symbols.
Move these items around your Map Canvas until you are pleased with the layout of your map. Think of
your audience: will they understand the information you want to convey?

3. SavingMaps

At this stage, you can decide if you want to save themap as a singlemap ormove on to generate an atlas.
If you would like to save the current map as a stand-alonemap, open the ‘Layout’ Menu and select one of
the ‘Export as…’ options depending on your file preference.

4. AtlasGeneration

After completing the layout for your map, you are ready to generate the atlas. Select the map box and in
the ‘Item Properties’ panel, check the box for ‘Controlled by Atlas’.
In the right-hand panel, select the tab for ‘Atlas generation’, near the ‘Composition’ and ‘Item properties’
tabs. If this tab is not appearing, select the ‘Atlas’ menu from the top toolbar, then select ‘Atlas Settings’.
In the ‘Atlas’ panel, check the box next to ‘Generate an atlas’ to begin configuring your atlas.

5. Configuration

The configuration options in the atlas generation panel controls how the atlas is generated.
1. The ‘Coverage layer’ is the layer that contains the geographic areas of interest for your atlas. For
example, for an atlas showing maps of each district you will need to select your district layer.

2. ‘Page name’ allows you to name pages by either selecting an attribute from the coverage layer or
building an expression from attribute table values.

3. If you do not want to show all areas included in your coverage layer, ‘Filter with’ allows you to filter
out geographic areas that you do or do not want to include in your atlas. This option requires an
expression to be built.

4. ‘Sort by’ allows you to order your atlas by an attribute of your coverage layer.
Practice

• Select ‘Dar_sub-wards_EPSG_4326’ as the coverage layer.
• For page name, select ‘Vil_Mtaa_N’. (This field is the sub-ward name.)
• Check the box for ‘Sort by’ and select ‘Vil_Mtaa_N’. (This field is the sub-ward name.)

6. Atlas Toolbar andNavigation

Once the atlas is generated, you will be able to preview and navigate through the atlas with the atlas tool-
bar. To navigate, first select the ‘Preview atlas’ button. Changes can be made to the atlas layout while in
previewmode.

7. Building expressions for data-driven text

Expressions allow for text such as labels and titles to be data-driven, or generated from attributes. When
working with an atlas, expressions take attributes from the coverage layer.
1. Text that is not data driven should be written within single quote marks. Example: ‘Map’
2. Spaces betweenwords should be indicatedwith a spacewithin single quotemarks. Example: ‘Map
of’

3. Selected values and plain text need to be separated by the operator ‘||’. This operator can be typed
or selected from the ‘Operators’ list. Example: ‘Map of’ ||

4. Data-driven text, or text that is generated from attributes, can be selected from the ‘Fields and Val-
ues’ list. Example: ‘Map of’ || “Ward_Name”

5. An ‘Output preview’ will generate at the bottom of the expression builder window.
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Practice
• Select or create your title box and select “Insert expression” in the ‘Item Properties’ panel.
• Use the ‘Fields and Values’ list to generate the following expression:
“Vil_Mtaa_N” || ‘,’ || “Ward_Name”

• Check the output preview to make sure the expression was typed correctly.

7. Inverse polygon layer

Adding an inverse polygon layer can focus the map by shading out or completely covering features out-
side your area of interest.
1. Return to the main QGIS window.
2. Select the layer used as the coverage layer in the Print Composer. Right-click and select ‘Duplicate’
3. Right-click on the layer copy and select rename. Rename the layer.
4. Right-click on the layer and open properties. Select ‘Style’ from the side menu.
5. In the top drop-downmenu, select ‘Inverted polygons’.
6. Under ‘Sub renderer:’, select ‘Rule-based’ from the drop downmenu.
7. In the rules list window, double click on ‘(no filter)’ to open the ‘Edit rule’ window.
8. In the ‘Edit rule’ window, select the ‘…’ button to create a filter. An expression builder will open. In
the expression window, type or build from the Variable list: $id=@atlas_featureid

9. In the ‘Edit rule’ window, make sure that the symbol type is Simple Fill.
10. Change the transparency to 50%.
11. Change the color to dark grey.
12. Click ‘Ok’ to exit all option windows.
Practice:

• Complete all steps above.
• For step 2, this will be the “Dar_sub-wards_EPSG_4326” layer.
• For step 3, rename the file “inverse_sub-wards”.

8. Adding overviewmaps

Overview maps allow the audience to understand the map’s focal location within the context of a larger
area. For example, an overview map may show a ward’s location within the city. In QGIS, an overview
map can be created that will automatically show the map location for each atlas page.
1. In themainQGISwindow, select the layersyouwould like tohave in theoverviewmap. Theseshould
typically be layers that canbeviewedeasily onasmall scale (i.e. boundaries, highways,waterways).
Multiple layers can be selected at a time by holding Ctrl on your keyboard while selecting.

2. Right-click on these layers and select ‘Duplicate’.
3. Select all of the copied layers. Right-click and select ‘Group Selected’. This allows for better data
management andmakes it easier to turn groups of layers on and off depending on the map needs.

4. Right-click on this group and rename it ‘OverviewMap’
5. Turn on all grouped layers and turn off all others by clicking the check boxes next to the layer names.
6. Return to your Print Composer.
7. Open the ‘Layout’ menu from the top toolbar and select ‘Add map’. Draw a small box for your
overviewmap.

8. Go to the ‘Item Properties’ panel for the secondmap and open the ‘Overviews’ options.
9. Click the green ‘+’ button to add an overview.
10. For ‘Map frame’, select ‘Map 0’ from the drop downmenu.
11. ‘Frame style’ will allow you to change the color, outline, and transparency of the map frame.
12. In the ‘Items Properties’ panel, open the ‘Layers’ option and select ‘Lock layers’. This will keep the

limited layers while allowing for the main map to show all layers.
13. Return to the Main QGIS window. Turn off all grouped overview layers and turn on the other layers.
Practice

• Follow all steps above.
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• For Step 1, select the layers ‘Dar_wards_EPSG_4326 copy’, ‘Dar_sub-wards_EPSG_ 4326 copy’,
and ‘Ward_grey_background copy’.’

9. Atlas Review

After completing the layout and atlas generation, it is important to check each page of the atlas for correct
expression generation (i.e. all pages are correctly titled) and that the appearance of layers and labels in
each map appear correctly. If there is a large difference between map scales for different pages, styles,
labels, grids, and other factors may need to be adjusted to best suit all map scales.
Practice:

• Use the ‘Atlas toolbar’ to navigate through your atlas pages.
• For each page, check:

– Map layer visibility
– Label visibility
– Expression-driven text (i.e. title, additional text boxes)
– Scalebar size and placement

10. Output filename expression

Prior to exporting the atlas, an output filename expression needs to be built. This expression will deter-
mine the name for each page of the exported atlas files. See ‘Building expressions’ for instructions on
building expressions.
Thedefault expression is ‘output_’||@atlas_featurenumberwhichwill produceafilenamesuchas “Output
3”. This can be changed to create a more accurate filename for your maps.
Practice:

• Select the expression builder button
• Build the expression: “District_N” || ‘’ || “Ward_Name” || ’’ || “Vil_Mtaa_N”
• Check the output preview at the bottom of the expression builder to make sure that the expression
has been built correctly.

11. Exporting Atlas

To export the atlas, select the ‘Export Atlas’ button in the Atlas tool bar. Select the appropriate file type
(Export as Images, Export asSVG, orExport asPDF) and select the folderwhere the fileswill be exported
to.

12. Atlas Templates

Atlas templates can be saved and added to other QGIS projects. To save a template, open the ‘Project’
menu from the top toolbar and select ‘Save as Template’. This will save as a Composer Template (.qpt
.QPT) file.
To add the template to another project, open a new print composer. Open the ‘Project’ menu from the top
toolbar and select ‘Add items from Template’. Note: items will be sized to the original document page
size. Item sizes may need to be adjusted if the new project is using a different page size.
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7.3Web& InteractiveMaps
This section provides:

• An overview of online interactive map tools for visualizing data
• Step-by-step instructions for creating interactive maps with two tools: uMap and Overpass Turbo

Overview
Interactivemapsareviewedas themodernequivalent of visual communicationwithmaps. This involves
the creation and study of the visual representation of data (maps). To communicate information clearly
andefficiently, datavisualizationusesstatistical graphics, plots, informationgraphicsandother tools. The
use of interactivemaps gives users an opportunity to change the display of themap to one’s preferences
freely.

Resources and TrainingMaterials
This section features a selection of resources targeted at projectmanagers, trainers, or even self-learners
on the topic(s) outlined above.
The following section is designed to serve as self-paced material that can be used both during trainings,
and by self-guided learners.
This section covers two tools for creating interactivemaps usingOSMdata: uMap andOverpassTurbo.
uMap lets you create maps with OSM layers quickly. The platform features sample maps to inspire your
use of layers, points of interest, design and licensing. Overpass TurboQuery is a web-based data filter-
ing tool for OSM. You can run queries and analyse the resulting OSM data interactively on a map. There
is an integratedWizard that makes creating queries easy.

Overpass Turbo

Overpass TurboQuery is a web-based datamining tool for OpenStreetMap. It runs any kind of Overpass
API query and shows the results on an interactive map.
Skills and TechnologyNeeded

• Computer with
• Internet connection
• Recommended: computer mouse

Skill level requiredBeginner/Intermediate
How to useOverpass Turbo
1. In your web browser enter https://overpass-turbo.eu/ to load Overpass Turbo
2. ClickWizard on the Top Bar to create a data query
3. Create a query. For example, type highway=* (This query searches for all highways in the area of
interest) in the search box and click ‘Build Query’.

4. In the search box on your right (Map Canvas) type the area of interest (such as Kampala, Uganda)
after which, zoom in to the area.

5. On the top bar, click Run to get the data. (After data points load on the map canvas)
6. Click on Export in the top bar. Under the Map section download as an interactive map and share.

uMap

uMap lets you create amapwithOpenStreetMap layers and embed it in your site. All within a fewminutes.
You can create custommaps (see the examples below). It is powered by open-source, WTFPL-licensed
software.
Skills and TechnologyNeeded
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• Computer with
• Internet connection
• Recommended: computer mouse

Skill level requiredBeginner/Intermediate
How to use uMap
1. In your web browser enter http://umap.openstreetmap.fr/en/
2. On your top bar click login/signup and choose the third party (OpenStreetMap - Icon) application to
use.

3. Using OpenStreetMap account grant access to Umap and you will be redirected back to the uMap
interface.

4. On your top right corner, click create map tab
5. On the top bar, Click Editing, UntitledMap to provide title map, map description and configure inter-
active and symbology settings of the map.

6. Click SAVE after every action to prevent losing changes made.
7. Click Import Data Icon on the editing tools (right bar) to add data to themap. Navigate towhere your
data is stored and import it.

8. Click Manage Data Icon on the editing tools (right bar), then click the edit (pencil) button to edit the
visual properties of the data such as color and icon style.

9. Click Save on the top bar to have changes made saved.
10. Refresh the page and on the left panel, click the sharing icon to copy the link that can be shared for

the interactive map generated or embed the map in a customwebsite.

Linking uMap andOverpass Turbo

Linking uMap andOverpass Turbomakes your interactive uMap update asOpenStreetMap data is being
updated.
Skills and TechnologyNeeded

• Computer with
• Internet connection
• Recommended: computer mouse

How to link uMap andOverpass Turbo
1. After creating a query in overpass-turbo.eu, click Export, Query, and then compact.
2. Copy the query link as text and paste into a text editor (e.g. notepad). If you use the “copy link”
featureof your browser youmayfirst have todecode theURLbypasting in hereandclickingDecode
before copying to output to a text editor.

3. Next, we need to take this text and generalise it to work on any map area:
4. Add http://overpass-api.de/api/interpreter?data= before the copied text.
5. Replace thehard-coded latitudeand longitudecoordinateswith({south},{west},{north},{east}).
This will need to be done three times; after node[x], way[x], and relation[x].

6. Thefinal result should look like: http://overpass-api.de/api/interpreter?data=[out:json][timeout:25];(node[“source”=”HOT-UG”]({south},{west},{north},{east});way[“source”=”HOT-UG”]({south},{west},{north},{east});relation[“source”=”HOT-UG”]({south},{west},{north},{east}););out
body;>;out skel qt;

7. Now navigate to umap.openstreetmap.fr.
8. Click Create a map and pan/zoom in to the area of interest.
9. Click the layers button and then click Edit (the pencil symbol).
10. In the right-hand pane click Remote data and paste the URL we constructed in step 6 into the Url

box.
11. Select “osm” from the drop-down Format list.
12. Tick the dynamic checkbox.
13. Optional: If you have a lot of data you may want to limit the display to certain zoom levels (so as to

not put too much strain on the Overpass servers). You can do this by entering a min zoom level in
the From Zoom box. Here I have entered 13 as myminimal zoom level.
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14. Customise using the options on the right. Here I’ve changed the map background to OSM
monochrome and changed the colour of the overlay data.

15. Click More on the left-hand side, followed by Embed and share this map.
16. Copy and paste the embeddable iframe (Youmay need to click Current view instead of default map

view in the iframe options box.
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7.4 Post-Earthquake Building Damage Assessment using Open-
StreetMap (OSM)
This section provides:

• An overview on the relevance on the use of OSM data for damage assessments post eathquake
• Deep dive into data models and acquisition of datasets
• Step-by-step instructions for creating damage assessments using OSM data on GIS

Overview
Performing a building damage assessment is crucial after a natural disaster to prevent further casualties
and identify safe locations for temporary shelters. The assessment can aid in response and recovery
efforts by prioritizing areas with the most damage, and provide data to evaluate property damage and
estimate repair costs. This document provides a step-by-step guide for using OpenStreetMap data in
post-earthquake building damage assessments, which can be customized based on available datasets
and the level of assessment needed.

OpenStreetMapBuilding Data
The first thing to consider before conducting such an assessment is the availability of publicly acces-
sible and downloadable datasets. This document’s Data Inputs section contains a good number of data
repositories that are useful for a post-earthquake building damage assessment. One of them is theOpen-
StreetMap database, which is a free and open-sourcemapping platform that provides building footprints
with valuable information such as height, material, and capacity. It is driven by OSM contributors all over
the world, who are mostly volunteers mapping geospatial features and adding critical information based
on local knowledge.
Figure 1 shows a health clinic in the Philippines that was mapped in OSM by the PhilAWARE Project.
The PhilAWARE Project, like many other OSM-based mapping projects, created its own data model 1,
which is a collection of OSM tags that best describe the attributes of a feature that are significant to the
project. Because the PhilAWAREProject was designed to provide situational data to local DRRMoffices,
tags like backup_generator=no, building_material=concrete, and capacity_persons=<50 are critical in
determining the possibility of this clinic remaining operational during a disaster event.
“Fig 1.” Health clinic mapped in OSM through the PhilAWARE Project
In 2017, the Humanitarian OpenStreetMap Team (HOT), in collaboration with the Global Earthquake
Model (GEM) and ImageCat, created a data schema for a global exposure database (GED4ALL) with
the goal of assisting local and global actors in identifying risk and equipping them for data-driven
decision-making. The table below shows a simplified data model 2 of the commonly used tags for
building attributes selected by GEM as crucial in describing the structural integrity of infrastructures
during a hazard event.
Table 1. GED4ALL Simplified Data Model on Buildings

Building Attribute OSMKey OSMDescription
Occupancy building=* Describe the building purpose

(residential, commercial, public,
mixed_use, industrial,
agriculture, assembly,
government, educational,
unknown)

Surroundings building:adjacency=* Describe the neighboring
condition of the building(
attached, free_standing)

1PhilAWAREData Model, Retrieved from https://wiki.openstreetmap.org/wiki/PhilAWARE_Data_Model
2GED4ALL Data Model, Retrieved from https://wiki.openstreetmap.org/wiki/GED4ALL
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Building Attribute OSMKey OSMDescription
Date of Construction or Retrofit building:age=* Proposed OSM age tag,

associated with buildings
(pre_2000, post_2000,
unknown)

Condition building:condition=* Describe the condition of the
building (good, average, poor,
unknown)

Geological Base building:geological_site=* Describes the geological site the
building is built upon (flat_land,
river_bank, slopy_land,
landslide_prone_area,
flood_prone_area, river_bank)

Material of the Lateral
Load-Resisting System

building:lateral:material=* Proposed lateral load resisting
material tag
(concrete_reinforced, concrete,
concrete_steel, metal,
masonary_reinforced, masonry,
masonry_confined, earth,
earth_reinforced, wood, other,
unknown )

Lateral Load Resisting System building:lateral:system=* Identify structural system of
buildings (moment_frame,
infilled_frame, braced_frame,
post_beam, wall,
dual_framewall, flat_slab,
waffle_slab ,infill_flatslab,
infill_waffleslab, hybrid,
unknown)

Height building:levels=* Number of above-ground levels
of a building

Capacity capacity:persons=* Describe the number of people a
building can support

Roof roof:material=* Outer material for the building
roof (masonry, earth, concrete,
metal, wood, fabric, slate, stone,
clay, unknown)

roof:shape=* Well known roof shapes (flat,
pitched, monopitch, sawtooth,
curved, complex_regular,
complex_irregular, unknown)

Although not all OSMbuildingswould have the same number of attributes as described in the datamodel
above, providing users with rich building-level data allows them to generate secondary analyses that can
support or validate the results of the building damage assessment.

Data Inputs
1. Determine your area/s of interest: Prior to collecting data, you must first identify an area of interest
towhich the assessmentwill be bound. It can be at the national or district level, as long as it is within
the disaster’s priority area or impact zone.

2. List and download all necessary data sources: Start organizing and collecting data on the post-
earthquake disaster event, exposure data, existing building damage assessments, etc.

Table 2. List of Opensource Datasets and Repositories |Data| Description |Link to Source| |:—-|:—-|:—-|
|USGSShakeMap|groundmotionandshaking intensity information|https://earthquake.usgs.gov/data/shakemap/|
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|GlobalEarthquakeModel|earthquake riskassessment to locateprobable impactof seismichazards|https://data.humdata.org/organization/gem-
foundation| |Copernicus Emergency Mapping Service|results of analyses (like building damage assess-
ment) on requested activations from Copernicus| copernicus Dashboard| |Copernicus Emergency Map-
ping Service Request|guide on how to request for Copernicusmapping service|Copernicus How ToUse|
|UNOSATAnalyses|results of analyses (likebuildingdamageassessment) on requestedactivations from
UNOSAT|https://unosat.org/products| |UNOSAT Humanitarian Rapid Mapping Service Request|guide
on how to request for UNOSAT mapping service|https://unosat.org/services| |MAXAR Open Data Pro-
gram|satellite imageries showing post-earthquake situation and damage|https://www.maxar.com/open-
data| | Repository |Description | Link to Source | |Humanitarian Data Exchange (HDX)|hosts disaster
layers and exposure data like OSM data exported by HOT|https://data.humdata.org/| |Global Dis-
aster Alert and Coordination System (GDACS)|list of disaster event datasets (also contains USGS
ShakeMap)|https://www.gdacs.org/| |OpenAerialMap|stores post-earthquake satellite and drone im-
ageries from organizations and individuals|https://openaerialmap.org/|

• Many of the data sources that can be used to generate a building damage assessment are spread
out across various databases and repositories. Justmake sure you have all of the necessary up-to-
date datasets before beginning the assessment. Remember that the data you use will have a large
impact on the quality and accuracy of the assessment results.

3. Properly cite data sources: Make sure to check the license type of each dataset and learn how to
properly attribute them to your work.

### Scenario
Following the7.8, 7.5, and6.3magnitudeearthquakesaffectingSyria inFebruary2023, agroupof trained
responders is planning to assist people in evacuating their homes. For an effective response plan, they
want to first identify the city hotspots where buildings are most likely to be destroyed. They then intend
to categorize the different types of building damagewithin the hotspots for better prioritization. There are
no public building damage assessments available, but MAXAR has released post-earthquake satellite
imagery for the area.
1. Downloadall availabledatasets: Make sure the file formats are compatiblewith themapping soft-
ware you intend to use. Note that the QGIS application will be used throughout the various pro-
cesses in this demonstration.

Data Description Link to Source
USGS ShakeMap Intensity polygons fromUSGS

through the GDACS Event
Resources

M 7.8 in Türkiye on 06 Feb 2023
01:17 UTC - M 7.5 in Türkiye on
06 Feb 2023 10:24 UTC - M 6.3
in Türkiye on 20 Feb 2023 17:04
UTC

Pre-event OSMBuilding
Footprints

OSM building data uploaded to
the HDX repository

https://data.humdata.org/dataset/hotosm_syr_buildings
(can also be downloaded from
the (6.1) HOT Export Tool 3,
Geofabrik, (7.3) Overpass API 4 ,
etc.)

OCHA Administrative
Boundaries

Admin bounds uploaded to the
HDX repository

https://data.humdata.org/dataset/cod-
ab-syr

MAXAROpen Data Program Post-earthquake satellite
imageries

Satellite Imageries (includes
Planet and Maxar imageries)

2. Consolidate USGS ShakeMaps: Especially for disasters with multiple major events, such as the
Turkey-Syria Earthquake, which has threemain triggers (M7.8,M7.5, andM6.3 events), it is critical
to understand where the events overlap to see where the risk is greatest. With that, you need to
perform a union of the disaster layers while making sure that the attribute fields corresponding to
the intensity levels are all imported to the output layer.

3HOT Export Tool, Retrieved from https://toolbox.hotosm.org/pages/data-export/6.1-hot-export-tool/
4Overpass Turbo, Retrieved from https://toolbox.hotosm.org/pages/data-use-and-analysis/7.3_web_and_interactive_maps/
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“Fig 2.” Consolidation of USGS ShakeMaps using QGIS
3. Clip consolidated disaster layer: Clip the consolidated USGS ShakeMap within Syria using the
OCHA Administrative Boundary dataset.

4. Join attributes of the disaster layer to theOSMBuilding Footprints: Overlay theOSMBuilding
Footprints to the disaster layer and search for Join Attributes by Location in the QGIS Processing
Toolbox. You may use within as the geometric predicate to capture footprints that are within the
disaster layer extent. Add the Total Intensity Score field to the resulting layer and use it to classify
the building footprints.

“Fig 3.” Parameter settings for the Join Attributes by Location process in QGIS
• A total of 967,813 buildings were identified to be within the USGS Consolidated ShakeMap. This
represents 90% of all buildings mapped in OSM for Syria.

5. Overlay administrative layer for visual inspection: Identify cities where buildings experienced
severe to violent shaking intensities, as theseare themost likely to havesuffereddamageasa result
of the earthquake hazards.

“Fig 4.”Classified OSMBuilding Footprints over Syria Administrative Bounds
• Visual inspection reveals that the most vulnerable buildings are in Harim/Harem and the northwest
portion of Idlib/Idleb. Buildings in the northwest part of Afrin are also likely to be damaged. Depend-
ing on the available OSM tags, opening the attribute table of the classified building footprints will
display critical exposure information such as the name, type, and address of the building.

“Fig 5.”Part of the classified building’s attribute table
6. Use MAXAR’s post-earthquake imageries to validate and identify damage types: Use
MAXAR’s post-earthquake imagery as a validation layer on the predicted areas of building damage.
The example below shows how Copernicus damage grades were used to determine the level of
damage per building in Harim/Harem, Syria.

“Fig 6.”Damaged building was identified using MAXAR’s post-earthquake imagery
“Fig 7.” Building Damage Grade fromCopernicus 5

Remote validation using post-earthquake imagery is beneficial, particularly in identifying heavily dam-
aged buildings. Minor infrastructure damage, on the other hand, is difficult to identify from images. This
is why field validation is still recommended to better categorize the different types of building damage.

Conclusion

OpenStreetMap (OSM) data is helpful in performing rapid analyses such as assessing post-earthquake
building damage. Crowdsourcing is commonly used to collectOSMdata, which allows for a large volume
of data to be collected quickly and efficiently. This information can then be used to determine the extent
of building damage in the affected area.
Oneway that OSMdata can be used for post-earthquake damage assessment is by serving as exposure
data. This means that the OSM building footprints can be used to estimate the number of buildings with
probable damage based on the intensity datasets of the earthquake event. By overlaying the intensity
dataset onto the OSM building footprints, it is possible to identify which buildings are likely to have been
damaged.
In addition, OSMdata can be linked to existing damage analysis, allowing the building footprints to assist
in identifying and validating different damage grades within an area. This means that OSM data can be
used to complement other types of data and provide amore comprehensive understanding of the extent
of damage caused by the earthquake.
It is important to note that the quality and quantity of OSMdata available for post-earthquake damage as-
sessment will depend on the level of mapping that has been conducted in the affected areas prior to the
disaster. Areas that arewell-mappedwill have an advantage in termsof the quantity and quality of assess-
ment that can be conducted. This is why it is critical to prioritize the mapping of disaster risk hotspots in

5Copernicus Damage Assessment, Retrieved from https://emergency.copernicus.eu/mapping/book/export/html/138313
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OSM even before a disaster event occurs. By doing so, it is possible to collect more accurate and useful
data that can be used to assess the damage and assist in relief efforts in the aftermath of an earthquake.

References
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8.0 Introduction toMappingWorkflows
In this section, Project Managers will find example workflows from HOT projects on how the processes,
tools, andworkflowscontained inprevioussectionsof thisToolboxhavebeenapplied to real fieldprojects.
Project Managers can use these example workflows to identify a project similar in scope or goal to their
own and identify which tools and processesmay be needed for their ownproject. Eachworkflowexample
contains:

• An overview of the project

• A step-by-step guide of phases, steps, and tools used
• Links to various parts of the Toolbox to learn how the step was completed

There are many ways to complete a mapping project. HOT has provided overviews of how we’ve com-
pleted projects with the following workflows:

• 8.1 Buildings and POI with OMK showcases the tools and processes used in a long-term fieldmap-
ping project to map buildings and points of interest using OpenMapKit with government and local
partners.

• 8.2 POI with ODK+KoboToolbox Server showcases the tools and processes used in a simple field
mapping project used by a local NGO to integrate into existing programs using OpenDataKit and
KoboToolBox Server.
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8.1Mapping Buildings and POI with OMK
The following workflow showcases the tools and processes used in a long-term field mapping project to
map buildings and points of interest using OpenMapKit with government and local partners.

Project Overview
OpenCities Africa - Accra
The Open Cities Africa Accra project sought to make Alogboshie and its environs resilient to natural dis-
asters, especially flooding. The project involved the remote mapping of Alogboshie, Akweteyman and
Alajo. These are areas of focus in a larger resilience project, Greater Accra Resilience and Integrated
Development (GARID), and are all located along the Odaw River which is prone to floods. Alogboshie is
a community that is plagued by perennial flooding affecting its residents and those in neighboring com-
munities. The area is usually flooded in the months of June and July during the peak times of the rainy
season. The effect of the flood on human life in the community is huge. Often after floods, some commu-
nity residents are displaced.
TheOpenCities Accra team - led byHumanitarianOpenStreetMap Team (HOT),MobileWebGhana and
OpenStreetMap Ghana (OSMGhana).
Project page: OPENCITIES AFRICA - ACCRACITY PROJECT - GHANA
Dates: June 2018 - February 2019
Status: Complete

Tools used:
• Field and Remote Data collection: OpenDataKit (ODK) Collect, OpenMapKit, JOSM, TileMill,
Mapillary

• Data FieldMonitoring: OSMand andMaps.me
• Data Cleaning: JOSM
• Data Extraction and Visualization: HOT Export tool and QGIS

FieldMappingWorkflow
1. Designing the project At the beginning of the project, HOT, Mobile Web Ghana, and OSM Ghana
met with local stakeholders and community members to assess mapping needs. With this information,
we were able to develop a data model that would be useful to local stakeholders but feasible to capture
with project constraints.
Steps used in this phase:

• Designing the Data Model

2. Remote Mapping Due to the density of the building in this project area of interest, and the lack of
high resolution, up-to-date satellite imagery, UAVs/Drones were flown to capture high resolution imagery
whichwasused in remotemapping. Following thedrone imagery capture, imagerywas loaded intoJOSM
to be used by remote mappers.
Steps used in this phase:

• Remote digitization using HOT Tasking Manager
• Remote digitization using JOSM
• Validating with JOSM
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3. Field Mapping Technical Set-up The main data collection tool for this project was OpenMapKit.
This required technical set-up for OpenMapKit including: creation of ODK and OMK forms, creation of
mbtiles, creation of .osm layers. Once these files were created, all files were loaded onto devices and an
OpenMapKit server was set up by HOT.
Steps used in this phase:

• Creation of ODK &OMK Forms
• ODK set-up
• OMK set-up

– Creation of mbtiles using TileMill. (While this Toolbox does not include the TileMill process,
the samembtiles can be created using the QGIS process).

– Creation of .osm layers used JOSM
• Set up devices for ODK and OMK
• Set up a POSM or online OMK Server for use in downloading forms and receiving field data
• Use of OMK Server and POSM

4. Field Mapping Management Field mappers grouped into teams with leaders. Each mapper used
OMK (full survey) and OSMAnd (tracking field movement) on a daily basis. At the end of each day, all
data was uploaded remotely to an online OpenMapKit Server, as well as manually to a POSM device for
back-up.
Steps used in this phase:

• Creation of mapping sections in QGIS
• Creation of mapping sections for use in OSMAnd

5. Data Cleaning Download data from the OpenMapKit server then manually divided into small sec-
tions that could be cleaned in a few hours by local data cleaners. Data was cleaned in JOSM, then up-
loaded into OSM.
Steps used in this phase:

• Data Cleaning with JOSM
• Validating with JOSM

6. DataVisualization Allmappeddatawas uploaded toOSM, andwas later used to developmapprod-
ucts to be used by stakeholders. This data was downloaded into QGIS using QuickOSM, then large wall
maps and atlases were developed to be provided back to stakeholders and community members.
Steps used in this phase:

• Downloading data with QuickOSM
• Creating Maps and Atlases in QGIS
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8.2Mapping POI with ODK+KoboToolbox Server
The following workflow showcases the tools and processes used in a simple field mapping project dur-
ing which HOT trained local NGOs to integrate mapping into existing programs using OpenDataKit and
KoboToolBox Server.

Project Overview
BridgingGaps in Development and Emergency for the RefugeeCrisis in East Africa
East Africa (and Uganda specifically) continues to be the center of one of the world’s largest and fastest
growing refugee crises. Uganda’s progressive open-door policy alone has led to an influx of approxi-
mately 1.4 million refugees into the country. High mobility of refugees means distribution and size of
refugee settlements changes constantly and the need for standardized accessible information to make
timely informed decisions about where services need to be planned and built becomesmore crucial than
ever. Through the use of open-source technical tools combined with a community-based methodology,
HOT has been able to address the critical data gap in these contexts by increasing real-time compre-
hensive data production on infrastructure and services where refugees and host communities reside. To
ensure that government and organizations involved in the refugee response know that, first, this data ex-
ists and, second, how to effectively use it, HOThasworked extensively to support and train actors on how
to systematically incorporate citizen-generated data into their programs to address and fill existing gaps.
Project page: BRIDGINGDATAGAPS: MAPPINGREFUGEECONTEXTS IN EAST AFRICA
Dates: June 2018 - May 2019
Status: Complete

Tools used:
• Field and Remote Data collection: OpenDataKit (ODK) Collect, Kobo server, HOT Tasking Man-
ager (ID Editor, JOSM)

• Data FieldMonitoring: OSMand andMaps.me
• Data Cleaning: OpenRefine, Excel, JOSM, Python scripts
• Data Extraction and Visualization: HOT Export tool, OSM Analytics, QGIS, Overpass Turbo,
Umap, HDX

FieldMappingWorkflow
1. Identifying Partners’ Need and Area of Interest/Operation Through regular interactions and
planned meetings with various stakeholders & partners - including UNHCR, OPM, LWF, etc. - the
Project Manager and/or Country Manager would work to understand the technical gaps and needs that
institutions were facing in strengthening their contributions to the national refugee response. From this
point, we would identify data gaps and the institutional skills needed to fill these areas and co-devise an
implementation plan to train the group/organization over multiple days to achieve the intended results
and outcomes.
Steps used in this phase:

• Defining Needs and Requirements

2. Trainings and Capacity-building Exercises After the extensive consultation process, trainings
would be planned and conducted in house or at a partners’ premise. The main objective of these train-
ings would be to introduce - and attempt to instil - GIS tools and support capacity building with refugee
response partners through custom lessons over a short number of days. These training materials
were all specifically designed for each partner organization to ensure the resources matched their level
of skill/understanding and enable them to adequately improve their practical knowledge. Trainings
generally lasted between 2-5 days and covered topics including data collection, storage, extraction,
analysis and visualization.
Steps used in this phase:
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• Trainings andWorkshops
Trainings provided to partners included:

• Introduction to OSM
• Mapping with JOSM
• Mapping with ID editor
• Mobile Data Collection Tools
• Introduction to QGIS
• Downloading data fromOSM (Hot Export Tool and Quick OSM)

3. Data collection Data collection activities were consultative and participatory in nature, where data
collectors were chosen from the local communities that we were interested in generating data to sup-
port the refugee response. Data collectors used their personal smartphones and those who didn’t have
proper functioning smartphones were equipped with one by HOT. OpenDatakit was the main data col-
lection tool/application used and 6 unique forms - incl. Health, Education, Water, Sanitation - would be
implemented by surveyors and used for mapping in every village visited both in and around the refugee
settlements.
Steps used in this phase:

• Choosing a Data Collection Application: OpenDataKit (ODK)
• Setting up OpenDataKit
• Using ODKCollect

4. DataStorage andMonitoring The data from the field was stored on the online UNHCR kobo server
space. This allowed for different UNHCR and OPM implementing partners to access the data easily and
effectively. The data was uploaded by the field data collector at the end of each working day. Upload-
ing ODK requires as low as a 2G connection to send the files to the server. The surveyors were always
provided with at least 50MB of data to accomplish such tasks. The Kobo server was also used as amon-
itoring tool to determine the number of data points collected and quickly assess any data quality gaps in
the field.
Steps used in this phase:

• Data Collection Servers

5. Data Cleaning and Analysis After storing the data on Kobo, the data would be downloaded then
cleaned and uploaded using JOSM.
Steps used in this phase:

• Data Cleaning with JOSM

6. Data Visualization For this project, HOT used a number of methods to visualize data; from using
QGIS to create staticmaps and atlases to using tools such asOverpass turbo, Umap andMapboxStudio
to create dynamic & informative map products. The types of visualizations were mainly developed in-
cluded distancematrices, resource gap identifiers, location and navigationmaps and proximity indicator
maps.
Steps used in this phase:

• Downloading data with HOT Export Tool
• Creating Maps and Atlases in QGIS
• Web & Interactive Maps
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Data Cleaning, Upload, andQuality Assurance
DataCleaning,Upload, andQualityAssurance is a critical step in anymappingworkflow. This process
covers cleaning rawfield data for errors andmistakes, uploading cleandata toOpenStreetMap, andusing
various quality control tools to monitor data that has been uploaded. Regardless of how (and if) you are
collecting field data, any project that results edits inOpenStreetMap should have a quality assurance and
control plan.

• 6.1ManagementofCollectedData covers the best practices and recommendworkflows forman-
aging data that is collected in the field.

• 6.2 Data Cleaning and ValidationWorkflows provides examples of technical workflows used by
HOT in the field for various types of projects.

• 6.3 Data Cleaning in JOSM covers the process and steps required to clean field data and the up-
loading process using JOSM.

• 6.4QualityAssuranceToolsprovides a guide to toolsHOTuses formonitoring and checking data
quality of data uploaded to OpenStreetMap.

If your project… * Involves field data collection using OpenMapKit and/or OpenDataKit, start with section
6.1. *Doesnot involvefielddatacollectionusingOpenMapKit and/orOpenDataKit, jumpahead tosection
6.4.
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Data Use andAnalysis
There are a handful of free tools available to extract and utilize OSM data for decision-making. By ei-
ther using OSM data in conjunction with free population data sets from, for example, World Pop or other
thematic datasets from the Humanitarian Data Exchange or even combining it with your own generated
data, various tools can be used to clean, analyze and visualize information to inform project planning and
decision-making.
This section covers:
1. QGIS - a cross-platform desktop geographic information system (GIS) software that allows you to
analyze and edit spatial information, as well as compose and export geographic maps.
Level: Advanced
qgis.org

2. uMap lets you createmaps with OSM layers quickly. The platform features samplemaps to inspire
your use of layers, points of interest, design and licensing.
Level: Beginner
umap.openstreetmap.fr

3. OverpassTurboQuery is aweb-baseddata filtering tool forOSM.Youcan runqueries andanalyse
the resulting OSM data interactively on a map. There is an integrated Wizard that makes creating
queries easy.
Level: Beginner/Intermediate
overpass-turbo.eu

Additional tools not detailed in this section:
1. MyHeatMap allows you to view your geographic data interactively. Combining geospatial datawith
a colour-coded gradient makes it easier for your audience to quickly interpret your information.
Level: Beginner/Intermediate
openheatmap.com

2. Data Wrapper allows you to quickly create beautiful and responsive charts - in seconds. It is a
three step process: copy/paste your data, visualize your data by choosing from many charts and
map types and then publish your final creation into your format of choice.
Level: Intermediate
datawrapper.de
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Digitization and Editing in OSM
Digitization, or remotemapping, is theprocessof tracing featuressuchasbuildingsand roads fromaerial
or satellite imagery to create map data. OpenStreetMap relies heavily on users generating data through
digitization.
With OpenStreetmap at the core of our tools and workflows, mapping projects using HOT tools and work-
flows will likely incorporate digitization or editing of OSM data during one, in not multiple phases in the
project timeline. While numerous resources exist to teach new users how to use OpenStreetMap for the
first time, this section is largely designed to guide project managers and community members through
the digitization process from the perspective of leading trainings and managing teams conducting OSM
editing. Users looking for guidance on individuals mapping in OSM should look to LearnOSM.org as a
resource.

• 3.1 Introduction to OSM contains a brief overview of OpenStreetMap with the purpose of being
distributed as supplemental training guides.

• 3.2 Organized Editing Guidelines covers considerations project managers and communities
should make when organizing focused digitization or editing campaigns.

• 3.3Working with the HOT TaskingManager provides an overview of HOT’s tool for crowdsourc-
ing OpenStreetMap edits, as well as a guide for setting up tasks in the Tasking Manager.

• 3.4Editingwith iDandJOSMEditor provides guidance on selecting the appropriateOSMediting
tool for your project or event, and training materials using both tools.

• 3.5 Validatingwith JOSM dives into the validation process step-by-step.
• 3.6 Resolving conflicts in JOSM provides additional assistance for teams conducting advanced
OSM editing.

HOT presentations included in this section for use by communities and projects:
• Introduction to OSM
• Introduction to HOT Tasking Manager
• Mapping with iD Editor
• Mapping with JOSM
• Validating with JOSM
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Designing andCoordinating aMapping Project
There is nooneway tocollect data in thefieldand itwill varybycontext. However, therearesomeessential
topics and questions all project managers andOSM communities should consider whenDesigning and
Coordinating aMapping Project.

• 2.1DefiningNeedsandRequirementsposes questions to answerwhendefining the scopeof the
project, such as purpose, geographic scale, and what features to map, as well as ensuring that the
project takes into account the various contexts and stakeholders involved in the project.

• 2.2 Safety, Security, and Logistics for Field Operations contains guiding questions to help plan
for project logistics and security concerns. As all field operations involve some level of risk and
can involve many moving parts, it is vital to conduct a safety, security, and logistics review before
beginning field work on any project, regardless of experience.

These first two sections provide guiding questions and considerations, however, it is important to under-
stand that each project will have different variables that might not be covered. When designing a project,
be sure to use past experience, consult with other organizations, and meet with stakeholders to ensure
that you are covering all variables.

• 2.3 Selecting Hardware provides a guide on the various hardware, such as phones and laptops,
that could be needed for a project. Additionally, HOT has provided lists of specificmodels that have
been used in HOT field projects that have proven suitability.

• 2.4 Trainings andWorkshops covers the requirements for running trainings as well as providing
resources such as example agendas andmaterials to provide.

Further resources and reading
In addition to this Toolbox, there exists several guides that were developed to help teams in the project
planning process, some of which were borrowed from to develop this Toolbox.

• Open Maping for the SDGs - Humanitarian OpenStreetMap Team (HOT) published a guide for
launching and growing open mapping initiatives at the national and local levels to achieve the Sus-
tainable Development Goals (SDGs). This guide can be found at: https://hotosm.github.io/gpsdd-
documentation/

• Open Cities Project Guide - the World Bank Global Facility for Disaster Reduction and Recov-
ery (GFDRR) and Humanitarian OpenStreetMap Team (HOT) published a guide that can be down-
loaded at http://www.opencitiesproject.org/guide/.

• Participatory Mapping Toolkit - Humanitarian OpenStreetMap Team (HOT) published a guide
for open mapping projects in the context of refugees. The full toolkit can be downloaded at
https://www.hotosm.org/downloads/Toolkit-for-Participatory-Mapping.pdf
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How to use theHOTToolbox
The HOT Toolbox is designed to take a project manager or community through the entire mapping work-
flow, from planning, through initial mapping, data use and analysis. Not every mapping project is the
same. Some projects involve extensive field data collection components, othersmight not even conduct
field mapping activities but run desktop-based digitization projects instead.
The Toolbox has seven sections (overview below) that can be used in the order presented, or combined
to suit your individual project training needs.
If you do not want to go through each section, use the left-hand navigation, or the search bar to look for a
particular guide.
If you are not surewhere to begin a project use theMappingProjectWorkflows section to find an ex-
ample workflow that best suits your project’s goals and resources. Each example will guide you through
the exact steps, while linking to the relevant sections in the Toolbox and highlighting the tools and pro-
cesses used.

Overview of the Toolbox Sections
1. Designing and Coordinating a Mapping Project provides readers with an introduction to the
components that project managers should consider and take into account before beginning their
mapping projects.

2. Digitization and Editing in OSM provides project managers with training materials and guides on
managing the digitization process and which remote mapping tools are best for a project.

3. FieldMapping Technical Set-up provides project managers with the technical steps for selecting
whichmobile data collection application is best for their project, setting up those applications (such
as ODK and OMK) for use in the field, and whether or not data collection servers are necessary for
their project.

4. Field MappingManagement provides steps and guides for field mappers and supervisors to use
mobile data collection applications, as well as providing tips for managing teams in the field.

5. Data Cleaning Upload and Quality Assurance covers the process of taking field mapped data
through cleaning and upload to OpenStreetMap while ensuring strong data quality.

6. DataExportToolscovers thevarious toolsused for exportingdata fromOpenStreetMapandwhich
tools are best for different use cases.

7. Data Use andAnalysis provides an introduction to how data can be turned into effective maps for
decision making.

ToolboxGuides andResources
Sections in this toolbox contain different types of guides, depending on their user and purpose. We’ve
made it easy to determine the type of guide or resource with the following icons.
This icon represents presentation slides that can be used to lead a training or workshop.
This icon represents step-by-step instructions that are designed to serve as self-pacedmaterial that can
be used both during trainings, and by self-guided learners.
This icon represents guides that are designed to assist project managers with making decisions that im-
pact project design and implementation.
This icon indicates additional resources that are recommended for reading outside of the HOT Toolbox.
Thesemay or may not be resources created by or in partnership with HOT.
This icon indicates additional resources that are recommended for watching outside of the HOT Toolbox.
Thesemay or may not be resources created by or in partnership with HOT.
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